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SOFTWARE LICENSE AGREEMENT

ACI grants you a non-transferable, non-exclusive license to use this
copy of the program and accompanying materials according to the
following terms:

LICENSE:

You may:

a) use the program on only one computer at a time;

b) make one (1) copy of the program in machine readable form solely
for backup purposes, provided that you reproduce all proprietary
notices on the copy;

c¢) physically transfer the program from one computer to another,
provided that the program is used on only one computer at a time; and
d) transfer the program onto a hard disk only for use as described
above provided that you can immediately prove ownership of the
original diskettes.

You may not:

a) use the program in a network unless you pay for a separate license
for each terminal or workstation from which the program will be
accessed;

b) modify, translate, reverse engineer, decompile, disassemble, cre-
ate derivative works based on, or copy (except for the backup copy) the
program or accompanying materials;

c) rent, transfer or grant any rights in the program in any form or
accompanying materials to any person without the prior written consent
of ACI which, if given, is subject to the conferee’s consent to the terms
and conditions of this license; or

d) remove any proprietary notices, labels or marks on the program and
accompanying materials.

This license is not a sale. Title and copyrights to the program, accom-
panying materials and any copy made by you remain with ACI.
TERMINATION

Unauthorized copying of the program (alone or merged with other
software) or the accompanying materials, or failure to comply with the
above restrictions will result in automatic termination of this license and
will make available to ACI other legal remedies. Upon termination you
will destroy or return to ACI the program, accompanying materials and
any copies.

LIMITED WARRANTY AND DISCLAIMER

THE PROGRAM AND ACCOMPANYING MATERIALS ARE PRO-
VIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE.

ACI does not warrant that the functions contained in the program will
meet your requirements or that the operation will be uninterrupted or
error free. The entire risk as to the use, quality, and performance of the
program is with you. Should the program prove defective, you, and not
ACI, assume the entire cost of any necessary repair.

However, ACl warrants the diskettes on which the program is furnished
to be free from defects in materials and workmanship under normal use
for a period of ninety (90) days from the date of delivery to you as
evidenced by a copy of your receipt. The duration of any implied
warranties on the diskettes is limited to the period stated above. ACI's
entire liability and your exclusive remedy as to the diskettes (which is
subject to you returning the diskettes to ACI or an authorized dealer
with a copy of your receipt) will be the replacement of the diskettes or,
if ACI or the dealer is unable to deliver a replacement diskette, the
refund of the purchase price and termination of this Agreement.
SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN
IMPLIED WARRANTY LASTS SO THE ABOVE LIMITATION MAY
NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER RIGHTS WHICH
VARY FROM STATE TO STATE.

LIMITATION OF LIABILITY

IN NO EVENT WILL ACI BE LIABLE FOR ANY DAMAGES, INCLUD-
ING LOSS OF DATA, LOST PROFITS, COST OF COVEROR OTHER
SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAM-
AGES ARISING FROM THE USE OF THE PROGRAM OR ACCOM-
PANYING MATERIALS, HOWEVER CAUSED AND ON ANY THE-
ORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ACI OR
AUTHORIZED DEALER HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE LICENSE
FEE REFLECTS THIS ALLOCATION OF RISK. SOME STATES DO
NOT ALLOW LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.

GENERAL

This Agreement will be governed by the laws of France. In any dispute
arising out of this Agreement, ACI and you each consent to the
jurisdiction of the courts of France.

Use, duplication or disclosure by the U.S. Government is subject to
restrictions stated in paragraph (c) (1) (ii) of the Rights in Technical Data
and Computer Software clause at 252.227-7013.

Licensor: ACI, 5 Rue Beaujon, 75008 Paris, France

This Agreement is the entire agreement between us and supersedes
any other communications with respect to the program and accompa-
nying materials.

If any provision of this Agreement is held to be unenforceable, the
remainder of this agreement shall continue in full force and effect.

If you have aﬁy questions, please contact: ACI C[l;tom;f
Service, (33) 1 42 27 37 25 or write us at the above address.

SIGN AND MAIL THE REGISTRATION CARD TODAY.
Return of the registration card is required to receive any
product updates and notices of new versions or enhance-
ments.

All trade names referenced are the trademark or registered trademark
of their respective holder.

4th DIMENSION, 4D Runtime, 4D, and the abstract 4 logo are trade-
marks of ACIUS, Inc. and ACI.
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PREFACE .
WELCOME TO THE

4TH DIMENSION TUTORIALS

Before you start these tutorials, you should have worked
through the 4th DIMENSION Quick Start. The introductory
Quick Start chapters provide you with a complete basic
introduction to the program. Even if you are familiar with
4th DIMENSION, you should read it through.

This book begins where the 4th DIMENSION Quick Start leaves
off. Quick Start teaches you the basic skills you need to use
4th DIMENSION productively in your own work. You can
create useful databases based on the basic knowledge you have
obtained. This book is designed to help you take advantage of
4th DIMENSION’s more advanced features.

About the Manuals

The 4th DIMENSION Quick Start and 4th DIMENSION Tutorials
lead you through example lessons where you create and use a
4th DIMENSION database. These examples provide hands-on
experience and help you become familiar with the concepts and
features of 4th DIMENSION.

The 4th DIMENSION Design Reference serves as a reference

guide to 4th DIMENSION’s design environment and provides
detailed descriptions of 4th DIMENSION operations that you

can perform in this environment.

The 4th DIMENSION User Reference provides a description of
the environment where you will use the databases and layouts
to enter and manipulate data.

The 4th DIMENSION Language Reference is a guide to using
the 4th DIMENSION language. Use this manual to learn how
to use the language to customize a database.

The 4th DIMENSION Utilities Guide provides a guide to the
utilities available with 4th DIMENSION, such as 4D Tools,
4D Customizer, and 4D External Mover.

The 4th DIMENSION Glossary and Master Index provides a
glossary that defines terms and an index to all 4th DIMENSION
documents.

PREFACE  xiii
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About This Tutorial

This book offers you a series of tutorials, step-by-step
explanations that teach you how to use many of the special
features of 4th DIMENSION. You don’t need to work through
the whole book. But you should glance over any chapters you
skip, because later chapters assume knowledge of earlier
chapters. This book is divided into six parts:

Part I: Customizing the User Interface

m Creating multi-page layouts

m Formatting numbers and dates

m Changing the data entry order

m Creating and using lists

m Using scripts

Part II: Using Relational Databases and Subfiles
m Adding a second file

m Relating one file to another

m Using related files

m Creating and using subfiles

Part III: Using the Search Editor

m Using search conditions

m Searching on fields from another file

Part IV: Working with Reports

m Creating a Quick Report with totals and subtotals
m Using other summary calculations

m Using an output layout for reporting

Part V: Creating Custom Menus

m Creating menus and menu items

m Writing procedures that add records and print reports
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/0wy Part VI: Using the Password Access System
m Setting up a password access system
m Protecting individual menu items

Turn to any chapter to learn about the specific feature
mentioned in the title. To a large extent you can skip around,
learning what you need to use. In some cases, however, you
need to understand an earlier section.

How the Tutorials Work

As you follow the tutorials in this book, you will add to the
database application you started in Quick Start: a database that
keeps personnel records for the employees of a (fictional)
company.

The tutorials are designed to be practical, so that you learn
4th DIMENSION concepts while actually using the program.

Tutorial Text Conventions

The tutorials provide specific steps for you to follow as well as
general information that explains the program. Steps are usually
followed by a short comment or explanation. The format for
steps and explanations looks like this:

1. The numbered step tells you exactly what to do.

Following the numbered step is a separate paragraph that offers
a pertinent explanation or comment.

Another formatting element you will see is the note, often
called Comment in this Tutorial:

ﬂ Note: This format is used for comments about the operation of
some of 4th DIMENSION'’s features. If your main interest is the
topic of the tutorial, don't be distracted by these notes.

PREFACE xv
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CUSTOMIZING

USING THE LAYOUT EDITOR

Database: Personnel 1
Estimated time to complete: 20 minutes

4th DIMENSION’s Layout editor includes a simple but powerful
drawing program that allows you to make the screen design for
your database exactly the way you want it. In addition, the
Layout editor provides many additional functions that affect
the fields and how they work with information.

In this chapter you will learn how to

m open a layout in the Layout editor

m select, move, and change elements on a layout
m change text on a layout

m draw lines and shapes

m use fill patterns

m set the display format for numbers and dates

Modifying the Layout

Modifying your layout will introduce you to the tools of the
Layout editor. These tools give you complete control over
the appearance of your screens and printed reports.

If you have not done so already, start 4th DIMENSION and
open the Personnel 1 database.

Personnel 1 starts in the Design environment.
Choose Layout from the Design menu.

4th DIMENSION opens the Layout dialog box. You can
open any layout from this dialog box.

Click Expand.

4th DIMENSION expands the list to show the [Employees]
file layouts.

CHAPTER 1: USING THE LAYOUT EDITOR 5



Filename

Layout names

Layout editor menu bar & File Edit Use Design Layout Object Font Style

Field labels

Layout... &
Erlnplhg.e.e Input 1 figiate
IEmphuee List | 0
Procedureg
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] Done
Collapse [ input Name: | l
[ sstpes ACEOSS: l I

Figure 1-1

The Layout dialog box
Select Employee Input, and then click Open.
4th DIMENSION displays the layout in its own window.

Expand the window by clicking the zoom box or dragging the
size box so that the layout window fills the whole screen.

IEf==—— layout: Employee Input

Palette tools

Fields

Employees

~Last Name  [Last Name ———]-
~First Name [First Name —— -
= -Start Date

jg': [ | | FSalary

gl | Lritie [Tfite p—
I

Rulers

Figure 1-2
The expanded Layout window
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The Layout editor is similar to a Macintosh drawing program.
You can change the background patterns and line widths, enter
additional descriptive text, and change the style and font of the
typeface. The palette tools and menu commands allow you to
create exactly the layout you want to use. And if you make a
mistake, you can simply choose Undo from the Edit menu and
your last action is undone.

The layout has been given a title that is the same as the
filename, Employees. Because this particular layout will

be used to enter and modify information for each employee,
you decide to change the title to Employee Information.

Each element on the layout is an object that you select in
order to change it. You can move the object simply by
selecting it and dragging it to its new location. You use the
handles that appear on the boundary of an object (an invisible
rectangle enclosing the object) to change the size of the object.

Click once on the title Employees.
Be sure to click on the word itself.

4th DIMENSION displays the handles around the title.

: Employees

Figure 1-3

The handles around a selected element

The title area is a graphic object, as is each element on the
layout. When it is selected, handles appear on each corner of
the boundary. In step 8, you’ll use one of the handles to resize
the title area.

If you like, select different objects in the layout area. You will
see that the handles always show the selected object. Be sure
to select the title again before going on to the next step.

Drag the title area to the left, placing it just within the border
of the layout.

Figure 1-4
Dragging a selected object

N

CHAPTER 1: USING THE LAYOUT EDITOR 7



11.

You drag an object by putting the pointer on it, pressing the
button on the mouse, and holding it down while you move
the object to its new location.

When you start to move the title area, it becomes a blank
rectangle.

Resize the title area by making it as wide as the border of
the layout.

Employees

Figure 1-5

Resizing an object

You resize an object by placing the tip of the pointer on one
of the handles (so that it changes into a pointer made of four
arrows) and then dragging the handle.

Feel free to resize several of the objects on the screen. You
can always return to the original layout by choosing Revert to
Saved from the File menu. At any point, you can go back one
step by choosing Undo from the Edit menu. Be sure to leave
your screen looking like the illustration in Figure 1-5 before
continuing.

Select the Text Area tool from the palette.

Drag the I-beam pointer across the entire title.

Employees]

Figure 1-6
Dragging the I-beam pointer

You are going to replace the title with Employee Information.
Type Employee Information.

The new title replaces the old one.

ﬂ Note: The layout title has nothing to do with the layout name;

the title is strictly a text element added to the layout. When you
refer to this layout in procedures, you will use Employee Input,
the name you gave this particular layout.
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12. Choose Center from the Style menu to center the new title.

Your final screen looks like this:

100

Start Date Start Date
wn| | Satary

e Title [Titie

[ & File Edit Use Design Layout Object Font Style ]
EC] Layout: Employee Input =—————02
Pointer tool o r
olall | Employee Information
|- Last Name  [Last Name | [>°
= First Name [First Name |
EH

el |ty | [

Figure 1-7
An improved layout

13. To prepare for the next steps, click the pointer tool.

The mouse pointer changes to an arrow.

Using the Layout Editor Drawing Tools

The 4th DIMENSION Layout editor has graphic design
features that allow you to create borders, lines, and patterns to
enhance your layout. Objects can be layered, that is, placed on
top of or beneath another object. Any object on the layout can
be moved back or forward so that it disappears beneath or
appears on top of other objects.

In this section you explore some of the capabilities of the
Layout editor.

1. Choose Save Layout:Employee Input from the File menu.

It is always a good idea to save a layout you are happy with,
so that if you don’t like the changes you make, you can return
to the previous acceptable version of the layout.

2. Click within the border of the layout, but not on another
object, so that the border rectangle is selected.

CHAPTER 1: USING THE LAYOUT EDITOR 9



Handles show
that the border

Handles appear at the corners of the layout border.

In the next step you will choose a new fill pattern from a
submenu. Choosing from a submenu is a two-step process.

Pull down the Object menu, then drag the pointer to the
Fill menu item.

The Fill Pattern submenu appears to the right of the Object
menu.

Still holding the mouse button down, drag the pointer to
the right and then to the pattern you want to try, then release
the mouse button.

(& File Edit Use Design Layout JETYIIR8 Font Style )

rectangle |S EEDE Lagout: Emp Line Width 13
selected
Border...
olial | Employee Informat ¢,
Submenu offers choices =) =1 S ———
of fill patterns = Move to Front
First Name [First Name Move to Back
=|EH
== Start Date Start Date Brous
E_ IJ-II-I salary [Ealary | ngroup
M| Title [[itle_______| Position...
Align to Grid
18
Duplicate
[EE] farmat.,

Figure 1-8

Choosing a fill pattern from a submenu

4th DIMENSION displays the border rectangle with the fill
pattern you have chosen. As you see on your screen, and in
Figure 1-9, the field labels, fields, and title are not obscured
by the fill pattern. This is because they are in front of the
background and border.

In the next step you will choose a new line width for the
border from another submenu.

Choose the widest line width from the Line Width submenu.

4th DIMENSION displays the background with the new line
width.
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® File Edit Use Design Layout Object Font Style ]
==——— layout: Employee Input =—————"H

sz

i
L]

g

OlA Employee Information :
) Last Name Last Name i
%; First Name {First Name oo
== Start Date Start Date :
g |:||.| Salary Salar [
i {1 Title Title [

r200

Figure 1-9
Background with new line width and fill pattern

In the next steps you will draw some shapes and experiment
with the Move to Front and Move to Back tools.

Click the Oval tool, then draw an oval below the border of
the layout. '

The screen scrolls to make room for the oval if you draw
below the bottom of the window.

Choose a new fill pattern from the Fill submenu.

For the next step, you want to distinguish the oval pattern
from the background pattern you chose for the layout.

Drag the oval onto the layout.
The oval covers whatever is beneath it.

Click the Move to Back tool to move the oval beneath the
layout.

CHAPTER 1: USING THE LAYOUT EDITOR 11
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Move to Back tool

Oval is
behind
background

[ & File Edit Use Design Layout Object Font Style

ENe==———— Layout: Employee Input =—————VPIF

| _tarD £ 1

10.

Figure 1-10
Using Move to Back to place oval beneath the layout background

Feel free to use the other drawing tools to draw any lines,
rectangles, or rounded rectangles you want. Drag them to
different locations, and resize them into different shapes. This
kind of experimentation can spark ideas of how to use the
different shapes to create interesting and useful layout designs.

Finally, when you are finished, choose Revert to Saved from
the File menu. Click Yes.

The layout you have been working on is replaced by the
version you saved at the beginning of this section.

Using the Alignment Tools

When you modify a layout by moving things around, adding
objects, or rearranging layout elements, you often want to
align things in relation to each other. 4th DIMENSION
provides alignment tools that allow you to align selected
objects precisely.

In this section you will explore the effects of the alignment
tools.

Use the Rectangle tool to create a rectangle below the current
layout border, and then fill it with a pattern (see Figure 1-11).
Deselect the rectangle by clicking somewhere outside of the
layout.
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You will use this rectangle to see how the alignment tools
work.

2. Hold down the Shift key while you click each of the fields on
your layout.

Shift-Click is one way to select more than one object at the
same time.

2 3. Drag the selected fields into the new rectangle. Drag any one
field and the others follow along. Click the Move to Front icon
to put the fields on top of the rectangle.

Dragging the fields off of the layout background leaves boxes
that were placed beneath the fields. These boxes are the blank
field spaces on the data entry screen.

Boxes that [ & File Edit Use Design Layout Object Font Style "]
were behind lEJ=—-—— | ayout: Employee Inpyt ————=0
the fields N » BN :
remain F150
OPAY | Title  L—F | I
(]| [
EE == :2300DB
=a|EH - C
Handles e R OO _
show that == P R T ¥ 250
all the fields Ll I oJFirst Name
ar | I i ’\’\ NN S AT AN \3 SN TATAIN -
¢ selected it v hanajotart Date F200
X ,\/\/\(. /\/\/\/\/\I\I\/\/\/ )
Figure 1-11
Fields in the new rectangle area
4. Leaving all the fields selected, click the Align Right icon.
The fields align with their right edges vertically aligned.
5. Click the Align Center Vertical icon.

The fields align with their centers vertically aligned.

CHAPTER 1: USING THE LAYOUT EDITOR 13



[ % File Edit Use Design Layout Object Font Style ]
IEN==——— layout: Employee Input =—~—————
N » JEEC N E— :
aa F1s0
OAl | Title ] ] i
oO|a r
Vertical == L4 el
alignment i s il s ST Sl
tools L_ == '\jLast Name F250
Horizontal i i
alignment g 300
tools = r
F3s0
180

Figure 1-12
Fields aligned at their center

You have been using the vertical alignment tools, because
the objects you are aligning are arranged vertically. If you
use any of the horizontal alignment tools, the fields will be
aligned, certainly, but you will be able to see only one of
them. If you inadvertently use a horizontal alignment tool,
simply drag the fields off the stack one at a time.

6. Use Shift-Click, as in step 2, to select the new rectangle,
and then experiment with the alignment tools.

4th DIMENSION aligns the fields and the rectangle.

| % File Edit Use Design Layout Object Font Style ]
IEf=——— | ayout: Employee Input ﬁ@%l
sey [ ] :
F1s0
Title | |

AN
(RN PN NN NN

Last Name

b
||
MIT

150 200

Figure 1-13
Fields aligned to rectangle
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When you are finished, choose Revert to Saved to restore the
Layout. Click Yes.

Setting Display Formats

4th DIMENSION allows you to set the display format for data.
The display format determines how the entries in each field
are displayed on your screen and printed.

You set the display format using the Layout editor. Each
layout can use a different format for the same information. On
one layout you may want numbers to be displayed in one of
these ways:

m 1234.567
m 1,234.57
m $1,234.57

On another layout you might want the format to include dollar
signs, commas, and a row of asterisks for printing the number
on a check:

Display formats are separate from the data you enter in the
fields. The display format does not affect the way you enter
the information, only the way it is displayed.

For the Employee input layout, you will set the display
formats for the Start Date and Salary fields. For our example
database, you have decided to show the start date in this
format: Mon, Jan 13, 1990. For Salary, you want a dollar sign,
a comma, and two digits to the right of the decimal:
$35,550.00.

CHAPTER 1: USING THE LAYOUT EDITOR 15



Handles on
selected object

To set the display formats:
Select the Start Date field.

You select the field by clicking on it. Be sure to select the
field, not the field label. The field has a box around it, while
the field label is a text element without a box.

[ & File Edit Use Design Layout Object Font Style

Layout: Employee Input ==i"—"——=—-l1=
\ »u
olal | Employee Information
Fs0
o Last Name  [Last Name | -
| =]
% == First Name [First Name | A
r1o0
== Start Date !Start Date i
2 | | Satary -
= F150
kr'hhl.l M Title [Title | [

Figure 1-14
Selecting the Start Date field

Choose Format from the Object menu.

4th DIMENSION displays the Field Definition dialog box.

- Field

Format pop-up —
1
mend [ast Name A {Shﬂl’t l
First Name A
Format v : [ﬁ‘
Y Title Al

editing box [Employees] &

~ Data Entry

Entry filter:

Enterable

[J Mandatory

[ Choices (List...) — _

[J Required [List...] Minimum:

[JExcluded [List...) Masgimum:

O fest wsith sconi bar Default:

[ Print sarinbie frams [Script._.] ( Cancel ] [[ 0K ]]

16

Figure 1-15
The Field Definition dialog box



CUSTOMIZING

The Field Definition dialog box allows you to set the display
format and control several other aspects of a field. You will
find an introduction to the advanced features in later chapters.
For now, we will use only the boxes in the upper panel.

The fields in the file are listed in the box on the left. The Start
Date field is highlighted. The date format choices appear in a
pop-up menu on the right. You set the format for the field by

choosing it from the pop-up menu. The current format for the
Start Date field is shown in the pop-up menu.

Choose Abbreviated from the pop-up menu.

Field
1

Last Name
First Name

[

Abbrevisted

Salary Short 2
Title

[Employees]

<l

Figure 1-16

Choosing from a pop-up menu

A pop-up menu is indicated by a drop shadow below the
box. You choose from a pop-up menu just as you do from
any menu. The only difference is that the menu appears on
the screen, not on the menu bar. Press and hold the Format
entry to display the menu. Then drag the mouse to highlight
the choice you want and release the mouse button.

The Abbreviated choice displays the date in the Mon, Jan 12,
1989 format. The Long format would show it as Monday,
January 12, 1989. The Short format would show it as 1/12/89.

Click OK.

4th DIMENSION displays the layout again. Although there

is no indication on the layout itself, 4th DIMENSION has
accepted your instruction for displaying the Start Date. From
now on, when you use this layout, the start date is displayed
in the format you have chosen.

The date field needs to be made larger to accommodate the
display format you have chosen.

CHAPTER 1: USING THE LAYOUT EDITOR 17
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Select the Start Date field (not the field label), and drag the
handle on the lower right corner to the right to make the field
longer.

You are now ready to set the display format for salaries.
Double-click on the Salary field.

Double-clicking is a shortcut to display the Field Definition
dialog box. 4th DIMENSION displays the dialog box again,
this time highlighting the Salary field.

Display the pop-up menu to see the format choices.
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Figure 1-17

Numeric display format choices

You can set the display format by selecting it from the choices
shown, by selecting and modifying it, or by entering the
format character by character.

The formal structure of the number display format has three
parts. The first part is the format for positive numbers, the
second part is the format for negative numbers, and the third
part is the format for displaying zero.

Choose $### ##0.00;-$###,##0.00

4th DIMENSION displays the format in the Format Editing
box. The number signs show that you can display up to six
digits; the zeros show that 4th DIMENSION automatically
displays two digits after the decimal (if they are not entered,
4th DIMENSION displays two zeros). A negative number is
preceded by a minus sign. There is no special format for zero.
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Click OK.

4th DIMENSION again displays the layout. You have
established the display format for the Salary field.

Seeing the Layout in Action

You can go directly to the User environment to see the results
of your changes.

Choose User from the Use menu.

4th DIMENSION automatically saves your layout, including
the display formats you have selected, and displays the records
on the output layout.

Select any record, and then choose Modify Record from the
Enter menu.

The record appears on the input layout you have been working
with. The layout title has been changed, the Start Date and
Salary are displayed in the formats you selected.

The Next Step

You often modify layouts in 4th DIMENSION—when you add
fields, rearrange layout elements, or design a custom layout.
The palette tools provide the power to make any layout clear,
attractive, and useful.

If you want to, you can change the display format for Salary
on your output layout as well. You can use the same format as
the one on the input layout, or you can use a different one.

In the next chapter you will learn how to add custom buttons
to the layout.

CHAPTER 1: USING THE LAYOUT EDITOR 19
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CUSTOMIZING

ADDING BUTTONS TO THE LAYOUT

Database: Personnel 2
Estimated time to complete: 15 minutes

4th DIMENSION provides more than a dozen automatic
Macintosh buttons that you can use to perform functions, such
as accepting the record, displaying the first record, going to
the next page in a multi-page layout, and deleting the current
record.

In this chapter you will learn how to
m create buttons on a layout

® use your custom buttons to save, cancel, and move between
records

Up to now, when you entered or modified a record, you used
4th DIMENSION's control panel to accept, cancel, and move
from record to record. The control panel is always on the left
side of the screen, with the buttons stacked vertically. Your
custom buttons will automatically replace the control panel.
When you have finished with this tutorial, your data entry
screen will look like this:

[ ® File Edit Use Enter Select Report Special ]
= | Entry for Employees ="ircea———————|

Bl

Employee Information

Last Name Wilson

First Name |Marlys

Start Date |Wed, Feb 27, 1980

Salary $32,560.00

Title [Technician

( 0K ][ cancel ][ Nest ][ Previous |

O]

] =

Figure 2-1
Macintosh buttons on the layout
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In this tutorial you will add four buttons to your layout, OK,
Cancel, Next Record, and Previous Record. A button is one of
several layout objects that allow special Macintosh features on
your layouts—buttons, check boxes, pop-up menus, areas to
display graphs, rulers, dials, and thermometers, and scrollable
areas from which to select items in a list.

Creating an OK Button

You’re now going to replace the Enter and Cancel buttons
provided by the control panel with your own custom buttons.
You will place them on the layout and include your own text
on them. In this section you will create an OK button.

If you have not done so already, start 4th DIMENSION and
open the Personnel 2 database.

Personnel 2 starts in the Design environment.
Double-click the [Employees] filename.

4th DIMENSION displays the Layout dialog box. Double-
clicking a filename in the Structure window is a shortcut that
opens the Layout dialog box with the file already expanded
to show the layouts for that file.

Open the Buttons layout.

Click the zoom box or use the resize box to expand the
window to fill the entire screen.

You are going to position the buttons below the border,
separate from the portion of the layout that contains the fields.

Click the Create Active Object icon on the palette.

Clicking this icon informs 4th DIMENSION that the next area
you define on the layout will contain an active object.

Draw a rectangle below the frame and below the report control
marks, about 1 inch long and 1/2 inch high. Start in line with
the left edge of the border of the data entry area.
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[ & File Edit Use Design Layout Object Font Style

Start Date  [Start Date |

| | Salary

SR ——— Layout: Buttons

I . g
olal | Employee Information [
) Last Name  [Last Name | 550
=E- First Name [First Name | A
=& 100

150

Title [Fite ]

Figure 2-2

Drawing a custom button on the layout

When you release the mouse button, 4th DIMENSION displays
the Object Definition dialog box. The Object Definition dialog
box is similar to the Field Definition dialog box you used in
Chapter 1.

- Definition

Name: | ! Format:

Tupe: [:&: Enterable ]

Object action
pop-up menu

[Numeric ]

- Data Entry

Entry filter:

[JMandatory

[ Choices
O Required Minimum:
[ Excluded

[ Text with scroll bar

Masimum:

Default: |

[ Print variable frame
& Only if modified

Figure 2-3
The Object Definition dialog box

An active object can perform many actions, from displaying
data to working as a button or pop-up menu. You are going
to use this active object as a button.

CHAPTER 2: ADDING BUTTONS TO THE LAYOUT 25



7. Name the button bOK and press Tab. The text area will be
selected; label the button OK.

The Format area has a new title, Button text. OK is the text
you want displayed on the button when it appears on the
screen. You could have typed any text that would convey
the meaning you want—Enter, Accept Record, and so on.

8. Press and hold the Type menu to display the pop-up menu of
types of objects.

There are 15 types of layout objects you can choose
from. For complete information about these choices,
see the 4th DIMENSION Design Reference.

Enterable

MNon-enterable

® Radio Button
B Check Box
3 PopUp Menu
[CB scrollable Area
i Invisible Button
[ Highlight Button
9Bl Radio Picture
Graph

== External Object
EED Thermometer
L] Ruler

& Dial

Figure 2-4
Choosing from the Object Type pop-up menu

9. To create a button, drag the pointer to highlight the third
choice, Button, and then release the mouse button.

Button text - Definition

Object name Name: [ hoK | Button text:
Object type Type: [ Button ] [ok

Object action _[X_No Action ]

26

~ Data Entry

Ealry filler

[ ™andnioryg
O i asives PR ] b

O geguizes  (Lisd. ) Minimum:
O #nciuges [List... Magimum:
[ tesut usith sceodf bar Default:
Print yariabie frame
- (tancsr ] C k)

[ Only if modified

Figure 2-5
Entering button text
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10. Press and hold the Action menu to display the pop-up menu
of actions.

Just as Button is one type of object, these choices are different
actions you can assign to the button. You can choose from the
list of 13 actions. You will choose 4 actions for buttons in this
tutorial. For complete information about these actions, see the
4th DIMENSION Design Reference.

11. Highlight Accept, and then release the mouse button.

X No Action
@ Cancel
=)

B Accept

P Next Record

4 Previous Record
I First Record
Pl Last Record
W Delete Record
D Next Page

€10 Previous Page
{0 First Page

0% Last Page

D% Open Subrecord
D2 Delete Subrecord
O Add Subrecord

Figure 2-6

Choosing an action for the button

4th DIMENSION displays Accept as the action. The button
you are defining will cause a record to be accepted when it is
clicked.

12. Click OK.

4th DIMENSION displays the layout again, this time with your
button on it. Note that the rectangle you drew has changed to a
shape with rounded corners, the regular Macintosh shape for
this type of button.

You have added the first of your buttons to the layout. In the
next section you will create additional buttons the same size as
this one.

Duplicating and Editing Buttons

For your screen design, you want all your new buttons to be
the same size. The easiest way to accomplish this is to
duplicate the button you just created and then edit the
definition of each of the copies.

Remember, you are adding OK, Cancel, Next Record, and
Previous Record buttons to your layout. You’ve already added
OK, so you need three more buttons.
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Copy has
been moved

Original

If necessary, click the OK button you just created to select it.
Then click the Duplicate icon.

4th DIMENSION creates a copy of the OK button. The copy
has all the instructions you used for the first OK button. When
4th DIMENSION duplicates a layout element, all the
instructions for the element are copied as well (for example,

a field’s display format is copied).

Drag the new button up next to and to the right of the first
button.

When you position this button and keep it selected, you
prepare to use 4th DIMENSION’s smart duplicate feature.

4th DIMENSION remembers where you positioned the button
in relation to the first button. The next copy is similarly placed
automatically.

[ & File Edit Use Design Layout Object Font Style ]
E=——— layout: Buttons =——————115|}

NI 5

A Employee Information

r:"1
[rst]

1

Last Name [Last Name | -

First Name [First Name | C

Start Date  [Start Date |

w] | setery

Title [Titie |

i) |l ﬂ-m 0[]0

r150

button

28

Figure 2-7
New button created with Duplicate, selected for the next step

Click the Duplicate icon two more times.

4th DIMENSION creates two more buttons, each placed to the
right of the previous copy. If for some reason the duplication
does not place the new button to the right of its original, you
may have inadvertently selected something else before
duplicating. Delete any copies you have made and start over
again at step 1.
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11.

To align the four buttons exactly, Shift-click all four to select
them as a group, and then click the Align Top icon.

4th DIMENSION aligns the buttons in relation to each other.

If you make a mistake, don’t forget that you can go back a
step by choosing Undo from the Edit menu.

Click anywhere other than the four selected buttons.
The four buttons are deselected.
Now double-click the second button.

Double-clicking the button displays the Object Definition
dialog box for that button. You are going to make this button
the Cancel button. The instructions in the dialog box are the
ones you entered for the OK button. To make this button the
Cancel button, all you need to do is choose Cancel for the
action and change the display text.

Name the button bCancel and label it Cancel.
Choose Cancel from the Action pop-up menu.
Click OK.

4th DIMENSION again displays the layout. The second button
is changed to a Cancel button.

Make the third button a Next Record button by double-
clicking it, changing the button name to bNext, the button
Action to Next Record, and the button text to Next.

Make the fourth button a Previous Record button by double-
clicking it, changing the button name to bPrevious, the button
action to Previous Record, and the button text to Previous.

Your layout is finished; it now includes the set of custom
buttons you have created.

CHAPTER 2: ADDING BUTTONS TO THE LAYOUT
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[ € File Edit Use Design Layout Object Font Style

El Layout: Buttons

;;3 Employee Information

) Last Name  [Last Name |

E%; First Mame [First Name |

== Start Date  [Start Date |

2w | soery

MM Titte [Title ]

i

r 0K ]L Cancel ][ Neutg]:[ Previous I
140 o 200 250 300 350 40

Figure 2-8
Custom buttons added to the layout

Seeing the Custom Buttons in Action

As you learned in the previous chapter, you can go to the User
environment to check on work you have done in the Design
environment.

Since 4th DIMENSION removes the standard control panel
when you create your own buttons, you want to see how the
new buttons affect the screen design of your layout.

Marlys Wilson has been promoted in the Art Department; her
new title is Supervisor; her new salary is $36,500. You are
going to use your new layout to modify her employee record.

Choose User from the Use menu.
4th DIMENSION displays the records in the List layout.

Select the record for Marlys Wilson, and choose Modify
Record from the Enter menu.

4th DIMENSION displays your previous input layout.
Because you have created another input layout, you need
to tell 4th DIMENSION to use the new layout instead.




Click to set new
input layout
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Choose the Choose File/Layout command from the File menu.

4th DIMENSION displays the Choose File/LLayout dialog box.
This dialog box lets you establish the input and output layouts
for each file.

Double-click the [Employees] filename to display the layouts
for that file.

Choose File/Layout...

Select layout

Employee List 0 LT

Employees Employee Information|
Employee Input [ e
Input P - —

Click to complete
instructions

[J output =

ROy —")
a Choose l

Done

<]

fupand

Figure 2-9
The Choose File/Layout dialog box

Select Buttons from the list (do not double click on it), click
the Input check box, then click Choose.

4th DIMENSION displays the Buttons layout, ready for you to
enter information.

LC File Edit Use Enter Select Report Special ]
IE———— Entry for Employees aIE |
&
Employee Information
Last Name
First Name |Marlys
Start Date  |Wed, Feb 27, 1980
Salary $32,560.00
Title [Technician
( 0K | cancel ][ Next ][ Previous |
0]
@ S |

Figure 2-10
Seeing your custom layout in the User environment
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4th DIMENSION has removed the standard control panel
from the left side of the screen. Now your custom buttons
are arranged across the bottom of the screen.

Enter the new information for Marlys Wilson:

Salary: 36500 :

Title: Supervisor

Click Next.

4th DIMENSION displays the next record in the database.
Click Previous.

4th DIMENSION displays the record you just modified.
You can use Previous and Next to move from record to
record as often as you want.

Finally, click OK.
4th DIMENSION returns to the output layout for this database.

The Next Step

You have added Macintosh buttons to your layout for
accepting and storing the information on the current record

or canceling the entry or edit operation. The other buttons
you added allow you to move from record to record (Previous
and Next).

In the next chapter you will do more work with the Layout
editor. You will add a new page to a layout, and then change
the data entry order.
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MULTI-PAGE LAYOUTS AND
DATA ENTRY ORDER

Database: Personnel 3
Estimated time to complete: 20 minutes

4th DIMENSION allows you to control virtually everything
about your layouts. If you have too many fields to
conveniently display on one screen, you can add additional
pages. During data entry, when you use the Tab key to move
from field to field, 4th DIMENSION automatically selects the
next field according to the data entry order. You can change
the data entry order to fit your needs. In this chapter you will
learn how to

m add a page to your layout, making it a multi-page form

m change the data entry order

CHAPTER 3: MULTI-PAGE LAYOUTS AND DATA ENTRY ORDER 35
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Single-Page and Muliti-Page Layouts

4th DIMENSION’s layouts provide a huge “page” on which to
place fields and graphic elements, and display fields from
included files and subfiles. A single-page layout can be as
much as 144 inches wide and 142 inches high (almost 12
square feet). You use the scroll bars to move around the layout
in the Layout editor.

[ ® File Edit Use Enter Select Report Special ]
I=——— Entry for Employjees =—————[-
{_Enter ) Employees
A Last Name [Tattinger
First Name |Nicol
Start Date 5/8/85 Doctor
E Salary 35500 Emergency Phone
Department Art
Spouse [Michele
Address |19?8 Intercoastal Dr.
City [Birmingham
State |aK

Figure 3-1

A layout can be much bigger than the screen

You may want to divide this large layout into two or more
separate pages. 4th DIMENSION calls such a layout a multi-
page layout. When you use a multi-page layout, you can

m reduce the amount of scrolling necessary to work with a
layout.

m create a more attractive layout, in some cases.

m group related fields together on a particular page for
quickly updating related information. For example, you
could place all the fields that need regular modification on
the first page of a layout.

m design each page of the layout to fit the size of the display
monitor used by your system.

®m imitate your company’s current multi-page forms.
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Many standard forms, such as employment applications,
contracts for real estate, and insurance forms, contain several
pages, with blanks on each page to fill out. Just like turning to
the proper page in a multi-page paper form, when you use a
multi-page layout you can display the exact page that contains
the information you want to view or change.

Adding a Page

Suppose you have been working with another layout for the
personnel database, one that keeps track of emergency
information for each employee. The layout you are now using
takes up more than the entire screen. You decide to add a page
to the layout so that you can more conveniently display the
information on two screens. Two pages allow you to create

a more attractive display for the information, and reduce the
amount of scrolling you have to do during data entry.

You plan to place official information on the first page (name,
salary, department, and so on), and personal information on
the second page (address, spouse’s name, doctor’s name, and
telephone).

The several steps presented here show you how to add a page,
choose the parts of the layout you want to display on the new
page, and how to transfer them to the new page.

If you have not done so already, start 4th DIMENSION and
open the Personnel 3 database.

Personnel 3 starts in the Design environment.
Display the Emerg Records layout.
If needed, click the zoom box to expand the window.

Expanding the window reveals all the icons.
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Figure 3-2
The Emerg Records Layout

Add a page to the layout by clicking the Next Page icon.

Since there is no next page, 4th DIMENSION asks if you want
to create 1it.

_Click OK.

4th DIMENSION creates a blank page. The page number of the
page is in the bottom right hand corner.

Now you can select the fields you want to place on the second
page.

Adding Fields to the Layout

2.

4th DIMENSION provides a way to go back to the New Layout
dialog box so that you can add fields to an already existing
layout. To add the personal fields to the new second page:

Choose Add to Layout from the Layout menu.
The pointer changes to a right-angle marker.
_Click near the upper left corner of the screen.

This spot marks the upper-left corner of the layout that will
appear. 4th DIMENSION displays the New Layout dialog box.
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Select Spouse, Addréss, City, State, Zip Code, Phone, Doctor,
and Emergency Phone.

To select a field, you can either select the field, then click the
Select button, or you can simply double-click the field.

Select the 9-point font size, and then click OK.

4th DIMENSION adds the fields you selected to the second
page of your layout.

& File Edit Use Design Layout Object Font Style
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Layout: Emerg Records
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e Emergency Phone [
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Figure 3-3
The second page of the layout

Adding Next Page and Previous Page
Buttons

You have created a second page and placed the elements you
want on it. Now you need to add buttons to allow you to move
between the two pages.

Go back to the first page of your layout by clicking the

_Previous Page icon.

Add a Next Page button to the first page of your layout.

Use the Create Active Object icon. Name the button bNext,
select Next page from the Action pop-up menu and enter
Next Page for the button text.
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Figure 3-4
A Next Page button on the first page of the layout

3. Copy the button.

To copy an object you first select it, then choose Copy from the
Edit menu. _ ‘

4. Go to the second page and paste the copied button there.

To paste an object you have just copied, choose Paste from the
Edit menu, then drag the object into position. When the object
is in place, click anywhere outside the object to deselect it.

5. Change the name of the copied button to bPrevious, the action
to Previous Page, and the button text to Previous Page.

Your new layout is complete.

Seeing the Multi-Page Layout in Action

Now that you have created a multi-page layout, you can see
how it works.

1. Go to the User environment and change the Input layout to
Emerg Records in order to see your multi-page layout.
Changing the layout is described in Chapter 2.

2. Add a new record. Use the Next Page and Previous Page
buttons to move between the two pages of your single layout.
Switch to the Design environment when you are finished.
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Data Entry Order

You may have noticed that 4th DIMENSION automatically
selects the fields on your layout as you use the Tab key to
move from one field to the next. 4th DIMENSION maintains a
data entry order that determines the order in which the fields
are selected. You can change this order.

The original data entry order 4th DIMENSION uses is based
strictly on the position of the fields on a layout. The order
proceeds from left to right and from top to bottom. If one field
1s above another, it is selected first; if one field is to the left of
another, it is selected first. Precedence is given to a field if it is
even one pixel above another. (A pixel is one dot on the
screen.)

Employees

Doctor __|Doctor |

This field is chosen first
because it is to the left of
the other field

Emergency Phone  |[Emergency Phone |

Employees
Doctor Emergency Phone
[Doctor | [Emergency Phone

Figure 3-5
The data entry order is first determined by location

You can change the data entry order to

m select fields in logical order, which may be different from
the current data entry order.

m select fields in the order the information is presented for
data entry. For example, a form that a customer fills out
may show the information in a different order from the
fields on the screen.

m place fields that are rarely updated last so they can be
skipped if necessary.
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Changing the Data Entry Order

In this section, you will use a layout that displays the
information conveniently but has an awkward data entry order.
You will change the data entry order to make data entry easier.

Choose Layout from the Design menu, then open the Side By

~ Side layout.

4th DIMENSION displays the layout in another Layout editor
window.

If needed, click the zoom box to expand the window.

[ & File Edit Use Design Layout Object Font Style
E —_— S

:“ Employee Information:

Layout: Side By Side

Lo}

5]

(] Last Mame Start Date
Bl First Name
. Departrent
EH
addr  [Address |
=|| W B s
= city [City ] st [EE zip [Eip Cod! e
il
1
il |1
Phone —
Emergency Fhone Emetqency Ph Dactar

Figure 3-6
The Side By Side layout

As you can see, this layout provides an attractive visual
display of fields, exactly like the paper form used by your

employees for information. Unfortunately, the data entry order
makes it difficult to enter the information.

Choose Entry Order from the Layout menu.

4th DIMENSION displays the data entry order, and the pointer
changes to a small arrow. The data entry order is indicated by
arrows that point from field to field. As you can see, this order
goes across the screen before going down the screen. Ideally,
you want to enter information into the fields on the left first,
then into the fields on the right.
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[ & File Edit Use Design Layout Object Font Style ]
i Layout: Side By Sidle —=———————115
m Employee Information:

OA

)] T e — .
=] | st vame ,

=1|E8

—t— sddr  [Address L | >

== &= city  [City 0—@@ 4 ?

T

[T

Phone |Phone }

1) —=
[Fuz} Emergency Phone  [Emerqee e

Figure 3-7
The data entry order

The selection order arrows extend from the middle of one field
to the middle of the next. You change the order by drawing
new selection order arrows from one field to another.

Here is the order you want to end up with:

| & File Edit Use Design Layout Object Font Style ]
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Figure 3-8
The desired data entry order
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“Move the pointer to the Last Name field on the left side, then

press and hold down the mouse button as you drag the pointer
to the First Name field.

When you release the mouse button, 4th DIMENSION redraws
the selection order arrows for all affected fields.

You could continue in this fashion, drawing the new data entry
order from field to field. But 4th DIMENSION provides a way
to quickly change whole groups of fields.

. _ Drag a marquee around the group of fields on the left.

Marquee

Small arrow
pointer

[ % File Edit Use Design Layout Object Font Style ]
; Layout: Side By Side =————| EE
Employee Information:
Last Name Start Date x5
T S S I

First Narme  |First Mame¢—

addr  [Address e——"__1 1,

city [City e »H%Efg_g 3 ey ]

e
i |1 T — L
Phone Fhone o EE.
H - -

Emnergency Phone  [Ernetqe et

Figure 3-9
Dragging a marquee around a group of fields

When you release the mouse button, 4th DIMENSION
automatically redraws the data entry order. The order goes
down the left group first, then up to the right group.
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[ & File Edit Use Design Layout Object Font Style ]
SE Employee Information:

OlA!

C) |:] Last Name Start Date

=|=— First Name

=I|EB - { I

—T= Addr I ress - * +

==& city [City__e=—rFstfesl-zrEipsod =

Phone [Phone &° ] Spouse

-

Emergency Phone m Doctor

Figure 3-10
The new data entry order

.Return to layout editing by clicking on the pointer tool.

Try out your new custom data entry order in the User
environment.

Remember that you have to change the current input layout to
Side By Side to use your new data entry order.

The Next Step

The Layout editor is a flexible design tool. You can create
layouts that assist the data entry process, that display the
information effectively, and that look attractive.

Practice with the Layout editor to learn more about what you
can do with lines, shapes, and fill patterns. You can find
complete information about the tools available in the Layout
editor in the 4th DIMENSION Design Reference.

In the next chapter you will add a field to the database, and to
a layout, and use the Lists editor to create a list from which
you can select an entry for a field.
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ADDING FIELDS AND USING LISTS

Database: Personnel 4
Estimated time to complete: 20 minutes

You can add new fields at any time to a 4th DIMENSION file.
You already know how to create a field from Quick Start.
Adding a field is essentially the same process, except that you
must remember to place it on any existing layouts in order to
enter and view data.

You add fields to a database when you discover that you need
to store an additional piece of information on each record.
You add fields to layouts whenever you create a custom layout.

4th DIMENSION allows you to create lists for field entries.
You can display the list during data entry and choose the entry
from the list. Choosing from a list simplifies data entry, and it
ensures that the entry itself is exactly right—no misspelled
words, no extra spaces.

You can have many lists in a single database. You can use lists
for several fields and enterable objects. You can make a list
mandatory, so that only an entry that appears on the list can be
entered. Or you can make a list excluded, so that no entry that
appears on the list can be entered.

In this chapter you will learn how to
m create a list

m add a field to the database

m place a field on a layout

m attach a list to a field

m use the list for data entry
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Creating a List

Your company offers several health plans for its employees.
You have decided to keep track of which health plan each
employee has selected. In this section, you will make a list
of the plan names. This list will provide data entry choices
for the new field you plan to add to the database.

If you have not already done so, start 4th DIMENSION and
open the Personnel 4 database.

Personnel 4 opens in the Design environment.
Choose Lists from the D{_esign'menu.

4th DIMENSION displays the Lists editor.

e lists =—=———"UF
Lists... Items...
(b s
1] o
|
Figure 4-1

The Lists editor

The names of the lists you create appear in the Lists panel,
and the choices on each list appear in the Items panel.

Choose New from the Lists menu.
4th DIMENSION displays a dotted-line box in the Lists panel.
Tipps Mealih, Flens,

Health Plans is the name of this choice list. You will use this
name whenever you want to activate this list.

Having created the list, you now will add the items on it.
Choose New from the Items menu.

4th DIMENSION displays a dotted-line box in the Items panel.
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Type White Cross.
White Cross is one of the health plans an employee can join.
Choose New from the Items menu.

4th DIMENSION adds the first item to the Items column and
displays a second dotted-line box.

Type King HMO, and then press Return.

4th DIMENSION adds the second item to the Items column
and displays another dotted-line box. Pressing Return is a
shortcut for choosing New from the Items menu.

Complete the list by entering the following choices:
Green Shield

National

None

Choose Sort from the Items menu to arrange the choices
in alphabetical order.

4th DIMENSION sorts the titles.

S[I==——— lists ==—————"11=
Lists... Items...
Health Plans ¥ |Green Shield 2
King HMO
National
None
White Cross|
= ]
]
Figure 4-2

The completed list with sorted choices

When you create a list, 4th DIMENSION assumes you

want to be able to modify the list during data entry. Because
your company might add a new health plan in the future, you
decide to allow the list to be modified.

CHAPTER 4: ADDING FIELDS AND USING LISTS 51



52

IEH Items

New
Delete

vUser Modifiable

11. Pull down the Lists menu to ensure that User Modifiable has
a check mark. :

The check mark indicates that the list is modifiable. If the
check mark does not appear next to User Modifiable, choose
User Modifiable to place the check mark.

12. Click the Close box to close the Lists editor.

That’s all there is to creating a choice list. In the following
sections, you will see how to attach this list to a field and
how to use it during data entry.

Adding a New Field

You have created a list that offers health plan choices. In this
section you will add a field and attach the list to it so that the
list appears during data entry.

1. If needed, select Structure from the Design menu.

2. Double-click beneath the last field of the [Employees] file.
Double-clicking is a shortcut for choosing New Field from
the Structure menu. 4th DIMENSION displays the Field dialog
box, ready for you to add a new field to the file.

If you accidentally click one of the existing fields in the file,
4th DIMENSION displays the Field dialog box for that field.
In such a case, just click Cancel and try again.

3. Create a field called Health Plan and use the default field type,

Alpha 20.
As you did in Quick Start, type the field name.

4. Click the Choices check box in the Lists section.

When you select Choices, the List button becomes active.

5. Click the List button.

4th DIMENSION displays the Lists dialog box. This dialog box
displays all the lists that have been created for this database.
Since you have created only the Health Plans list, it is the only
one displayed.
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Lists...

%
Cancel Il Select ]I

Figure 4-3
The Lists dialog box

With the Health Plans list highlighted, click Select.

4th DIMENSION returns the Field Definition dialog box
to the screen. Whenever you select this field during data
entry, the Health Plans list will appear so that you can
select that employee’s plan.

Click OK.

4th DIMENSION displays the Structure window. You
have successfully added the Health Plan field to the file.
The new field, however, does not yet appear on any
layout. You need to add it to an existing layout.
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Double-click
here to display
the Layout dialog

Placing the New Field on a Layout

Now that your new field exists, the next step is to add this field
to a layout. To do this you use the Layout editor.

Double-click the filename title bar.

Ernployees
Last Name &
First Mame &
Start Date [
34
&
&

Salary
Title
Health Flan

Figure 4-4

The [Employees] file with an added field

Double-clicking the filename title bar in the Structure window
tells 4th DIMENSION that you want to see a layout for that
file. When 4th DIMENSION displays the Layout dialog box,

the [Employees] file is already expanded to show the layouts
for that file.

Double-click the Employee Input layout.

4th DIMENSION displays the Employee Input layout. You are
going to add the new field to this layout.

_ Select the frame of this layout and make it bigger by dragging

the lower right corner toward the bottom of the screen.
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Layout frame
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Click the Add Field icon on the palette, then draw a rectangle
in the space you have added to the frame of the layout

[ & File Edit Use Design Layout Object Font Style ]
[EJ=—————= Layout: Employee Input =——=|
R (=15
Olajl | Employee Information S
O[] Last Name  [Last Mame | ™0

First Name [First Name | [
r100

Start Date  [Start Date |

Salary Salar

Title [ritie | i

i
il

Figure 4-5
Drawing an area for adding a field

As soon as you finish drawing the field area, 4th DIMENSION
displays the Field Definition dialog box. You use this dialog
box not only to set the field display format (as you have done
before), but also to choose the field you want in the field area
you have just drawn and to set any data validation instructions
for that field.

- Field

Lazt Narne l
First Marne
Start Date

Salary
Title
Health Plan

~ Data Entry

(] Enterable
[O™Mandatory

[ Choices List... |
[JRequired [List...
O Excluded List... |

Dot usith srol bar Default: I:l

[ #risst savinbis frama , Script...] [ Cancel ] [[ 0K ]]

Entry filter:

Figure 4-6
The Field Definition dialog box
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Select Health Plan from the list of fields.

Click OK. Select 12 point from the Style menu.

4th DIMENSION displays the layout with the added field.
Use the Text Area tool to create a field label: Health Plan.

~ Make it 12 point.

Align the text to the field with the Align Top tool.

Remember to select both the new text area and the Health Plan
field before you click the Align Top tool.

Select only the Health Plan field and then press Command-1
to create a box around it.

& File Edit Use Design Layout Object Font Style ]

Layout: Employee Input %E‘EE
o) ;

s,

i
L]

5

olal | Employee Information
(- Last Name  [Last Name | [0
= First Name [First Name | L
G b r100
== Start Date  [Start Date | r
| | serery i
= F150
M Title [ritle | -

Health Plan [Health Plan

5 Al

4-7
The layout with a new field added
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This tutorial has taken you through adding a field to a layout
to emphasize this point: new fields are not automatically added
to layouts. Here is the rule to remember:

You must add a new field not only to the structure of the
database, but also to any existing layouts you want to use
it on.

Of course, any new layouts you create can automatically
include the new field, along with the other fields in the file.

Seeing the Choice List in Action

As you found in the previous chapters, you can go quickly to
the User environment to check on work you have done in the
Design environment.

You want to see how the new choice list affects how you enter
information into your layout.

Choose User from the Use menu.
4th DIMENSION displays the records in the List layout.

Select a record and choose Modify Record from the Enter
menu.

4th DIMENSION displays your modified input layout.
Select the Health Plan field.
4th DIMENSION displays the choice list.

Choices for Health Plans

King HMO
National
None
‘White Cross

%

[ Cancel ] [ Modify ]

Figure 4-8
The choice list displayed during data entry
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Click National.

4th DIMENSION enters National in the field and puts away the
choice list. The Health Plan field remains selected.

Feel free to experiment with the choice list. You can select a
different field, then select the Health Plan field to display the
choice list again. You can select a different entry from the list
to replace whatever has been previously entered. You can
click Modify to return to the Lists editor to add or delete items
from the list.

When you have finished using the list, click Enter or Cancel.

4th DIMENSION returns to the output layout for this database.

The Next Step

Choice lists provide a convenient and fast way to enter data
into a field accurately. You create a choice list in the List
editor. In this chapter you attached the choice list to a field as
a field attribute. In the next chapter you will see additional
ways to use choice lists for data validation.
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VALIDATING DATA

Database: Personnel 5
Estimated time to complete: 15 minutes

How important is correct information? An incorrect mailing
address can be either annoying or disastrous, depending on the
information that is delayed or not delivered. An incorrect total
in your checking account statement can be annoying; indeed,
if it goes undiscovered, it can be ruinous.

There are many ways incorrect information can find its way
into a database. Information can become out of date. It can
be entered wrong either accidentally or on purpose. It can be
calculated with an incorrect formula. And the list of what can
£0 wrong goes on.

The purpose of data validation is to check the information
before the record is accepted into the database.

4th DIMENSION provides many ways to validate data. You
can create lists of values that either must be used or may not
be used for a field. Using field attributes, you can ensure that
each record contains a unique entry in a field. You can
establish a range of acceptable numeric values, rejecting any
entry that does not fall between the upper and lower limits.
Or you can use 4th DIMENSION’s extensive language to write
scripts that perform almost any type of data validation.

In this chapter you will learn how to

m use field attributes for data validation

m create an entry filter to reduce typing errors in a field
m create upper and lower limits for a numeric field

m use a list to set required entries for a field
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Using Field Attributes for Data Validation

Field attributes provide several very useful ways to validate
the information that you enter into your database. For
example, applying the Mandatory attribute to any field makes
it impossible to enter a record without an entry in that field.

The Personnel 5 database has a new field for the employee’s
social security number. You will specify attributes that help
to validate the entries in that field.

If you have not done so already, start 4th DIMENSION and
open the Personnel 5 database.

Personnel 5 opens in the Design environment.
Double-click the SSNumber field in the [Employees] file.

Double-clicking is a shortcut for choosing Change Field from
the Structure menu. 4th DIMENSION displays the SSNumber
Field dialog box, ready for you to make any changes to the
field instructions.

If you accidentally click another field in the file,
4th DIMENSION displays the Field dialog box for that field.
In such a case, just click Cancel and start over.

Notice that the SSNumber field is an Alpha 9 field. All social
security numbers have nine digits. You will use the special
4th DIMENSION formatting features to allow space for the
two hyphens.

Select the Mandatory attribute.

Mandatory prevents a record from being accepted without
a social security number.
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Field for file Employees

Name: |[BQIIYLTTS

~Types — _ Attributes

] Mandatory
'S [J Display only
O [JCan't modify
[J Indexred
O O s#aigus
O [ Choices
9]
O
&
© - Cancel 0K |
O 08 subfile (_cancel J[_
Figure 5-1

Making SSNumber Mandatory

Now you will add other attributes to further protect the
integrity of the social security numbers in your records.

Select'Index_ed, then select Unique.

When you select Indexed, the Unique attribute becomes
available. Unique prevents any duplicate entries in the
SSNumber field.

Click OK.

4th DIMENSION displays the Structure window. You have
successfully changed the attributes of a field. The attributes
affect the SSNumber field on every layout on which it appears.

You could go to the User environment to see the results

of adding these attributes. But the next sections contain
additional data validation techniques. You may want to wait
until the end of this session to see the results in the User
environment.
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Setting an Entry Filter

An entry filter checks the information entered against a
pattern. If it matches the pattern, it is accepted; if it doesn’t
match the pattern, it is rejected. An entry filter can standardize
what appears in a Telephone Number field, or, in the case of
social security numbers, can ensure that the correct number
of digits is placed between hyphens.

Generally, when you specify an entry filter, you should also
specify a display format. The entry filter affects data entry
only; it has no effect on the way a field value is displayed
and printed. If you use hyphens in your data entry filter,
for example, they will be printed only if you also create a
display format for the field.

Double-click the title bar of the [Employees] file.
When the Layout dialog boanppears, double-click the

~ Validate layout.

4th DIMENSION displays the Validate layout. You are going
to use this layout for data validation controls.

Double-click the SSNumber field.

4th DIMENSION displays the Field Definition dialog box for
the SSNumber field.

Select the Entry Filter box.

An Entry Filter can be used to set any sort of pattern for
entering data. 4th DIMENSION then applies the pattern
whenever a value is entered into this field on this layout.
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You create patterns from symbols on your keyboard. Here is a
short table of the symbols and their meanings.

Symbol Meaning

& Signal that filter begins
# Placeholder symbol

9 Any number

a Any letter

A Any capital letter

~ Forces capital letter

For complete information, see the 4th DIMENSION Design
Reference.

To require a particular punctuation mark, simply use it in the
filter. All social security numbers follow a format of three
numbers, hyphen, two numbers, hyphen, four numbers
(123-45-6789). The next step shows an example of how to
specify this pattern.

To create the pattern for the SSNumber field, type the
following:

QOH#HH-HH#t-HEH#

The Entry Filter pattern specifies the entry format for the
SSNumber field. Each entry is forced into this format; only
numbers are accepted. The entry filter has no effect on the way
a value is displayed. In order to display the social security
number with hyphens, you need to add a display format.

Specify a display format for the field by entering the following
in the Format box (see Figure 5-2):

H#H-HH-HH

This display format ensures that the social security number
will be displayed and printed with hyphens. Without the
display format, only the numbers would be displayed.
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Format box

- Field
I1

Last Name
First Name
Start Date
Salary

HER-RE-BRER

Title

SENurber

- Data Entry

[ Enterable
[JMandatory

[ Choices

Entry filter:
GORFH-FH-HHES

] Required Minimum
] Excluded MR

[Jtest wsith scrad bar Default: :I

O print yarinbie frame  [Script..] [ Cancel | | ok ||

Figure 5-2
Entry filter and display format for social security numbers

Click OK.
4th DIMENSION displays the layout again.

This data validation technique helps prevent data entry errors
from affecting this important field.

Adding a Validation Range

Salaries in your company range from $15,500 to $105,000.
These are the lower and upper limits of acceptable salary
figures. To set these limits to validate entries in the Salary
field, you use the same layout.

Double-click the Salary field.

4th DIMENSION displays the Field Definition dialog box
for the Salary field.



You have already used this dialog box to set the display
format. Now you will use it to enter upper and lower limits for
the salary field.

Select the Minimum box and type 15500.
The lower limit for Salary is set at $15,500.
Select the Maximum box and type 105000.
The upper limit for Salary is set at $105,000.

Field
I
Last Name ###’##U I
First Name
Start Date
Title
SSNurnber
- Data Entry
Entry filter:
[ Enterable
[OMandatory
O Choices S
[] Required Minimum: 15500
[J Excluded Maximum: |105000
[ ¥est usith scrol bay Default: |
[ print sariabie frams [ Script...] ( Ccancel ] [[ 0K ]

Figure 5-3
The Field Definition dialog box for the Salary field

Click OK.

That’s all there is to it. Now whenever a value outside these
limits is entered into the Salary field, 4th DIMENSION will
refuse the entry and display an alert. You will see what the
alert looks like on the screen later in this chapter.
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Making a List Required

You created a list for the Health Plan field in the previous
chapter. The Personnel 5 database also includes a list for the
Title field. You want to ensure that only these titles and no
others are used in the employee records.

A list is commonly used to provide a quick, accurate method
for entering data. Unless you make the list itself required,
another title can be typed in (a feature you would want in
many cases). You can make the choices on the Titles list
required on this layout, which means that 4th DIMENSION
will accept only those entries and no others.

Double-click the Title _ﬁelAd.r _

4th DIMENSION displays the Field Definition dialog box for
the Title field. There are two field attributes you can set on
each layout—Enterable and Mandatory. These are exactly

the same as the Field Attributes, except that they affect a field
only on this layout.

Below the layout field attributes are the lists features. You can
attach a list to a field for only this layout, make a list required
for a field on this layout, or exclude a list of values from a
field on this layout.

Click the Choices check box in the Lists section.
Click the list button next to the Choices check box.
Select Titles from the list, then click Select.

By making Titles a Choices list, the user will be presented
with a Choices window.

Click the Required check box in the Lists section.
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Last Name
First Name
Start Date

SEMurnber

- Data Entry

[ Enterable
[JMandatory

X Choices

Entry filter:

X Required Minhmumn

[ Excluded List... Manimun

[ ¥ess? it serpl bay Default: I

[ erint sarinbis frams [script...] [ Cancel ]
Figure 5-4

Making a choice list required

Click the List button next to the Required check box.
4th DIMENSION displays the Liéts dialog box.
Select Titles from the list, then click Select.

Now 4th DIMENSION will accept only entries from the Titles
list for this field on this layout.

Click OK.
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Input layout
pop-up menu

Output layout
pop-up menu

Filename

Viewing the Results

Now that you have added these data validation features to
your layout, you can see the results in the User environment.

Choose User from thg_pse menu.

4th DIMENSION displays the output layout. Before using these
data validation features, you must tell 4th DIMENSION to use
the Validate input layout.

Here is a new method for changing the input layout. It is
usually much faster than using the Choose File/Layout dialog
box.

Press Command—Space.

A smaller window, the “List of files” window, is displayed in
front of the Employee records window. The “List of files”
window is always open, waiting behind the window you are
using. If you make the window smaller, you can see the “List
of files” window, and you can activate it by clicking on it.

== List of files =]

(11 [O] Employees

B[]

Figure 5-5
The “List of files” window

The layout icons are pop-up menus showing the layouts you
have created for the file. You use the Input Layout icon to set
a new input layout for that file, and you use the Output Layout
icon to set a new output layout for that file.
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Press the Input Layout icon for the Employees file and choose
Validate from the pop-up menu.

= List of files =
Employee Input
Employee List

Buttons
Dalidate
Scripts

=l

Figure 5-6
Choosing a new input layout from the “List of files” window

4th DIMENSION changes the current input layout to the
Validate layout.

Press Command—Space again to bring the output layout
to the front.

Or, you could just click the larger window.

Choose New Record from th& Enter menu.

4th DIMENSION displays the Validate input layout.
Try entering 106000 into the Sglary field.

As soon as you press Tab or Enter, or click on another field,
4th DIMENSION displays an alert box warning that the Salary
value is outside the valid range of entries for this field. This is
exactly what you want to happen. Enter a valid salary.

s The number must not be greater than
105000.

Figure 5-7
The alert message for an unacceptable value in a field
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Try entering alphanumeric information in the social security
number field.

4th DIMENSION rejects alphanumeric characters when you
type them. Enter a valid number.

Select the Title field, click Cancel for the choice list,
backspace over your entry and try to type a job title that
doesn’t appear on the Titles choice list.

4th DIMENSION refuses the entry. Click in the Title field
again to select one of the valid choices from the Choices list.

The Next Step

The data validation techniques you have used prevent gross
errors from affecting the information in your database. You
may want to try out additional techniques. Complete
information about using the Data Entry panel of the Field
Definition dialog box can be found in the 4th DIMENSION
Design Reference.

The next chapter gives you an introduction to using scripts and

default values. A script uses 4th DIMENSION procedures to
perform operations on a field. A default value is the initial
entry in a field.
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USING SCRIPTS AND DEFAULT
VALUES

Database: Personnel 6
Estimated time to complete: 10 minutes

A script is an instruction or series of instructions for

4th DIMENSION to execute. You can use a script to calculate
a value for a field, ensure that text entries are capitalized,
validate an entry, display a timely warning to the user, and
SO on.

A default value is an automatic initial entry in a field, a value
that 4th DIMENSION places in the field on each new record.
It remains that field’s value until you change it by entering a

different value. 4th DIMENSION provides a calculated default

value for current date, current time, and current sequence
number.

In this chapter you will learn how to
m create scripts to calculate values

E enter and use default values

CHAPTER 6: USING SCRIPTS AND DEFAULT VALUES
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About Scripts

A script is one type of 4th DIMENSION procedure. A script is
usually short, from one line to only a few lines long. A script
is always associated with an object on a layout (a field,

a button, or some other active object). When 4th DIMENSION
executes the script, it carries out the instructions provided by
the script.

The Procedure Editor

When you write a script, you do so using one of
4th DIMENSION’s two Procedure editors. You have the choice
of using the Flowchart editor or the Listing editor.

& File Edit Use Design Flowchart & File Edit Use Design Search
fae———————— £l Procedure: Search Listing SHee=————— 5|

“Search Routine

1 Ge=1)

SEARCH SELECTION((
uuuuuuuuuuuu ((Emp
DISPLAY SELECTION(
OUTPUT LAYOUT((Emy

End if|

‘Return to calling procedure or menu

Figure 6-1

Procedures in the Flowchart and Listing editors

The Flowchart editor is a graphically oriented procedure
editor, in which the instructions are presented as a series of
steps and tests that are connected with flowlines. The Listing
editor is a line editor in which the steps and tests are written as
text.

If you have used flowcharts to diagram procedures, you may
find the Flowchart editor more useful to you. However, most
people are familiar with procedures written as a listing. The
tutorials in this book use the Listing editor.
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Filename, Fields, and
Layouts (in italics)

Keywords

[ & File Edit Use Design Search ]
{E(Jl=———— Procedure: Procedurel ———1=
| &
[
Keywords - Employees -+ Routines E
= Last Name Arrays iy
If First Namne Boolean . :
Else = Communications aas
End if ompiler Directives
Case of
énd case
While

Figure 6-2

The Procedure editor (Listing editor)

The upper portion of the Procedure editor is where you enter
and edit the commands, functions, and other elements that
make up the script. You type the script into the text area. And
you can select many of the script’s elements from the selection
panels in the lower portion of the window.

Keywords: Symbols and phrases you use to construct your
procedure. The most commonly used symbol is := which
means gets. It is used to instruct 4th DIMENSION to place a
value in a field (or in a variable). For example, the statement

Monthly Salary := Salary/12

reads “Monthly Salary gets Salary divided by 12.” This
statement instructs 4th DIMENSION to take the value in the
Salary field, divide it by 12, and place it in the Monthly Salary
field.

Files: Fields and layouts from the current file. You can select
fields or layouts by clicking. You can display fields and
layouts from any file in the database by clicking on the small
arrows on either side of the panel title box.

Routines: Commands and functions provided by
4th DIMENSION. They are listed in alphabetical order.

A command carries out a task. For example, the ALERT
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command displays text in an alert window. A function returns
a value. For example the Round function rounds off a number
and returns (sends back) the new value.

Writing a Script

You have decided to add the monthly salary to each record.
You are going to use a script to calculate the value by dividing
the yearly salary by 12. You are first going to create a new
Monthly Salary field.

If you have not done so already, start 4th DIMENSION and
open the Personnel 6 database. It opens in the Design
environment.

Create a new field called Monthly Salary, make it a Real field,
and select the Display Only attribute.

The Monthly Salary field will contain a calculated value.
You make this field Display Only to prevent any different
value from being accidentally entered into it.

Creating a field is described in Chapter 4. The new field does
not yet appear on any layout. You need to add it to an existing
layout.

Open the Scripts layout.
You are going to add the new field to this layout.

Use the Add Field tool to place the Monthly Salary field
on the layout below the SSNumber field. Make the field
12 point. '

Placing a field on a layout is described in Chapter 4.
4th DIMENSION displays the Field dialog box.

Choose Monthly Salary from the list of fields.

Set the numeric display format by typing the following
into the format box:

0
S#it# #4#.00

Typing this set of symbols is another method of setting
the numeric display format, instead of choosing it from
the pop-up menu.

Click OK.
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8. Create a text area next to your new field and type:
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Monthly Salary

You are now ready to create a script.

display format

Select Monthly Salary in
the list of fields

Click the
Script button

- Field
First Marne hl
Start Date L |$###;##U-UU;‘$###,##U-Q
Salary [
Title ) 3‘-###,##0‘0[1
SENOmMbEr A
R
[Employees]
1
- Data Entry

Entry filter:

] Enterable
(DMandatory

[ Choices [ List... |
[JRequired [List... ]|
[J Excluded | List... ]

Ot

[t‘ancel | [[ 0K J]

| Script... ]

o

Figure 6-3
Defining the Monthly Salary field

You are now going to add a script to the Salary field that
computes a value for Monthly Salary.

Double-click the Salary field.

4th DIMENSION displays the Field Attribute dialog box for
Salary.

Set the numeric display format by typing the following into
the format box:

0
St #it#.00
Click the Script button.
It’s on the bottom of the dialog box.

4th DIMENSION displays the “Procedure type” dialog box,
which offers you a choice of using the Flowchart or Listing
methods for writing the script.

Leave the Listing button selected, and click OK.
4th DIMENSION displays the Procedure editor, in a window
titled Script: Salary.
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E[[=————=— Script: Salary =———=1=

Keywords - -+ Routines
Last Name <+ Arrays

First Name Boolean
ommunications
ompiler Directir

If
Else
End if

Case of

End case i Monthly Salary

E Emplayas fput

xceptions
ﬂ Execution Cycle

Figure 6-4
The Procedure editor for writing a script

The script you will enter is as follows:
Monthly Salary := Salary/12

This script reads “Monthly Salary gets Salary divided by 12.”
You can often write a script simply by clicking on items in the
three panels at the bottom of the window. In the next steps you
will select the field names from the middle panel, and the gets
symbol from the left panel. You will type the divide symbol
and the number.

Click Monthly Salary in the middle panel.

4th Dimension enters the field name in the top part of the
window.

Click the := symbol at the top of the Keywords list in the left
panel.

4th DIMENSION enters the symbol next to the Monthly Salary
field name.

Click Salary in the middle panel.
You are preparing to divide the Salary figure by 12.
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Click the close box to close the Procedure editor window.

Type: /12 and press enter.

The script is complete.

4th DIMENSION displays the Scripts layout in its window.

In a later section you will view the results in the User
environment.

Using a Default Value

You normally enter an employee’s record on the first day that
the employee starts work. The Start Date field, therefore,
almost always contains the current date on the day the record
is first created. You have decided to enter a default value to
make data entry faster.

Double-click the Start Date field.

4th DIMENSION displays the Field Definition dialog box for
the Start Date field.

Select the Default box.
It is just above the OK button.
Type #D.

This is a code for setting the current date as the default value
for a field.

Click OK.

4th DIMENSION displays the layout again. Subsequently,
when you create a new record, the current date will already be
entered in the Start Date field. You can type over the default
value if necessary.
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Seeing the Results in the User Environment

Now that you have added the field, script, and default value,
you can see the results in the User environment.

Choose User from the Use menu.

You modified the Scripts input layout. Before you can see the
results of your work, you need to switch input layouts.

Change the input layout by choosing Scripts from the List of
Files window.

You display the List of Files window by pressing
Command—Space. Choosing the input layout from the List of
Files window is described in Chapter 5, “Validating Data.”

Choose New Record from the Enter menu.

4th DIMENSION displays the Scripts input layout. The current
date 1s displayed in the Start Date field.

Enter a new salary in the Salary field, say 74000.

4th DIMENSION calculates the new monthly salary figure and
displays it in the Monthly Salary field.

[ ® File Edit Use Enter Select Report Special

[=————tntry for Employees =
) K
Enter | M
! Employees
; ; Last Name |
First Mame |
Start Date 6/1/89
Salary $74,000.00
Delete Title |
@ SSNumber
Monthly Salary $6,166.66
]
7] EEE

Figure 6-5
Record showing added field, calculated information, and default value
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The Monthly Salary field now contains information that can
be used in another place. If your payroll were set up to obtain
the monthly salary figure from this field, you can see that any
changes to an employee’s salary figure would be immediately
reflected on the payroll.

The Next Step

Scripts and default values can reduce data entry chores and
increase accuracy.

In Chapters 7 and 13, you will see more examples of using
scripts. You will use them to capitalize the entries in a field,
and to calculate totals and subtotals for a report.

In the next chapter you will use the Procedure editor to create
a global procedure, which you can then use in scripts for
several fields.
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USING PROCEDURES

Database: Personnel 7
Estimated time to complete: 20 minutes

Now that you have created a script in Chapter 6, you may
begin to see how useful 4th DIMENSION procedures can be.
A script is a procedure that is associated with a field or other
object in a layout. 4th DIMENSION allows you to write
procedures that can be used from within scripts. A global
procedure can be written once and used in many scripts and
other procedures.

In this chapter you will write a procedure that capitalizes the
first letter of a field entry. Then you will use this procedure in
scripts that you attach to two different fields.

You will learn how to

m get to the Procedure editor
m write a global procedure

m use the global procedure in a script

4th DIMENSION Procedures

4th DIMENSION uses several kinds of procedures:

Global procedures: A global procedure can be used in other
procedures or activated by a menu command.

Layout procedures: A layout procedure is associated with a
particular layout. A layout procedure is executed before the
layout is displayed, whenever a field or other object is selected
or modified, and again after the record is accepted.

Scripts: A script is a procedure that is associated with an
object on a layout. It can be executed as often as a layout
procedure, or only when the object is used.

File procedures: A file procedure is associated with a file.
A file procedure is executed before any layout for that file is
used for data entry.

In this chapter you will create a global procedure. You have
already created and used scripts (in Chapter 6 “Using Scripts
and Default Values™). You will use a Layout procedure in a

CHAPTER 7: USING PROCEDURES 87



Procedure list
area

later chapter. File procedures are useful in rare instances and
are not covered in this book. For complete information about
all these types of 4th DIMENSION procedures, see the

4th DIMENSION Design Reference and the 4th DIMENSION
Language Reference.

Getting to the Procedure Editor

Whenever you write a procedure, you use 4th DIMENSION’s
Procedure editor. For a script, you get to the Procedure editor
from within the Layout editor. For the other types of

procedures, however, you use the Procedure menu command.

If you have not done so already, start 4th DIMENSION and
open the Personnel 7 database.

Personnel 7 opens in the Design environment.
Choose Procedure from the Design menu.

4th DIMENSION displays the Procedure dialog box.

Procedure...

Global Procedures <}
File/Layout Procedures '—4 fieiete

Layout display
area

88

<a]

Name: | | Access: [ ]

Figure 7-1

The Procedure dialog box

The Procedure dialog box shows all the global, file, and layout
procedures associated with this database. At this point, before
any procedures have been created, there are no procedures to
list. Later you will be able to expand and collapse the lists to
see the procedures that you have created. (You use the Expand
and Collapse buttons, as in the Layout dialog box to expand
and collapse layout names.) When you highlight a layout
procedure, 4th DIMENSION displays the layout it is associated
with in the Layout display area.
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You must choose in this dialog box whether your procedure is
to be a global, file, or layout procedure. Because you are
writing a procedure that will be called by other procedures, it
is a global procedure.

The Global Procedures choice is already selected, so you don’t
need to change it. If you have deselected the Global
Procedures choice, be sure to select it before going on.

4th DIMENSION displays the “Procedure type” dialog box.

Procedure type:

® - Listing

') ? Flowchart

Procedure name:

Cancel 0K
Figure 7-2

The “Procedure type” dialog box

Here you name your global procedure and choose whether
to use the Listing or the Flowchart method for writing your
procedure.

If you are accustomed to using flowcharts to map out or
diagram procedures, you may find the Flowchart method
appropriate. However, most people are familiar with a listing
format, in which the procedures are written out line by line.

The choice between the two methods is available only for a
new procedure (such as this one). Subsequently, you can edit
the procedure only in the form in which you first write it.
Since most people prefer the Listing method, it is preselected.
For the purposes of this tutorial, don’t change the selection.

Type Uplow in the Procedure name box.

Uplow is a descriptive name for the procedure you will write.
It makes the first letter uppercase and the remainder of the
letters lowercase.

CHAPTER 7: USING PROCEDURES 89



90

Procedure
text area

Click OK.

4th DIMENSION displays the Procedure editor, in a window
titled Procedure: Uplow. You use the Procedure editor to write
and edit procedures.

[ ® File Edit Use Design Search

(M
mj |

Window split bar

Selection
panels

Eé[j% Procedure: Uplow
! &
]
Keywords + Ernployees Routines
= {r Last Narme Arrays
If First Marne Boolean
Else A Start Date Communications
End if Compiler Directives
Taseof Data Entry
£ Displaying
End case H Monthly Salary Exceptions
“while £ o ot E tion Ci {)

Figure 7-3

The Procedure editor

The upper portion of the Procedure editor is where you enter
and edit the commands, functions, and other elements that
make up the procedure. You can select most of the
procedure’s elements from the selection panels in the lower
portion of the window:

Keywords: Symbols and phrases you use to construct your
procedure.

Files: Fields and layouts from the current file. You can select
fields and layouts by clicking. You can display fields and
layouts from other files in the database by clicking on the
small arrows on either side of the panel title box.

Routines: Commands and functions provided by

4th DIMENSION. They are listed in alphabetical order or by
groups. You click the word Routines at the top of the panel to
select either an alphabetic or a grouped listing of the routines.
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Creating a Capitalization Procedure

You are now going to write the procedure to capitalize field
entries. This procedure is useful for preventing typing errors
from being stored in your database. When you use this
procedure in scripts, you can be sure that the names are
capitalized properly.

The procedure you will enter is as follows:
$0:=Lowercase($1)
$0<1>:=Uppercase($0<1>)

This procedure reads “Return a new value that is assigned the
lower case value for all characters in the field, then return a
new value which is assigned the uppercase value of this field’s
first letter.”

You have already seen how 4th DIMENSION allows you to
enter commands and other elements of a procedure by selecting
them from the three panels on the bottom half of the Procedure
editor (in Chapter 6 “Using Scripts and Default Values™). You
can select the filenames, field names, and layout names that
appear in the center panel, the keywords that appear in the left
panel, and the routines that appear in the right panel.

The following steps do not specify whether to select or type the
elements of the procedure. Try both ways. You will soon be
able to decide which method works best for you.

Click the zoom box to expand the Procedure editor window.

First type the following comment to identify the purpose of the
procedure:

“Uplow capitalizes the first letter of field entry.
Then press Return.

The leading accent mark indicates that this is a comment, not
part of the instructions. The accent mark appears in a different
place on different keyboards. Don’t confuse this accent mark
with the apostrophe or backslash.

When you press Return, the comment is entered and
automatically indented. The insertion point moves to the next
line.
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The following procedure uses the Uppercase and Lowercase
functions to create a procedure that, in turn, acts as a function.
A function is a procedural statement that returns a value. The
procedure you will write takes the value presented to it,
changes all the letters to lowercase, then changes the first letter
to uppercase and returns the changed value. Later you will see
how to pass a value to the function, and how to use the value it
returns.

This procedure uses special variables that hold and return
information temporarily (technically called “local variables”).
They appear as $0 and $1 in the instructions that follow. The
variable $1 holds the first value passed to the instruction. The
variable $0 holds whatever value the function returns. Using
these local variables allows the global procedure to be used in
a script for any field.

You begin on the second line with the first local variable and
the gets symbol. Type

) $0:=

This can be read as the “value returned gets.” The value
returned will be the lowercase version of the contents of the
field. The remainder of the first procedure line will create the
lowercase version.

Now you write the instruction to create lowercase letters for
the entire entry. Type

Lowercase($1)
Then press Return.

This part of the procedure tells 4th DIMENSION to make
lowercase the first value passed to the procedure ($1).

You begin by making all the characters lowercase, so that
when you subsequently make the first character uppercase, the
entry is correct.
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Now you write the instructions to create an uppercase letter in
the first position. Type

$0<1>:=

Type < and 2= by holding down the Option key and typing <
and >, respectively.

This can be read as “the character in the first position of the
value returned gets.”

Now you write the instructions to change the first character to
uppercase. Type

Uppercase($0<1>)

This part of the procedure tells 4th DIMENSION to make
uppercase the letter in the first position (and only the first
position). The entries in the parentheses instruct

4th DIMENSION to change the first character in the value
returned by the first line of the procedure.

Press Return to end the line.

[ & File Edit Use Design Search ]

IEDE Procedure: Uplow
“Uplow capitalizes the first letter of field entry.

$0:=Lowercase($1)
l$0$1 2 =Uppercase($0<12)

ol

Routines

Lol Employees
Last Name
First Name
Start Date

Keywords

If

Else
End if
Case of

Arrays

Boolean
ommunications
ompiler Directives

SSNumber
Monthly Salary
[ frpisyse out

xceptions

End case
E Execution Cycle

Figure 7-4
The completed procedure

That’s it. Now you can use this procedure as part of another
procedure.
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Using the Global Procedure in Scripts

Now that you have a procedure that capitalizes the first letter
of a word, you can use it in scripts to see how it works.

Choose Layout from the Design menu, then open the Scripts
layout. ’ ’

Hold down the Option key and click the Last Name field.

This is a shortcut to get to the Script editor. It is equivalent to
double-clicking the Last Name field, then clicking the Script
button in the Field Attributes dialog box.

Create the following script for this field:
Last Name:=Uplow(Last Name)

Placing the field name in parentheses after the name of the
procedure instructs 4th DIMENSION to use the contents of

the field as the value passed to the function. In this case the

$1 variable in the Uplow function is a placeholder for the

Last Name field. The final $0 value returned by the function

is placed in the Last Name field. Uplow is shown in italic after
pressing return because it is a procedure.

Create a similar script for the First Name field:
First Name:=Uplow(First Name)

In this case, $1 in Uplow is a placeholder for the First Name
field. Using the local variables ($0 and $1), you can write a

global procedure without naming the specific fields that will
be used with it.

Now you can test your scripts.
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Go to the User environment and enter a new record.

Be sure to use random uppercase and lowercase letters for the
field entries for Last Name and First Name. You will see how
the procedure corrects the entries as soon as you select another
field.

Employees Employees
Last Name  |[JoHnSOr| Last Name  |Johnson
First Name | First Name |
Figure 7-5

Mistyped and corrected field entries

The Next Step

The global procedure you have written works fine for
capitalizing a field entry. You can use it in any script on
any layout.

Global procedures such as this one can be used in any

other procedure. In a later section you will write a global
procedure that you attach to a menu command for a runtime
4th DIMENSION application.
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RELATING FILES

Database: Personnel 8
Estimated time to complete: 25 minutes

In this chapter you will create a second file to store department
information. You want to include the department name and
manager’s name on your employee input layout, but you don’t
want to duplicate the information on each employee record.

If a department gets a new manager, you would have to change
the entry on every employee record for that department.

You can add a second file to your database to store department
information. You can combine information from the two files,
relating them so that you can display information from the
[Departments] file in a layout for the [Employees] file. You
may also want to print a list of employees that includes their
managers, or sort the employee records by department.

If you keep the department name in a related file, you need to
enter it and store it on disk only once. You can then display the
department name on each employee record. If you need to
change the information, you need change it in only one place,
in the [Departments] file. The change is then automatically
reflected in the other files that use it.

In this chapter you will learn how to
m create a second file
m relate one file to another

m create a layout that displays information from a related file
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Here is an explanation of how relating works. You use fields
and layouts to store information about each department in the
[Departments] file. After you enter the data, the information
looks like this:

=————— Departments: 8 0f 8 =E|
Code |Name Manger Budget Total i
ACC  |Accounting Mrs. Adams 750000 65098
ADM Administration Mr. Knowles 285000 27605
ART Art Mr. Cezanne 459000 34500
DES Design Mr. Wanamaker 890450 89045
PROD |Production Ms. Taylor 3568000 290070
TRAN |Transportation Ms. Wayfarer 450800 42500
MAN  |Manufacturing Mr. Hoffman 1560000 167708
SaL Sales Mr. Hopkins 4980000 399000

Figure 8-1
[Departments] file information

Each department has one record. Each record has the
department name, the department code, the manager’s name,
the department budget, and the total of department salaries.

You use the Department Code field to relate the [Employees]
file to the [Departments] file. Because the department code
identifies a unique record in the [Departments] file,

4th DIMENSION can locate and use the information in that one
record automatically.

Whenever a record in the [Employees] file is displayed (or
otherwise made the current record), 4th DIMENSION uses the
department code in the employee record, searches the
[Departments] file for the corresponding record and then loads
the record. The information in the department record can be
used in many ways. For example, it can be displayed on the
layout for the employee’s record or printed together with other
employee information.

This diagram shows an example of many employee records
drawing information from one department record:



RELATING

Employees
Name Ransome, Shirley
Start Date 1/11/80
Salary $36,040
Departments
Dept Cade . VI Dept Code VAW
Dept Namvie JYELITY ing i BREEELEE Manufacturing
Manager Mr. Hoffman g Manager Mr. Hoffman

Employees

Name Bell, Fredrick
Start Date 2/14/80
Salary $25,200

Dept Code  VEW
el E I Manufacturing
Manager Mr. Hoffman

Employees
Name Sleeter, Michael
SIELEICEN 4/10/80
Salary $30,650

Dept Code YN
Dept Name ing
| Manager Mr. Hoffman

Figure 8-2

Many records draw information from one record

This is called a many-to-one relation. Many employee records
have the same department code, but that code is entered in
only one department record. You may be familiar with calling
these files the One file and the Many file.

One department code identifies one record in the
[Departments] file and many records in the [Employees] file.
For a full discussion of the concept of the One file and the
Many file, see the 4th DIMENSION Design Reference.

Creating a New File

In this section you will create a second file to contain
information about departments.

If you have not done so already, start 4th DIMENSION and
open the Personnel 8 database.

4th DIMENSION displays the Structure window with the
[Employees] file in it. A new Department Code field has been
added to the [Employees] file. This is the field you will use to
relate the [Employees] file to the [Departments] file.
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2.

Choose New File from the Structure menu.

The pointer changes to a square file icon (the same shape that
4th DIMENSION uses to display a file). It remains file-shaped
until the next step.

Position the pointer where you want the new file to be located
(anywhere in the window) and click.

File2 is created at that location. (You can move a file to any
location by dragging its filename.)

11 Note: If you change your mind about creating a file after you

have chosen New File from the Structure menu, move the file-
shaped pointer into the menu bar and click. This cancels the
command, and the pointer again becomes an arrow.

Rename this file Departments by choosing Rename File from
the Structure menu, filling in the filename in the dialog box,
and then clicking OK.

[ & File Edit Use Design Structure |
I==—— structure for Personnel 08 = —m=]
Employees Departrnents

Last Name A

First Name A

Start Date V]

Salary R

Title A

SEMumnber A

Cepartrent Code A

Figure 8-3
The new [Departments] file

You now have two files. You can create up to 99 files for a
single database.
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5. Create the following fields for the [Departments] file:

Field name  Type Attribute
Code Alpha 5 Indexed
Name Alpha 15
Manager Alpha 15
Budget Real
Total Salaries  Real Display Only
e | T __ 6. Create an input layout named Dept Input that includes all the

fields in the above table.

J

li

Use layout template #5 (the one in the middle) to see what it
CusTon looks like, and to differentiate the [Departments] layout from
the [Employees] layout.

[ % File Edit Use Design Layout Object Font Style ]
IEN=——— layout: Dept Input EE |
N 3
Oli&; ;

O [so

L

= i [

=8 r:'100
eI 3

= r1s0

il | M 0 Total Salar i
I =4 Lol e

LA r

=N 200

Figure 8-4
Your [Departments] layout

7. Create an output layout named Dept Display that includes
all the fields in the above table. Use layout template #1 (the
one in the upper-left corner).

You are now ready to relate the two files.
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Relating Two Files

First you will relate the [Employees] file to the [Departments]
file. Then you will create a new layout for the [Employees] file
that includes information from the [Departments] file.

You establish a relation between two files by drawing a line
that connects the common fields, that is, the fields that have
information in common. In this case, the fields are the
Department Code field in the [Employees] file and the Code
field in the [Departments] file. The two fields do not have to
have the same name, but they must have the same field type.
In addition, the fields should be indexed.

Position the pointer on the Department Code field name in the
[Employees] file.

Because the [Employees] file is the Many file, you start with
it. The rule is this:

Whenever you draw a line to relate two files in
4th DIMENSION, you start with the Many file.

The Many file, remember, contains many instances of the
common information, in this case, many instances of the
department code. The Code field in the One file contains only
a single instance of each code.

The Department Code field will be related to the Code field in
the [Departments] file. These fields will contain the
information that allows 4th DIMENSION to find corresponding
records.

Press the mouse button, and drag the pomter to the Code field
name in the [Departments] file.

A line follows the pointer (see Figure 8-5).
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[ % File Edit Use Design Structure

Eg Structure for Personnel 08

Departments
e
Sne

A
A
Manager A
Budget R
R

Total Salaries

Employees
Last Hame
First Hame
Start Date
Salary
Title
SSMurnber
Departrnent Code

>N C >

Figure 8-5
Drawing the line that relates two files

With the pointer positioned on the Code field in the
[Departments] file, release the mouse button.

4th DIMENSION displays the Relation type dialog box.

Automatic Wildcard Choice
(< Relate one
Relate many

Cancel |

Total Salaries

Figure 8-6

The Relation type dialog box

4th DIMENSION relations are automatic, that is, they do not
require any programming. The line you have just drawn
establishes the relation between the two files. 4th DIMENSION
can locate the single record in the One file that corresponds to
any record in the Many file (the relation is many records
related to one record). And 4th DIMENSION can also locate
the several records in the Many file that correspond to any
record in the One file (the relation is one record related to
many records).
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You can deselect automatic relation for either Relate to One or
Relate to Many in the Relation Type dialog box. Both check
boxes are preselected, and these standard settings are the ones
you want to use.

4. Click Name in the Wildcard choices list.

For complete information about Wildcard choices, see the
4th DIMENSION Design Reference.

5. Click OK.

4th DIMENSION displays the structure window again with an

arrow pointing from the [Employees] file to the [Departments]
file. The arrow shows that the two files are related. The arrow

points from the Department Code field in the [Employees] file
(where you started) to the Code field in the [Departments] file
(where you ended).

If you made an error in drawing the line, you can quickly
correct it. Simply repeat the steps.

Layouts With Fields From the Related File

You have related the [Employees] file to the [Departments]
file. Whenever you enter a department code on a layout for
the [Employees] file (or otherwise make that record current),
4th DIMENSION loads the corresponding record from the
[Departments] file. You can then use information from that
[Departments] record.

Your next step is to create a layout to display information
from both files. This will be a new input layout for the
[Employees] file.

1. To open the Layout dialog box, double-click the title of the
[Employees] file.

4th DIMENSION displays the Layout dialog box, showing
the layouts for the [Employees] file already expanded.
Because you double-clicked the [Employees] file, only the
layouts for that file are shown.

2. Click New to display the New Layout dialog box.
Notice that the field that you used to relate the two files
(Department Code) is now in bold type, and the file it is
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related to ([Departments]) is shown in brackets next to it.
The [Departments] file is also shown at the end of the list of
fields. This second listing allows you to create an included
layout; you will work with the second listing of a file in the
next chapter.

Double-click the Department Code field name.

Related file

Second file listing
for included layouts

Field used to relate

Select fields:
Last Name K3
First Name N
Start Date
Salary
Title
SSNumber

Department Code [Departments]
Code

Name
Manager
Budget

Total Salaries

[Departments %

Departments

Last Name A
First Name A
Start Date D
Salary R Budget

Al

A

A

A
A
Manager A
R
Total Salaries R

Title
SShumber

the two files

Department Code

Figure 8-7
The new field list reflects the relation

4th DIMENSION expands the list to show the fields from the
[Departments] file. You can include any of these fields in the
layout you are now creating.

When you are creating a layout that includes fields from a
related file, you must select all the fields you want to display.
The fields will appear in your layout in the order you select
them.

To select a field for your layout you click first the field name,
then the Select button.

Select these fields from the [Employees] file in the following
order:

Last Name

First Name

Start Date

Salary

Title
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Layout font size 4_1—1——72
New layout for Employees ) 9 point

Expanded list of
fields in the
[Departments] file

Select the Department Code field in the [Employees] file by
clicking Select.

Now select the following fields from the [Departments] file:

_Name

Manager

4th DIMENSION displays numbers beside the selected fields.
These numbers show the order in which the fields will appear
on the layout.

Type Related as the layout name, and choose the 9-point font
size.

Font size: =
Select fields: (12 point

1
2
tart Dat 3
4
5

SSHumber
|Depactment Code [Departments] &
Code

CusTom

Layout Name:

Related

Enterable related fields

memﬁ ] [[ Select Jl [ Cancel ] [ 0K ]
Figure 8-8
New Layout dialog box for the Related layout
Click OK.

4th DIMENSION displays the new layout you have created.
The two field labels for the fields you selected from the
[Departments] file are displayed on this layout in bold type
(the field labels from the [Employees] file are shown in

plain type).
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[ € File Edit Use Design Layout Object Font Style ]
Em ——— layout: Related =————=}
C; Fa Employees
(] Last Name [50
: irst Na r
FleldS from the EE — First Name Firzt Mame
[Employees] file g Start Date i
— Salary [1a0
=|= Title [
: ER ] Departrent Cod r
Fields from the = | epartmemitace <R Liso
; Mame ] F
[Departments] file g L _{ [ Mame
I_T_[_] I—[___L| L Manager Manaaer

Figure 8-9
The [Employees] Related layout

You can now go to the User environment to enter records.

Importing Department Records

Now that you have related the two files and have created a
layout that includes fields from both files, you can see the
result as you enter additional records.

You must first add records for.the [Departments] file. A text
file of department records is included in the Personnel 08 f
folder.

1. Choose User from the Use menu.

4th DIMENSION displays the list of employee records you
have been using.

2. Make [Departments] the current file.

Before you can import data, you must make the file that will
contain the data the current file.

To change the current file, press Command—Space bar to

display the “List of files” window, then select the file you
want to make current on the “List of files”window. Then

press Command—Space bar again.
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Fields from the
[Departments] file

Field import
order

Choose Import Data from the file menu.

You are going to import data from a text file for
the [Departments] records.

4th DIMENSION displays the Import data dialog box.

“Text file — Departments” is the file that contains the
department data and should alreday be selected.

Click Append >>> five (5) times so that the field import order
matches the order of the fields in the [Departments] file.

You do not need to make any changes in the order of fields,
because the text file’s fields are in the same order as the
fields in your [Departments] file. For further instructions see
Quick Start Chapter 3, “Entering, Importing, and Modifying
Records.”

Your screen should match Figure 8-10.

Import data... — ACIUS

ST T

D Tesxt File - Departments &y

( orive , ][ Cincel )

@Text ODIF OSYLK
End of field: 9

End of record: |13

| [JUse input layout

Code O Code
Hame =1 (Append>>]  [Name =
Manager Manager
Budget Budget
| TR Totsl Salaries
= Hamape |
¥
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Figure 8-10
Import data dialog box

Click Open.

4th DIMENSION imports the records and places them in the
[Departments] file. 4th DIMENSION displays the records.
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=———————— Departments: B of 8 EEI
Code |Name Manger Budget Total Ko
ACC Accounting Mrs. Adams 750000

ADM Administration Mr. Knowles 285000

ART Art Mr. Cezanne 459000

DES Design Mr. Wanamaker 890450

PROD |Production Ms. Taylor 3568000

TRAN |[Transportation Ms. wWayfarer 450800

MaN  |Manufacturing Mr. Hoffman 1560000

SAL Sales Mr. Hopkins 4980000

Figure 8-11

Imported [Departments] data

Seeing the Relation in Action

In this section you’ll see that, when you enter the department
code on an employee record, 4th DIMENSION immediately
displays the information from the [Departments] file.

To see how the automatic relation works, you will need to use
the Related layout you just created.

Press Command—Space bar to display the “List of files”
window.

Click the Input Layout icon for the [Employees] file and
choose Related from the pop-up menu.

4th DIMENSION changes the current input layout to the
Related layout you just created.

Press Command—Space bar again to bring the Records
window to the front.

4th DIMENSION puts away the “List of files” window.
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4. Choose New Record from the Enter menu.

5. Enter some practice information:

Last Name Ormolu
First Name Fritz

Start Date 4/1/89
Salary 38050
Title Fabricator

6. Select the Department Code field.
7. Enter DES and press Tab.

4th DIMENSION instantly enters the department name
(Design) and the manager’s name (Mr. Wanamaker) in their
fields. This information came from the [Departments] file.
Thus you see the first benefit of the relation you have
established: automatic, instantaneous, accurate lookups.

8. Click Enter.

4th DIMENSION accepts the record and displays a blank
record for further data entry.

Access to the Related File

You will occasionally need to have access to a related file.
You may need to create a record for a new department, for
example. 4th DIMENSION makes this easy to do. When you
enter a new department code, 4th DIMENSION gives you
access to the input layout of the related file so that you can
create the new record.

Suppose your company hires an engineer as the first employee
of a new engineering department. You enter this record before
the department record is created.

In this section you will enter a new department code, and then
create the corresponding department record.
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This record does not exist in file
"Departments”.
What do you want to do?

[ create 1t |

RELATING

Enter some practice information:

Last Name Conqueror
First Name Bill

Start Date 10/1/88
Salary 45000

Title Engineer

Enter ENG in the Department Code field.

After you Tab out of the field, select another field, or press
Enter, 4th DIMENSION looks in the [Departments] file for this
code. When it finds no record, it decides that you have either
made a mistake or else you want to create a new record.

4th DIMENSION displays the “This record does not exist”
message and offers to let you create one.

Click Create It.
| & File Edit Use Enter Select Report Special ]
IE=——— Entry for Departments =}
i
Departments

Delete |

cancel |
=
3] [l

Figure 8-12
Creating a new record in the related file

4th DIMENSION displays the input layout for the [Departments]
file, ready for you to enter information about the Engineering
department. The new department code is already entered in the

correct field. To create a new record in the [Departments] file,
you need only fill out the rest of the form.
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4. Enter the Engineering department information:
Name: Engineering
Manager: Mr. Sturges
Budget: 175000

You can ignore the Total Salaries field for the moment. This
field has a Display Only attribute that prevents any value from
being entered. Later you can instruct 4th DIMENSION to
calculate a value for this field.

5. Click Enter.

4th DIMENSION accepts the record, returns to the Employee
file’s input layout, and displays the department and manager
information in the related fields. The information has been
drawn from the record you have just created in the
[Departments] file.

[ ® File Edit Use Enter Select Report Special ]
= Entry for Employees ok
8 K
[ﬂl Employees
o . Last Name Conqueror
ilj‘ 7 First Name Ein
Start Date 10/1/88
Salary 45000
Title Engineet
Department Code ENG
Name Engincering |
Delete
—_— Manager Mr . Sturges
Cancel |
=
= B
Figure 8-13

Displaying information from the related file

6. Click Enter to return to the list of records.
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The Next Step

You have seen how related files allow you to share
information between files. Your records of employees now
include their department name and manager’s name. And you
will see in the next chapter that the department layouts can
include information about each department employee.

Since the files can share this information, data that might have
been repeated many times is stored only once. The advantages
of this structure are reduced data entry time, less chance of
error, ease of updating the information, and use of less space
on disk.

You can create reports that use information from the related
file. You can also search and sort records based on information
in the related file. For example, you can sort the records in the
[Employees] file by department or by manager, even though
the department name and manager’s name are in the
[Departments] file. You will see these operations in later
chapters of this book.
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RELATING ONE TO MANY

Database: Personnel 9
Estimated time to complete: 10 minutes

In this chapter you will use the relation you established in
Chapter 8 to display records from the [Employees] file in a
layout for the [Departments] file. This is called a One to Many
relation.

Relating One to Many means that whenever a record in the
[Departments] file is made current, 4th DIMENSION loads all
the [Employees] file records that have the same department
code. This capability allows you to use information from
many employee records from within each of the unique
records in the [Departments] file.

Departments
DENTHOLL M MAN
PETIREIEE  Manufacturin
i 9 Employees

Manager Mr. Hoffman
Name Start Date  Salary Dept Code

Name Start Date | Salary i o Ransome, Shirley ~ 1/11/80  $36,040 MAN {-

5 Pfaff, Bryan 1/20/80  $28,990 ADM

Ransome, Shirley | 1/11/80 | $36,040 | Heizer, Nancy 2/12/80  $31,600  SAL

Bell, Fredrick 2/14/80 | $25,200 Bell, Fredrick 2/14/80  $25,200 MAN {-

Sleeter, Michael 4/10/80 | $30,650 Krause, Mike 3/22/80  $27,880 DES
Sleeter, Michael ~ 4/10/80  $30,650  MAN 4

Figure 9-1
Many records contribute information to one record

In this chapter you will learn how to
m create a layout that includes records from the Many file

m modify an employee record from the [Departments] file

CHAPTER 9: RELATING ONE TO MANY 121



122

Creating an Included Layout

You want to create a layout that displays all employees that
belong to a department on that department’s record. You need
to create a layout for the [Departments] file that includes space
for [Employees] records. 4th DIMENSION provides an
automatic method for including records from another file.

The way it works is similar to the way you created the Related
layout to display information from the [Departments] file.

If you have not done so already, start 4th DIMENSION and
open the Personnel 9 database.

Personnel 9 opens in the Design environment.

Double-click the title of the [Departments] file to open the
Layout dialog box, and then click New.

4th DIMENSION displays the New Layout for Departments
dialog box.

This dialog box shows the field names from the [Departments]
file. The [Employees] filename is shown in bold and in
brackets at the bottom of the list of fields. You will select two
[Departments] fields and several [Employees] fields to display
on the same layout.

Select Naﬁne and Manﬁger from the [Departments] file.
Click on the [Emﬁoyees] filename and click Select.
Double-click the [Employees] filename.

4th DIMENSION lists the fields in the [Employees] file.

/ _ ) J
Select Last Name, First Name, Start Date, and Salary in that
order from the [Employees] file.

Be sure to select them in that order, so that they appear in that
order on the layout. If you make a mistake, you can deselect
any field name by selecting it again.

The numbers for the fields from the [Employees] file start over
again from number 1. This is because the fields are numbered
within the included layout area.
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7. Select the fifth layout pattern (the one in the middle), and
make the font size 9, and type Included as the layout name.

New layout for Departments Font size: 8?2[!0:::"
select fields: P

Code

Name 1 EEE | e=e= | o=
Manager 2

[Employees] 3
Last Name 1
First Name 2
Start Date 3

Title Layout Name:
SSNumber
Department Code

[ Enterabie related fields

[ Eupand ] [ Select ]] [ Cancel ] [ 0K ]
Figure 9-2
New Layout dialog box for the Included layout
8. Click OK.

4th DIMENSION displays the new layout.

9. Click the zoom box to expand the window.

[ € File Edit Use Design Layout Object Font Style
ﬂ = lLayout: Included

Included
layout area

Figure 9-3
The [Departments] file layout with an included layout area

4th DIMENSION has automatically placed an included layout
area on the new layout. An included layout area displays
records from another file. On this layout, the included layout
area will show the employee records in a multi-line scrollable
list format. At present, no fields are visible. You will see them
in the User environment.
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Viewing and Entering Records

= List of files =

Dept input &

Dept Display
Included

G

Now you can go to the User environment to view department
records that contain employee information. Each time a
particular record is made current, 4th DIMENSION searches
for all the employee records that match the department code
and selects them. 4th DIMENSION then displays the
information in the fields that you have selected.

Choose User from the Use menu.

4th DIMENSION displays the employee records. You need
to change the file and layout.

Press Command-Space bar to display the “List of files”
window.

Press the Input Layout icon for the [Departments] file and
choose Included from the pop-up menu.

4th DIMENSION changes the current file to [Departments]
and the input layout to the Included layout.

Press Command—Space bar again to send the “List of files”
window to the back.

4th DIMENSION displays the department records in the
[Departments] file output layout.

Select the Administration Department record and choose
Modify Record from the Enter menu.

4th DIMENSION displays the new input layout, including
a scrollable list of Administration Department employees.
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( & File Edit Use Enter Select Report Special

[T
m—

Entry for Departments =—————11

Previous record
arrow

2/e ||

Information from

Dennis
Bryan
Mary

|

the [Employees] file

Marlys

o
&

Figure 9-4
Employee information displayed in a department record

You can modify the employee records from this layout.
Suppose one employee, Mary Smith, has received a raise of
$3,000 per year. You can change the salary figure here.

Click the Salary field in Mary Smith’s record to select it, type

.29_500’ and then click ahywhere else on the record.

4th DIMENSION accepts the modified salary value. The record
in the [Employees] file is now updated; the updating occurs
when you move out of the employee record.

Click the next record arrow in the control panel to move to the
next department record.

4th DIMENSION displays the next record in the [Departments]
file. Employees in this department are listed in the included
file area. You can continue to examine the different
department records, scrolling to view all the employees in
each department.
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The Next Step

Automatic Relate One to Many is available whenever you use
related files. One to Many makes it possible to gain access to
many related records from the One file. Remember that each
of the records in the [Employees] file has a department code
that corresponds to one of the codes in the [Departments] file.
Each department record is related to many records in the
[Employees] file.

Using an included layout you can use the information in the
[Employees] file in conjunction with a record in the
[Departments] file. You can not only display this information,
you can also print it, use it to search and sort, and perform
calculations with it (total salaries per department, for
example).
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USING A SUBFILE

Database: Personnel 10
Estimated time to complete: 25 minutes

In this chapter you will use 4th DIMENSION to store
information about each employee’s performance reviews.
You have no way of knowing in advance how many reviews
a particular employee has had. New employees have had no
reviews; others who have been with the company a long time
have had many reviews. You need to keep track of varying
amounts of information for each record.

A 4th DIMENSION subfile handles just this problem. A subfile
is a subordinate file that can contain any number of records
associated with a single record in the parent file. It lets you
keep track of a variable amount of information for each
record, from no entries to as many as necessary. In effect, each
employee record will have an entire data file in which to store
that person’s performance review information.

The file to which a subfile is attached is called the parent file.
Since a subfile is associated with each record in the parent file,
the records in the parent file are called parent records. The
fields in a subfile are called subfields, and records in a subfile
are called subrecords. A parent file can have many subfiles.

In this chapter you will learn how to
m create a subfile
m create a layout that displays information from the subfile

m enter information into the subfile
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Why Use a Subfile?

You use a subfile when you need to keep track of a varying
number of additional entries for each record. A subfile is an
excellent place to store information limited to one record. You
might keep track of your employee’s children, publications, or
social service awards in a subfile.

The subrecords—records in a subfile—are stored with the
parent record. The subrecords are placed in memory when the
parent record is made the current record. The number of
subrecords a subfile can contain is limited to the number that
will fit in memory.

The information in a subfile is available only when its parent
record is current. Therefore, it is difficult to summarize
information from subfiles belonging to different records. You
would not use a subfile when you need to collect the
information from all the subrecords of all subfiles. For
example, an invoice file might seem to be a good candidate for
using a subfile, because each set of purchased items could be
associated with a specific customer record. But because you
usually need access to such purchase records, you would
undoubtedly use a normal file and an automatic relation to
store the sales information. You would relate the sales file to
the customer file to prepare invoices.

Creating a Subfile

You create a subfile in two steps: first, you add a field with a
subfile field type to the parent file (([Employees]), and then you
add fields to the subfile in the normal way. Once the subfile
exists, you can create a new layout for the [Employees] file
that includes the subfile.

Notice that creating a subfile is quite different from creating a
relation between two files that already exist. You cannot make
a file that already exists into a subfile.

In the following steps you will create the subfile.

If you have not done so already, start 4th DIMENSION and
open the Personnel 10 database.

Personnel 10 opens in the Design environment.
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Double-click in the space below the field names in the
[Employees] file.

4th DIMENSION displays the Field dialog box.

Type Review Info for the field name.

This is the name 4th DIMENSION will use for the subfile as
well as the field.

Select the Subfile field type.
Click OK.

4th DIMENSION creates the subfile below the [Employees] file
and connects it to the Review Info field with a gray line.

[ ® File Edit Use Design Structure |
[=————— structure for Personnel 18 o E.

Departments

A Code A

Name A

Manager A
R
R

Budget
Total Salaries

Review Info

Figure 10-1
Subfile added to [Employees] file

The gray line connects the top of the subfile to the parent file.
(This is unlike the arrow that connects two related fields.)

Next, you create fields in the subfile—subfields—to contain
the information. These steps are the same as those for a
regular file.
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Double-click within the subfile.

4th DIMENSION displays the “Field for Review Info” dialog
box.

Create the following subfields:

Subfield Type
Review Date Date
Rating Real
Comments Text

Click OK after creating the Comments subfield.
These subfields are linked automatically to each parent record.

The Review Date subfield will contain the date the
performance review is approved. The Rating subfield is for the
numerical rating your company uses for performance reviews.
The Comments subfield will contain the text of the
performance review itself. You have made it a Text subfield
so that it can hold a substantial amount of text (up to 32,000
characters).

Using the same layout pattern (#5) you used for the previous
input layouts, create an input layout for the Review Info
subfile named Input. Use all three subfields. (See Figure 10-2).

After creating the layout, double-click the Comments field.
4th DIMENSION displays the Field Definition dialog box.
Click the “Text with scroll bar” check box.

Click OK.

This layout will be referred to later on as a full-page layout,
because it provides access to a record on a full page.

Drag the layout frame down to just past 250. Increase the size
of the comments field to match Figure 10-2. The comments
field has been expanded to accommodate paragraphs of text.
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€ File Edit Use Design Layout Object Font Style ]
=——————— lLayout: Imput &&"iecFK"ecF"F""——

rmmr——

JIIIIT}
L]

o

Review In

[ 5k]
[z

e
IEINE

= i Comments
[

1)

Expanded
Comments field

Kal ]

Figure 10-2
An input layout for a subfile

Now that you have created an input layout, you can proceed to

create a layout for the [Employees] file that includes a layout
for the subfields. '

1. Create a new input layout for the [Employees] file. Name it
= Subdfile. Select 9 point font size.

-

2. Select the First Name, Last Name, and Title fields from the
[Employees] file.

3. Double-click the Reviéw Info field and click Select.
4th DIMENSION lists the subfields in the Review Info subfile.
; -

4. Select the Review Date, Rating, and Corhments subfields.
(See Figure 10-3).

es 3

New layout for Employe FoRt Stz g?zpo:'::“
select fields: p
Last Name =
First Name 1 === ==
Start Date
Salary
= : =l
SSNumber
Department Code  [Departments]
Review Info 4 E CusTon

Review Date 1

Ratin

Layout Name:

[Departments]

Enterable related fields

(Crspang ] | setect [ cancel | [ 0k ]

Figure 10-3
Fields and subfields selected for the new layout
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Included layout area

You create an included layout area for a subfile in the same
way you created an included layout area for a related file in
Chapter 9. You select the subfile as one of the fields to be
displayed, then select the fields you want from the subfile. Be
sure your New Layout dialog box matches the one in Figure
10-3 before proceeding.

When you have finished, click OK.

4th DIMENSION creates a new layout, automatically including
a multi-line layout area for the subfile fields.

ercer——

& File Edit Use Design Layout Object Font Style

El Layout: Subfile
[}
N
= Employees
rxa
OLA) i
O First Name [s0
L
Last Name -
Title

Review Info - 100

= @00

el ol | [ m

r1so

Figure 10-4
The input layout with a subfile display area

Whenever you enter information for an employee you will
see the subfile displayed in the subfile display area.

You now need to associate the subfile input layout with the
included layout area.

Double-click the included layout area.
4th DIMENSION displays the “Included layout” dialog box.

You use this dialog box to tell 4th DIMENSION which of
the subfile layouts to use for input.

The Review Info subfile name is highlighted. The asterisk next
to the subfile name shows that Review Info is associated with
included layout area.
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Click Expand to show the list of layouts you have created for
Review Info.

Select Input, and then click the Full Page check box.

This step makes the input layout you designed the full-page

" layout that “waits behind” the subfile display area until you
signal to enter more data. You will see this feature in action in
the next section of this chapter. Ignore the buttons for the
different frame displays; they are used only during printing.

Click the Double-clickable check box in the Data Entry area.

This step makes it possible to double-click the included
layout. When the included layout is double-clicked, the full-
page layout is displayed.

Click OK.

4th DIMENSION displays the layout you have been working
on.

Close the Layout editor window.

Entering Information Into the Subfile

Now that you have created the subfile and an [Employees] file
layout with a subfile display area, you can use the new layout
to enter and display information. In the following steps you
will add review information to a record that already exists.

Choosei Uscr from th¢ Use menu.

4th DIMENSION lists the employee records in the output
layout.

Make the new layout, Subfile, the current input layout.

You change the current layout by choosing it from the “List of
files” window. To display the “List of files” window, press
Command—Space.

Select the first record in the list of records.
Choose Modify Record from the Enter menu.

4th DIMENSION displays the record, including the added
subfile display area.
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=——————— [ntry for Employjees ="——————"12
Employees
afe)es| | oo
H ik Last Mame Johnson
Title Engineer
Review Date  [Rating Cornments Q‘
5
| Cancel
o]
] I
Figure 10-5

The first record with a subfile display area

As you can see, the subfile display area uses a multi-line
layout pattern.

5. Double-click anywhere within the subfile area.

4th DIMENSION displays the full-page layout for the Review
Info file. This is what was meant by the Review Input layout
“waiting behind” the subfile area.

6. Enter the following information for this employee:
Review date: 3/18/88
Rating: 4.5

Comments: Tom has had a very successful quarter,
meeting all his stated goals. In particular, his report on
the need for the new Engineering Department was
effective in getting it established.

During the coming quarter, his goal is to establish
budget and scheduling parameters for the coming year.
This means he will be working directly with Bud
Schulberg.
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[ & File Edit Use Enter Select Report Special |
Entry for Employees =———————

T

new Engineering Department was effective in getting it
established.

During the coming quarter, his goal is to establish budget

and scheduling parameters for the comming year. This

means he will be working directly with Bud Schulber:

| e

K] 2

Figure 10-6
Entering comments into a text field

Notice that the text area for comments works like a text
processor. The words wrap from line to line within the borders
of the field area.

Click Enter.

4th DIMENSION displays a blank input layout for the subfile.
Click Cancel to return to the parent record.

You see only a few lines of the text you have entered, though
the text area contains all the words.
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[ ® File Edit Use Enter Select Report Special ]

i
Employees
& j:“ First Name  [Tom
m B Last Name Johnson
1760 Title Engineet
Review Date  [Rating Comments
3/18/88 4.5 |Tom has had a very successful quarter, meetir
Delete
Cancel
&
el =)
Figure 10-7

Subfield entries displayed in parent record

After you enter additional subrecords, you can move any of
them into view with the scroll bar on the right of the subrecord
display area.

Click Enter to return to the output layout.

The Next Step

You have seen how to add a subfile to each record in which
you can store many pieces of information about an employee.
The subfile can accommodate any number of subrecords, from
none at all to the many performance reviews of a long-term
employee.
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USING THE SEARCH EDITOR

Database: Personnel 11
Estimated time to complete: 10 minutes

In this chapter you will learn how to use 4th DIMENSION’s
Search editor to search for a group of records based on a
complex set of search conditions.

In Chapter 3 of Quick Start you used Search by Layout to
search for a specific record. When your search conditions are
more complex, you usually use the Search editor. You would
use the Search editor, for example, if you wanted to find all
the records between two dates.

In this chapter you will learn how to
m enter search conditions in the Search editor
m create complex search conditions

m search on a field in a related file
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Using Search Conditions

You often need to isolate a specific group of records, to view
them together, to update a field in each record in the group, or
to perform a calculation or print a report based on that subset
of all the records. The subset of the records isolated by
searching is called the selection.

A search is based on search conditions, instructions to

4th DIMENSION that identify the basis on which the records
are included or excluded from the selection. The selection is
made up of records that meet the search conditions.

Suppose you want to see all the records for employees with
salaries greater than $30,000. The condition you would enter
to isolate those records is “Salary greater than 30000.” This
simple example illustrates both the exact nature of a search
condition and the ease with which you can write search
conditions in 4th DIMENSION. Using this search condition,
4th DIMENSION tests the condition against the value in the
Salary field on each record. If the condition is true (the salary
is greater than 30000), the record is included in the selection;
if the condition is false (the salary is 30000 or less), the record
is excluded from the selection.

A search condition always has three elements in this order:
field name, operator, value. The field name is from the current
file or a related file. The operator is one of the comparisons
(equal to, greater than, less than, and so forth). The value is
the value to which each record is compared. In the Search
editor, the search condition is displayed in the text area so that
you can see it easily and edit it as necessary.

You can save search conditions or load conditions you have
previously saved. If you need to perform the same search on a
regular basis, 4th DIMENSION allows you to enter the search
conditions once, save them, and then have them available
whenever you need them.

If the field is an indexed field, 4th DIMENSION can perform
the search very fast.
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Using the Search Editor

Suppose you want to see all records of people earning more
than $30,000 per year. You can create a selection of just these
records using the Search editor.

1. If you have not done so already, start 4th DIMENSION and
open the Personnel 11 database.
Personnel 11 opens in the User environment.
2. Choose Search Editor from the Select menu.
4th DIMENSION displays the Search editor. Here you enter the
condition you want to use to search.
Search Editor
Editor text area ___
Select operator
Last Name ; :z ::‘:?q:'oa”c O fing
First Name is greater than _
Start Date is greater than or equal to O iy
?ﬂ]a:u l Ii ﬁii I::: or equal to O Eunant
Select field name Fshumber.. | —
Type in value LT '
[ search in selection
([ sawe.. ] [ toad.. | [ cCancel | [ 0K ]
Figure 11-1
The Search editor
3. To enter the field name you want to use, click Salary in the
panel on the lower left. .
4th DIMENSION enters the field name in the editor text area.
4. To enter the operator you want to use, click “is greater than”
(in the center panel).
5. Type 30000 (the amount is entered on the Value line at the
bottom of the dialog box).
This completes your search condition.
6. Click OK.

4th DIMENSION performs the search based on the condition
you have entered. The records of all employees earning more
than $30,000 are displayed on the screen.

CHAPTER 11: USING THE SEARCH EDITOR 145



146

To see all the records again, choose Show All from the
Select menu.

Using a Condition With And

You use the And conjunction to join two search conditions.
The And conjunction restricts the search to fewer records than
either condition alone. In order to meet the compound
condition, a record must satisfy both conditions.

Suppose, to take a simple example, you want to view the
record for Mary Smith. You can use And to create a compound
search condition for this task. You want to see the record that
has Smith in the Last Name field And that has Mary in the First
Name field. The record must meet both conditions, not just
one.

Choose Search Editor from the Select menu.

4th DIMENSION displays the Search editor. The previous
search condition is still displayed in the editor text area.

Choose Clear from the Edit menu.

The previous search condition is erased.

To enter the field name you want to use, click Last Name.
4th DIMENSION enters the field name in the editor text area.
To enter the operator you want to use, click “is equal to.”
Type Smith.

The first search condition is complete. So far your condition
states that you want to see records that have a last name of
Smith. You now need to enter the conjunction and the second
condition.

Click the And button.
This step prepares the editor to receive the second condition.
Click First Name, then click “is equal to,” then type Mary.

Both conditions are complete.
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Search Editor

Last Name is #qual to Smith
And  First Name s equal to Mary

- - iz equal to
Last Name | [is not equal to O And
First Hame is greater than
Start Date is greater than or equal to O or
Salary is less than
Title is less than or equal to C) Except
SSMNurnber contains
I T ——
[J search in selection
([ save.. ] [ Load.. | [ cancel | [ 0K ]
Figure 11-2
Completed compound search conditions
Click OK.

4th DIMENSION performs the search based on the conditions
you have entered. The record you want is displayed on the
screen.

Using a Condition With Or

You use the Or conjunction to join two search conditions. The
Or conjunction expands the search to more records than either
condition alone. In order to meet the compound condition, a
record can satisfy either condition.

Suppose, for example, you want to see the records for several
employees who have recently received social service awards
of various kinds. You can join them into one compound search
condition with Or.

Your conditions will state that you want to see records that
have a Last Name entry of Davis, or Wilson, or Tracy, or
Arnold, or Martin. In ordinary English you might say, “I want
to see the records for Davis, and Wilson, and Tracy, and
Arnold, and Martin.” However, you are writing logical
conditions. Clearly no record contains Davis, Wilson, Tracy,
Arnold, And Martin. Each record has just one of these last
names. In this case, you need Or to expand the number of
records that meet the condition.

Choose_»Seir‘ch Editor from the ‘Select menu.

4th DIMENSION displays the Search editor again.
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2. Choose Clear from the Edit menu to remove your previous
search conditions.

4th DIMENSION clears the Search editor.
3. Click Last Name, click “is equal to,” and type Davis
4. Click the Or button.
5. Enter the next condition, and click Or again:
Last Name, is equal to, Wilson r
6. Continue using the Or condition for the remaining last names:

Tracy
Arnold
Martin

You have entered a five-part search condition, joined with Or.
A record can meet any of these conditions and be included in
the selection. The principle at work here is that using Or
expands the number of records in the selection.

Search Editor

Last Mame is equal to Davis
iz equal to Wilson

Or
or
or
Or

iz equal to Tracy
is equal to Arnold

+ is equal to

Last Name iz not equal to O And
First Name iz greater than
Start Date iz greater than or equal to O or
Salar, is less than
T?ﬂaer ’ is less than or equal to O Encept
SSMNurnber contains
[alue [Martin ]
[] Search in selection
[ save... ] [ Load... ] L Cancel ] [ 0K ]
Figure 11-3
Completed search conditions
7. Click OK.

4th DIMENSION performs the search and displays the
selection of records on the screen. Notice that the search
was of the entire file, not of just the selection created by
the previous search. 4th DIMENSION assumes you want to
search the entire database. If you ever want to search just
the current selection, you would click the “Search in
selection” check box before you click OK.
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Searching on a Field in a Related File

The [Employees] file is related to the [Departments] file. As
you saw in Chapter 8, this means that every employee record
has one corresponding department record. The relation allows
you to perform searches of the Employees records based on
the entries on records in the [Departments] file.

In this section you will search first on the department code,
and then on the department manager’s name.

Choose Search Editor from the Select menu.

4th DIMENSION displays the Search editor again. Your
previous search condition remains in the Search editor.

Choose Clear from the Edit menu.
4th DIMENSION clears the Search editor.

Click either of the cycle arrows at the top of the list of files
until the [Departments] file is displayed.

- Departrents

Bl

Code
Narne
Manager
Budget
Total Salaries -

5

Figure 11-4
Displaying the [Departments] file

Enter this search condition:
Code, is equal to, TRAN
Click OK.

4th DIMENSION searches for the records in the [Employees]
file that are related to the [Departments] record with TRAN in
the Code field, then displays them.

You have searched on the department code to isolate all the
records for members of the Transportation department.
Suppose, however, you want to see the employees that report
to Mr. Wanamaker, but you don’t know his department code.
You can use another field from the related file, not just the
related field.
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Open the Search Editor, clear it, and enter this search
condition:

Manager, is equal to, Mr. Wan@

You have used the “@” wildcard so you don’t have to spell
out the whole name.

Click OK.

4th DIMENSION searches for the records in the [Employees]
file that are related to the [Departments] record with Mr.Wan
in the Manager field, then displays them. These are all the
employees who report to Mr. Wanamaker.

The Next Step

The Search editor is designed for compound searches. As you
can see from the Select menu, the Search editor is just one of
four ways to search the database.

Show ANl ®6

Show Subset Sl

Search Editor... #S
Search by Layout... #L
Search and Modify...
Search by Formula...

Sort Selection... ®T

Sort File...

Figure 11-5

The Select menu shows four ways of searching

4th DIMENSION provides the Search by Layout and Search
and Modify methods that you worked with in Quick Start to
perform simple searches. The Search editor is designed to
perform any kind of search, from simple searches to the kind
of compound searches that are covered in this chapter, as well
as even more complex combinations of Or, And, and Except.

It is possible to use Search by Layout for compound searches
with special symbols. For complete information, see the
4th DIMENSION User Reference.

4th DIMENSION also provides the Search by Formula method
for searching the database. The Formula editor is designed to
search with formulas created with 4th DIMENSION’s
procedural language.
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QUICK REPORTS WITH BREAKS

Database: Personnel 12
Estimated time to complete: 15 minutes

You often need various printed versions of the records in
your database. You may need to print a list of names and
phone numbers or create mailing labels. You might be called
upon to prepare quick reports that present the information in
several ways. With 4th DIMENSION you have all the
flexibility you need to perform these tasks.

In this chapter you will learn how to
m create a quick report that includes subtotals

m use fields from a related file in a report

Using the Quick Report Editor

Reports allow you to communicate the information contained
in the records. 4th DIMENSION’s Quick Report editor allows
you to print all the information, some of it, or just summaries
of it (total sales for October, for example). You can design and
save reports that you use again and again. And you can
quickly design a report you use only one time for a special

purpose.

Quick Report is one of 4th DIMENSION’s two major report
methods. You can also design a report using the Layout editor.
The Quick Report can handle many of your reporting needs,
but not all of them. In Chapter 13, you will design a more
complex report using the Layout editor.
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Using the Quick Report editor, you can design and print
tabular reports quickly. You can choose the fields you want to
print, arrange them in any order, calculate totals and subtotals,
and print additional text. Here is a typical report:

Columns headers I 1
Name Last Name Salary !
Accounting Baldwin $43 990
| Johnson $18,250
B Subtotal for Accounting $62,240
" iadministration  Hanson $40,520
Pfaff $26,440
Information ] — $26,500
drawn from fields — Terry $16,190
| | wilson $26,500
Subtotal for Administration $146,150
i Art Forbes $15,840
Martin $56,144
— Tompkins $19,770
Venable R $43,520
[ Yoltz $25,150
Subtotal for Art $163 424
Grand Total: $371,814
Figure 12-1

Parts of a typical report

This report was created by the following report design.
The report design is the set of instructions that tells
4th DIMENSION what to print.

Reports... [ Report with frame
- - Name |Last Name Salary ] K
Last Name K3 [ R [Name iLastName Salary
First Name m Py fans wan
Start Date ¥
Salary B1 Subtotal for ® Sum
Title i

S E
SSNurmber I oradTotr: | [§)Swm
Department Code
Review Info

Sort

Name
Last Name
<<Add Sort>>

O sum Ofiverage [ ™in
[ O Mas O Count

O Rests column widin

Figure 12-2
The report design in the Quick Report editor
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By comparing the report design with the final printed output,
you can see that the Header row is shown at the top of the
design and that it is printed at the top of the columns of field
information. The Detail and Break rows appear in the middle of
the design, and they affect the middle of the printed report. The
Totals row is shown at the bottom of the design, and it is printed
at the bottom.

Details and Breaks

When your report is printed, 4th DIMENSION looks through
the records in the current selection one at a time. The sort order
determines the order the records appear in the report and how
records are divided into groups.

The report design in this chapter sorts the records by
Department. 4th DIMENSION looks at all the records for

one department, then at all the records for the next department,
and so on. This sort order allows 4th DIMENSION to calculate
a subtotal for each department. If the records were sorted by
job title, 4th DIMENSION could calculate a subtotal for each
job title.

Whenever the value in the sort field changes, a break is
generated. The word break comes from the idea of interrupting.
When 4th DIMENSION comes to the end of the records for the
art department, a break occurs (an interruption in the sequence
of Department entries). Before 4th DIMENSION prints the first
record in the next department, it performs whatever calculations
you have instructed it to do.

Records can be sorted into many levels. If you sort the records
by department and then by job title, you can create a break
whenever the job title value changes as well as when the
department value changes. You could therefore calculate
additional subtotals for job title within department.
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Cycle arrow

Field list

You must have at least as many sort levels as break levels.

But you don’t have to create a break level for every sort

level. In the example in this chapter, there are two sort fields,
Department Name and Last Name, but only one break level.

The break level corresponds to the first sort field, Department —
Name. Therefore, records are broken up into groups using

the Department Name, but not Last Name. The Last Name

field is used to sort records so that within each department

the employees appear in alphabetical order.

Creating a Quick Report

For this quick report, you will create a list of employees and

their salaries, grouped by department. You plan to calculate

the total salaries for all employees as well as subtotals for each
department. -

If you have not done so already, start 4th DIMENSION and
open the Personnel 12 database.

Personnel 12 opens in the User environment.
Choose Quick from the Report menu.

4th DIMENSION displays the Quick Report editor.

Reports... Report with frame

1]

[TCS Mamne

First Name
Start Date

Bl

Work area

Salary
Title
SSNumber

| UeEartmen! Code
eview Info

i

Sort
<<Add Sort>>

50 100 150 200 250

O sum O#fserage [Mia
O mMas O <€aunt
0K [ &t column widih

Figure 12-3

The Quick Report editor

In the next steps you will drag the fields from the field list into
the work area. Since the first field you want (Name) is in
another file, use the cycle arrows at the top of the list to
display the [Departments] file.
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Click the right cycle arrow until the [Departments] filename is
displayed in the box.

The [Departments] file fields are displayed in the field list.
Drag the Name field from the field list into the work area.

When you release the mouse button, 4th DIMENSION creates
a column for department names.

Click the left cycle arrow once to return to the [Employees]
file fields.

Drag the Last Name field, then the Salary field from the field
list into the work area.

4th DIMENSION creates two new columns for these fields.

You now need to establish the sort order, both to determine
the order in which the records will be printed, and to allow
you to create a break row. You will use Name and Last Name
for your sort fields.

Drag the <<Add Sort>> phrase from the Sort list onto the
Name column in the work area.

Reports... [ Report with frame

PUEE Lost Name  1Salary K
POOCHE L o<t Name  iSalary

- Employees -
Last Name
First Name

o

Start Date
Salary

Title

SSNumber
Department Code
Review Info ]

O Sum [J Average O Min

||
2 O Man [] Count
0K [ Auto column width

Figure 12-4
Dragging the <<Add Sort>> phrase to create a sort field

4th DIMENSION adds the Name field to the Sort list.

Drag the <<Add Sort>> phrase from the Sort list onto the Last
‘Name column.

You have created a two-level sort. The primary sort field is the
department name, and within each department the records are
sorted by the employees’ last names.
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Salary column

Total row

You want to have 4th DIMENSION calculate a total for
salaries. You do this the same way you did it in Quick Start.

Click the Sum check box

9. In the Salary column, select the cell intersected by the Total
“row, and then click Sum.
4th DIMENSION adds a Sum symbol to the selected cell,
instructing the program to calculate the total of all the salaries
when the report is printed. The total will be printed in the
Salary column.
Reports... [ Report with frame
- - Name Last Name Sa1§rg i K
l;‘irs;""a;\:e Ko [H [Mame ‘LastNeme iSalary
Reviee o = |
Sum [JAverage [ Min
2l [ Man [J Count
Cancel | 0K [ Aute column width
Figure 12-5
Instructing 4th DIMENSION to calculate a total
10. Select the cell to the left of the calculated cell you just created,
click again to create an insertion point, then type Grand Total.
Select left from the style menu.
You can now create a Break row, so that you can instruct
4th DIMENSION to calculate a subtotal.
11. Select the Total row by clicking on the “T” or by clicking in
the Total row to the right of the fields.
12.

Choose Insert Break from the Edit menu.
4th DIMENSION creates a Break row just above the Total row.

4th DIMENSION adds a Sum symbol to the Salary cell in the
Break row. This action instructs the program to calculate the
subtotal (all the salaries in the preceding department) when the
report is printed. The same symbol is used for both summing
operations (total and subtotal). The difference between the
instructions depends on the row in which the Sum instruction
is placed: Placed in a Total row, the Sum calculates over the
entire report (sums salaries for every record in the selection);



13.

14.

15.

placed in a Break row, the Sum calculates over only the
records printed since the previous break (sums salaries for
records in each department).

You can now add some additional text next to the subtotal.
Placing the text in the Break row ensures that it will be printed
each time the subtotal is calculated.

Select the cell to the left of the subtotal cell you just created,
click again to create an insertion point, then replace the
existing text with Subtotal for: #. Select Right from the Style
menu. '

The p(g)u&rf& sign, #, tells 4th DIMENSION to substitute the
name of the department whose sum is being printed. For
example, when 4th DIMENSION prints the subtotal for the
engineering department, the label will read, “Subtotal for
Department: Engineering.”

Click on the Detail cell in the Salary column. Click again to

/

create an insertion point. Type the format: $###,###. (

This tells 4th DIMENSION how to format the employees’ %

salaries. This format will also be applied to the subtotals and
the grand total.

Here is your final report design:

Reports... [ Report with frame

- Name :iLast Name iSalary

Last Name Mame iLast Name ‘Salary

First Name o gres wue
Start Date - -
Salary B1 Subtotal for # Sum,
Title 2 e
SSNumber T Grand Total @ sum
Department Code
Review Info 5

Bl

Sort

Narne
Last Mame
<<Add Sort>>

O sum Osearage [ Min
1] O Mas O ¢aunt »
O 8ute column widih =

Figure 12-6
Final report design

You are now ready to print your report. D) )2

(

Choose Print from the Fil(_e menu.
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16. Select “Preview on screen” and then click OK.

4th DIMENSION prints the report. You can click Zoom to
examine it closely. Click Stop Printing and OK to exit.

MNarne Last Mame Salary
E;ccount'in-.gi ........ Baldwin $42,990
Johnson $128,250
Subtotal for Accounting $62,240
Administration  iHanson $40,520
Pfaff $26,440
Srnith $26,500
Terry $16,190
Wilzon $36,500
Subtotal for Administration $146,150
tArt Forbes $18,840
: Martin $56,144
Tampking $19,770
Yenable $42 520
Vaoltz $25,150
Subtotal for Art $163,424
Design Doyen $43,210

Figure 12-7

The report previewed on screen

You have created and printed a useful report in just a few
minutes. If you wanted to print such a report each month

or each quarter, you could save this report and use it over
again. When the time came, you would simply load the report
design and print it again. The printed output would reflect
any changes you had made to the database in the meantime.

The Next Step

The Quick Report editor can also print text at the top and
bottom of each page, provide automatic page numbers, and
use any text font, size, and style. For complete information,
see the 4th DIMENSION User Reference.
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CREATING A CUSTOM REPORT
LAYOUT

Database: Personnel 13
Estimated time to complete: 45 minutes

One of the major functions of a database is to produce reports.
In Chapter 12 you used the Quick Report editor to create a
report. In this chapter you will use the Layout editor to create
a custom report.

There are several advantages of using a layout for a report:
you can use graphic elements on the layout, you can control
the placement of report elements precisely, you can use scripts
to perform calculations, and you can use headers at each
break. The advantage of the quick report is that it is sometimes
faster to create.

You will next create a report that shows the employees, their
salaries, and the total salaries for each department. This report
is similar to the quick report you produced in the previous
chapter. By going through the steps in each chapter, you can
compare the two methods.

In this chapter you will learn how to

m create a report layout including header, footer, detail, and
break areas

m print the time, date, and page number

m create scripts that calculate subtotals and totals

%
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Here is an example of a report produced from a layout:

Header
Consumer Products Employees
Date: 6/8/89 Time: 5:43 PM
Accounting
Break header
Name Title Salary
Detail Baldwin, Steve Supervisor $43,930
Johnson, John Clerk $18,250
Break subtotal Total Salaries for Accounting $62,240
Transportation
Break header
Name Title Salary
Detail Bentley, Alice Engineer $28,000
Garbando, Smeldorf Clerk $19,610
Break subtotal Total Salaries for Transportation $47,610
Grand total Total Salaries for Cormpany $109,850
Footer Salaries by Department Page: |
Figure 13-1

The final report
Here is the output layout for this report.

[ € File Edit Use Design Layout Object Font Style ]
Ei———————— Layout: EmployeeReport =ic—————""112
N\ Consumer Products Employees i
rDste: FEE— me (E— 1 |
Header marker OlAlT ——= T e
O|O0|[Name | [S0
qu::(l;:\eader = EIName Title Salary _
Detail marker e L IS43E] Jlselary | D
= [ Total Salaries for <[Departments]N FrargSub | i
Break markers z [ i i INeome, Lo o B
T i | 1 Total Salaries for Company [VSateryTaf | i
T ¢ M
G Salaries by Department Page: p 200
Footer marker

Figure 13-2
The report layout

The areas of the report—the header, break header, detail,
break area, and footer—are controlled by the report control
markers on the layout. The report control markers are in the
right ruler.
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You are familiar with most of these terms already:

Header: The header is printed at the top of each page.

Break header: A break header contains material that is
printed once at the beginning of a break, and not again until
the next break. This type of header is useful to label
information at each major division of a report.

Detail: The detail area usually contains data that comes
directly from each record. Whatever appears in the detail area
on the report layout is printed once for each record.

Break: A break area contains subtotals and other calculations
performed during a break in the Sort field. You can specify
what calculations you want performed and any additional text
you want printed whenever a break occurs.

Footer: The footer is printed at the bottom of each page.

The layout rulers are marked in pixels, which are the smallest
dots your screen can display. The rulers can be changed to
inches or centimeters by choosing Ruler Units from the
Layout menu.

The report control markers define areas on the layout. The
elements you place in each of these areas—fields, text, and
variables—are printed at the appropriate place in the report.
You can use scripts to perform any necessary calculations.

Working With Report Control Markers

In Quick Start you created an output layout to display your
records on the screen. This time, you will create an output
layout designed for printing.

If you have not done so already, start 4th DIMENSION and
open the Personnel 13 database.

Personnel 13 opens in the User environment.

Choose\Des‘ign from the Use menu.

oo
v
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Create a new output layout for the [Employees] file named
EmployeeReport.

Include these fields in this order: Last Name, Title, and

* Salary. Use the layout template in the upper-left corner of the

pattern choices. Make sure your New Layout dialog box
matches that in Figure 13-3.

New layout for Employees
Select fields:

) 9 point

Font size: @ 12 point

Last Name 1 K3

First Mame 1 ====] ases ———

Start Date

Title 2 Ee E
S=

SSNumber

Department Code [Departments
Review Info

[Departments]

CusTom

Layout Name:

ﬁ lEmpIugeeHeport J

[ Enterable related fields

[ .‘i'%;;f%%zzﬂ [[ Select ]] | cancel } [ 0K ]

Figure 13-3
New Layout dialog box for the report layout

The layout is displayed in the Layout editor.

[ & File Edit Use Design Layout Object Font Style |

iEl)=—— layout: EmployeeReport =——————15|
Y Lost Name Title Salary - - '3
O[iANLast Name J[Title [Salary | EQH

Figure 13-4
The three fields in the layout

Expand the window either by clicking the zoom box or
dragging the size box.
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To prepare to add elements to the report, drag the Footer
marker down to 230 and the Break marker down to 150.

To move the marker, drag the letter or the triangle of each
marker. A dotted line extends from each marker across the
layout to show the location of each area.

The Footer marker, a triangle labeled F, shows the bottom

of the Footer area. Anything you enter on the layout between

the Footer marker and the Break marker will be printed at the
bottom of each page of the report. You usually use footers for
page numbers and running titles or comments.

The Break marker, a triangle labeled B0, shows the bottom
of the Break area. The Break area is equivalent to the T row
in the Quick Report editor. BO stands for the level zero break.

Hold down the Option key and click the Break marker.

The level one Break marker, labeled B/, appears on top of BO.
Drag the BO marker down to 180.

Anything you enter on the layout between the B1 Break
marker and the Detail marker will be printed each time the
value in the sort field changes. (You will sort the records
before printing to create the necessary Sort field break.)

ﬁ Note: If you inadvertently create an extra Break marker
(B2, B3, and so on), you can delete it by holding down the
Commandﬁ keﬁyiagxou click }hfa_ vunwanted marker.

Choose Select All from the Edit menu. Move all the elements
on the layout by dragging them so that the bottom line of the
frame is at about 120. Deselect the elements by clicking on the
layout. Format the Salary field with a $ format by double-
clicking on the field and choosing the format from the Format
pop-up menu. See Figure 13-5 for the proper positioning.
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Bottom of frame

10.

11.

[ ® File Edit Use Design Layout Object Font Style ]
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Figure 13-5
The bottom of the frame is at 120

Drag the Detail marker down to just above the bottom line of
the layout (just above 120). See Figure 13-6.

The Detail marker, a triangle labeled D, shows the bottom of
the detail area. Anything you enter on the layout just above the
Detail marker will be printed once for each record in the
selection you print. You use this area for data drawn directly
from the records.

Drag the Header marker until it is at 40.

The Header marker, a triangle labeled H, shows the bottom of
the header area. Anything you enter on the layout just above
the Header marker will be printed at the top of each page of
the report. You usually use headers for the title of the report
and date or time stamps.

Hold down the Option key and click the Header marker.
The level one Break Header marker, labeled H 1, appears.



12.

13.

14.

wvertical bars inside the layout box that separate the fields.

REPORTS

Drag the H1 marker just below the middle line of the layout
and above'the fields (just above 100).

The Break Header marker, labeled H1, is at the bottom of
the break header area. Anything you enter between the Break
Header and Header markers will be printed once above each
group of records. You will use this area to label each group
of records and the columns of the report.

Raise the top line of the layout box up to 50. Delete the two

® File Edit Use Design Layout Object Font Style |

[[E——————= layout: EmployeeReport

0
-
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r
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Figure 13-6
The layout after markers have been dragged

Click the Add Field tool and draw a rectangle in the upper-left
corner of the layout box (see Figure 13-7). Select the Name
field from the [Departments] file. To do this double-click on

the [Departments] file name and scroll down the list of fields
to Name. Make the field 12 point and bold.

You have now defined areas on your layout for elements to be
printed in the Header, Break Header, Detail, Break, and Footer
areas of your report. Anything entered in these areas prints at
the appropriate time.
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[Departments] Name
field

® File Edit Use Design Layout Object Font Style ]
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Figure 13-7
The [Departments] Name field is added

Working With Nonenterable Objects and
Scripts

2

B chL spac

You worked with one type of active object, in Chapter 1, when
you added buttons to your layout. Now you will use objects
and scripts to perform tasks on this report layout.

Select the Last Name text area, and change it to Name.
You use the Text tool to select text within the text area.

Delete the Last Name field by selecting it and pressing the
Delete key. Replace it with an active object.

To add an active object, you click the Create Active Object

icon, then you draw a rectangle where you want to place the
object. You will name the object and add other instructions

in the Object Definition dialog box.

You selected the Last Name field for inclusion only so that the
layout would provide room for this object. You are going to
write a script for the object to join each employee’s first and
last names.



REPORTS

In the Object Definition dialog box, type vName for the name,
select a Nonenterable object type, deselect “Only if modified.”

Be certain to deselect “Only if modified.” “Only if modified”
applies only to an input layout. If you leave it selected, the
script will not be executed when the report is printed.

Click the Script button, and select the Listing type for the
procedure. Enter the following one-line procedure, then click
the Close box:

vName:=Last Name+", "+First Name
Make vName 12 point.

This script instructs 4th DIMENSION to print the value from
the Last Name field, then a comma and a space, and then the
value from the First Name field. This is better than using two
fields on the layout because the comma and the first name
come immediately after the last name. Two fields would leave
extra spaces after most last names.

The vName variable is in the Detail area of the report. It will
be processed and printed once for each record you print. The
script you have written will cause the report to include the last
and first names for each employee.

Everything in the Detail area prints once for every record. The
Name field will print the department name and the Salary field
will print the salary value, once for each record. Of course, the
information on the record will determine the exact value
printed for each record.

In the Header area above the column headings, create a large
text area and enter a report title: Consumer Products
Employees. Set the font and size of the title to Helvetica 18
and make it bold (see Figure 13-8). -
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Create a text area and and type Date:

7. Create an active object, name it vDate, and make it a
Nonenterable object. Deselect the “Only if modified” check
-box. Use the Short date format. Click the Script button and
enter the followmg script:

vDate:=Current date

This code instructs 4th DIMENSION to print the current date
in the object.

8. Create a text area and type Time:

Create an active object, name it vTime, and make it a
‘Nonenterable object. Deselect the “Only if modified” check
box. Use the H:MM AM/PM format. Click the Scrlpt button
and enter the following script:

vTime:=Current time

This code instructs 4th DIMENSION to print the current time
in the object.

Your layout should now look like Figure 13-8.

[ % File Edit Use Design Layout Object Font Style

|
Layout: EmployeeReport %Q;E
Text areas — Consumer Products Employees S
. , Date (i3 ——— ] e ¥ i
Active objects Time (TR |

[Name ]

MName Title Salary
[lame————____ |[Title |[Satary |

Figure 13-8
Elements added in the Header area

10. In the B1 Break area (between the Detail marker and the B1
Break marker), create an active object for the salary subtotal.
Make the object the same size as the Salary field above it.
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11.

12.

REPORTS vV

Name the object vSalarySub. See Figure 13-9 for placement.
Make vSalarySub a nonenterable object, deselect “Only if
modified,” and enter $#,### ### as the numeric display

format.

: Y

Click the Script button and enter the following script:
vSaIarySub =Subtotal(Salary)
The Subtotal routine instructs 4th DIMENSION to calculate the

total for the current break. Because the object is located in the
B1 Break area, the Subtotal routine will calculate a subtotal
for each department. The portion of the script in parentheses
is called the argument for the Subtotal routine. It instructs
4th DIMENSION to use the Salary field for the subtotals.

Create a text area to the left of the vSalarySub object.

An insertion point appears in the text area. Type the following
label: Total Salaries for

Press the spacebar after typing the label.

While holding down the Shift and the Optlon keys, press and
hold down the mouse button. -/

A pop-up menu appears as shown in Figure 13-9.

[ ® File Edit Use Design Layout Object Font Style

IE)=——————— layout: EmployeeReport
N Consumer Products Employees
| CJfName |
— Marne Title Salary
El— == .
= [vHEmT—— |[Tit1e |[Salary ]

:Tcutal Salaries for

;
._

Departments ) o SIS &

N:nle

1

Figure 13-9

Manager
Budget
Total Salaries

Field names pop-up menu

Choose the Name field in the [Depa1 tments] file from the pop-

up menu.
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4th DIMENSION appends the Name field to the text. The text
area should now look like Figure 13-10.

[ % File Edit Use Design Layout Object Font Style ] '
[E0==—=—=—=—=——=——— |ayout: Employeeheport ==
SP Consumer Products Employees [©
O AlPate f———_ 1 Time : [rTime——___] -QH
O|OfName | [0
EEE Narme Title Salary [
) = %I : e
Field name —1= [vHame———__ |[Title |[Salary | 0
g\;il’ted in text ;_ ||_|,||,| Total Salaries for <[DepartmentsName> i

Object to calculate
a subtotal

Figure 13-10
Elements added in the break area

When you print the report, 4th DIMENSION will insert the
name of the department where the <[Departments]Name>
phrase appears in the output layout.

ﬁ Note: You can use this technique of embedding the values of |

fields in text areas in other kinds of reports. For example, you
can create a mail-merge letter using one large text area. See
Chapter 5 of the 4th DIMENSION Design Reference for more
information.

13. Choose 12 point and Right from the Style menu.
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14. Now create an active object to calculate the total salaries, and
add additional text to identify it. Place both elements in the BO
Break area. See Figure 13-11 for placement.

The active object, named vSalaryTot, can be created by
duplicating vSalarySub, and then editing the name and the
Script. The script to calculate the total is as follows:

vSalaryTot:=Subtotal(Salary)

The Subtotal routine instructs 4th DIMENSION to calculate
the total for the current break. Because the object is located
in the BO Break area, the Subtotal routine will calculate the
grand total for all records.

[ % File Edit Use Design Layout Object Font Style ]
[I==————— layout: EmployeeReport E—BEE
t Consumer Products Employees @
A |Pate : [vDate — Time fime——_] | o
C] Cl{Name | [0
= Name Title Salary L
=i
——{[vNarme—— |[Title |[Salary | ,:155[)
; ,E, Total Salaries for <[Departments]Names [VSatarySub | L
= ¥ s #0 B
, il 11 Total Salaries for Company [vSatspylot i
Object to calculate 1-11___'5,1__[5 . — 4 EO
grand total : J i

Flgure 13-11
Placing text and an active object to calculate a total
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15.

16.
17.

18.

In the left side of the Footer area (between the BO Break
marker and the Footer marker), create a text area and enter a
running title:

Salaries by Department

This running title will print at the bottom of each page of the
report.

On the right side, create a text area, and type: Page:

Create a Nonenterable active object to contain the page
number. Name this object vPage; deselect “Only if modified.”

Click the Script button and enter the following script:
vPage:=Printing page
This script causes 4th DIMENSION to print the page number.

% File Edit Use Design Layout Object Font Style

I |
IElE=————— layout: EmployeeReport EEEE

:n Consumer Products Employees [
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Salaries by Department Page:

Figure 13-12
The completed report layout

Figure 13-12 shows the completed report layout. Make sure
your layout looks similar to this layout before you continue.



REPORITS IV

Printing the Report

You have created the layout, objects, and scripts for your
report, and now you can see the result.

1. Choose User from the Use menu.
, o€
b Sez € 2. Choose Sort from the Select menu and sort the records by
‘ Departments] Name and [Employees] Last Name.
// D:."ﬂ l:ZA/I.M( [ P ] [ proyes ]

3, [Emr] Last Manc Use the cycle arrows to choose the [Departments] Name field.
. Lémp.

You can sort the records in the [Employees] file by a field in
the [Departments] file because the two files are related.

This sort order is required so that a break is generated after
each department. 4th DIMENSION also requires at least one
more sort level than break level. In this case, you are using
two sort levels so that the names that appear within each
department are in alphabetical order.

—— Y Sort Emplogees...

* 2| |Name
L;asi Hame -’\;‘\r
£l svMame Last Narme
Start Date

Salary

Title

BSMurnber
Department Code
Review Info

[

$<§<<] 1_Hdd Furmulﬂ [Zé@i@%zﬂ (Cancel ][ Sort ]

Figure 13-13
Sorting the records prior to printing

You are now ready to print your report.
{ : :
& ry L 3. Choose Print from the File menu.
J ) 2 A ’ =

The Print File dialog box appears. Here you choose which
layout you want to use to print.

Somull 4. Eetlectﬂ EmployeeReport, the layout you just designed, from the
ist.
5. Click OK.
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Two printer instruction dialog boxes appear, one after the
other. If you have a printer connected to your computer,

you can print your report. Click the “Preview on screen” - ¥
check box on the second dialog box to send your report to

the screen instead.

Click OK.

Click the Zoom button to see the report close up.

= Printing Employees =——————VT15|
Consumer Products Employees

Date: 6/8/39 Time: 5:34 PM

Accounting
MName Title Salary
Baldwin, Steve Supervisor $42,990
Johnson, John Clerk $18,250
Total Salaries for Accounting $62,240
Administration
Mame Title Salary
Hanson, Dennis Manager $40,520
Pfaff, Bryan Secretary $26,440
Smith, Mary Engineer $26,500
Terry Don Clerk $16 140
Figure 13-14

Seeing the report printing to the screen

You have created a working report. The scripts perform the
necessary calculations for subtotals and totals. They display
the proper department name for each subtotal as well as the
date, time, and page number of the report. You can view the
third page of the report to see that the text for the grand total is
also correct.

The Next Step

180

You have created a report layout and printed a report with it.
In Part V you will use this layout for a report in a runtime
application.

In Chapter 15 you will create a global procedure that
automatically carries out the manual actions you performed in
this chapter (sorting the records, choosing the layout to use for
printing, and so on). You will then link the procedure to a
menu item. You can use this menu item in the runtime
application, and you can also execute the command to print
this report from the User environment.
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CREATING CUSTOM MENUS

Database: Personnel 14
Estimated time to complete: 15 minutes

You can create your own Macintosh applications, called
runtime applications, using 4th DIMENSION. You work with
a runtime application in the Runtime environment, or as a
stand-alone application using a special Runtime version of
4th DIMENSION.

A runtime application uses many elements you are already
familiar with: fields, choice lists, objects, scripts, formats,
procedures, layouts, and so forth. To create a runtime
application, you combine these elements with custom menus.

In this chapter you will learn how to
m create custom menus

m add a unique graphic background to an application
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Runtime Applications

A runtime application is an extension of a database. With a
runtime application, you create the files, fields, and layouts
you need. Then you package the database with customized
menus and procedures that control the program. You use
display data, and reports for printing data.

Menu commands and procedures allow the user to perform
operations you provide, such as searching, sorting, and
graphing. Your procedures can use the same editors used

in the User environment. You can use the 4th DIMENSION
Sort editor, Search editor, Search by Layout, Quick Report,
Graph editor, Label editor, and so on. Or you can have more
functions than the User environment offers. You can add
special search dialog boxes that perform exactly the search
you want with just a click. Or you can call a particular sort
from a menu for a sort you do frequently.

You can make a simple program. If you want a program
that accepts information and stores it in records, you can
create an application that does only that. If you want a
program that accepts information and prints a daily report,
you can have that.

Or you can make a multi-function program that includes

the features you have already worked with: data validation,
mailing labels, sorting, searching, and so on. You can create
an application that includes several different reports; the
ability to add, modify, and delete information; and output
to desktop publishing programs.

If you have a multi-user setup (a server with several Macintosh
computers hooked up to it), you can create a program that
users in different departments each use with different access
privileges. The manager of the accounting department might
be able to display information from any file in the database,
while an order entry clerk might be able to see and use only
one layout in a single file.

And remember that you can create programs that take
advantage of the whole range of Macintosh interface features—
different windows, custom dialog boxes, and so on.
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Creating Custom Menus

4th DIMENSION allows you to create custom menus to operate
your runtime application.

®€ File Edit Departments

(AT GITEEES Reports

Maodify Empﬁgee
Remove Employee

Figure 14-1
A custom menubar with menus and menu items

A menu bar is one set of menus. You can have several menu
bars for your application, each with different menus. Each
menu bar can have as many menus as can fit across a screen.
Each menu can have as many items (commands) on it as there
is room for in a screen.

Each menu item calls a procedure to carry out the command.
In this chapter you will create menus and menu items. In the
next chapter you will create the procedures for two of the
menu items you create in this chapter.

For this tutorial example, you will create the menus for a
runtime application based on the database you have been
working with in previous chapters. This application performs
information tracking for your employees. It includes reports
that you provide for your company each month and each
quarter.

Suppose you decide that your personnel application needs the
following menus and menu items:

File Departments  Employees  Reports
Quit  Add Department Add Employee Monthly
Modify Department  Modify Employee Quarterly

Remove Department Remove Employee
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Getting to the Menu Editor

To create these menu titles and items you use
4th DIMENSION’s Menu editor.

If you have not done so already, start 4th DIMENSION and
open the Personnel 14 database.

Personnel 14 opens in the Design environment.
Choose Menu from the Design menu.

4th DIMENSION displays the Menu Bars dialog box.

Menu Bars...

New
fialaia
I Hnen I

<l

Figure 14-2
The Menu Bars dialog box

This dialog box will eventually list all the menu bars you
create for this database. You can then select the one you
want to modify. Because this is your first custom menu, the
menu bar display area is blank.

Click New.

4th DIMENSION displays the Menu editor, titled Menu Bar #1.
You cannot change this name.

On every menu bar, 4th DIMENSION automatically enters
the File menu as the first menu. It contains one menu item,
the Quit command.

Select the File menu title.

As you can see, the Menu editor displays the items in the
selected menu. In this case, there is only one item, Quit, and
there is no procedure. The absence of a procedure is the way
to tell 4th DIMENSION to quit the application.



It is always a good idea to leave the Quit command on the File
menu because that is where Macintosh users expect it to
appear.

Pull down the File menu on the far right side of the screen.

(& File Edit Use Design Menu A
Quit

Figure 14-3
Viewing the File menu

The menu preview shows the order and style of the menu
items on the selected menu. In this case, there is only one
item, Quit. Later you will preview the menus you create.

Entering Menu Titles and Items

You create the menus you want by entering the menu titles in
the Menus column in the order you want them to appear. Then
you enter the items for each menu in the Items column. For
each menu item (except Quit), you enter a procedure name in
the Procedures column. If you don’t enter a procedure name,
4th DIMENSION will quit the application when that menu item
is chosen.

The menu titles you create appear across the top of the screen
in your application. 4th DIMENSION automatically shows the
Apple and Edit menus.

Choose Append Menu from the Menu menu.

A blank box containing the insertion point appears in the
Menus column.

Type Departments.

This is the first of your custom menu titles. You will enter the
items for this menu later.

Double-click in the Menus column just below the Departments
menu title.

Double-clicking creates another menu title box, just as if you
had chosen Append Menu again.

Type_ Employees.
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5. Double-click below this menu title to create another blank
menu title box.

6. Type Reports and this time press Return.
Pressing Return also creates a blank menu title box.

Now you have finished entering your custom menu titles. You
can go on to enter the items for each title and the procedure
name for each item.

7. Select the Employees menu title.

Use the scroll bar to move this menu title into view, if
necessary, before selecting it.

8. Choose Append Item from the Menu menu.

A blank item box appears in the Ttems column and a blank
procedure box appears in the Procedures column.

S[[=————— Menu Bar #¥1 ==—-=-I=
Menus Items Procedures
File K > n
Departments
Employees
Reports
- o] o
[J Keyboard: |__—] [JBold
[OLine [ 1talic
(4 Enabled [J underline
[] Outline
Password: [A1l Groups ] [JShadow
ol
Figure 14-4

Appending an item

4th DIMENSION always adds both these boxes at the same
time because each menu item must have a procedure entered
in the Procedures column.

9. Type Add Employee in the item box and press Return.
The insertion point moves to the procedure box.
10. Type Add Empl and press Return.

Add Empl is the name you will give the procedure to add an
employee record to the database.

190



11.

Another item box and procedure box are added on the next
line.

You get the idea. You type in the menu item as you want it to
appear and then enter a procedure name for each one. You can
use any procedure name you want.

Complete the menu bar. To prepare for the next tutorial, add
the following menu items and procedures:

Tile  ftem

Departments Add Department Add Dept
Modify Department Mod Dept
Remove Department Remove Dept

Procedure

Employees Add Employee Add Empl
Modify Employee =~ Mod Empl
Remove Employee = Remove Empl

Reports Monthly Monthly Rep
Quarterly Quarter Rep
When you have finished, the menus look like this:
S[1&=———— Menu Bar ¥| =——"—F=
Menus Items Procedures
File K ¥ Add Department {3+ Add Dept iy
Departments Modify Department Maod Dept
- - Remove Departrent Remove Dept
Employees
Reports
o o =
Menus Items Procedures
File K #| Add Employee KCr| Add Empl K3
Departments _< Maodify Employee Mod Empl
. Remove Employee Remove Empl
Employees
Reports
o [ 7
Menus Items Procedures
File KC#|Monthly KCr|Monthly Rep iy
Departments Quarterly Quarter Rep
Employees
Reports
o] >
Figure 14-5

Completed menus

CHAPTER 14: CREATING CUSTOM MENUS 191



192

Changing the Style and Adding a Shortcut

On the lower half of the Menu editor window are commands
to change the look and function of each menu item. The users
of this application will most often choose Add Employees.
You can provide a visual emphasis for the menu item and add
a keystroke to activate the command as well.

Select the Add Employee menu item.
Click the Underline check box.
The menu will display Add Employee with an underline.

ﬁ Note: Underlining is shown here for demonstration only.
Apple’s Human Interface Guidelines suggest that you should
retain the basic Macintosh typeface in menus. You should
reserve font and style changes in menus for those menu items
that result in font and style changes in the application.

Select the Keyboard check box.

You want this menu command to be accessed by a keystroke
as well as by choosing the item from the menu. You want the
keystroke to be Command—N.

Select the Keyboard entry box and type N.

4th DIMENSION will automatically insert the command
character.

Preview the menu display by pulling down the menu preview
on the far right of the menu bar.

Employees.

Add Employee 3N
Modify Employee
Remove Employee

Figure 14-6

Previewing the modified menu

You have now made it possible to use the Command-N
keystroke combination to start the process that adds an
employee record to the database.

Note that there are two additional check boxes on the bottom
of the Menu editor, Enabled and Line. Menu items are
automatically enabled when you enter them in the Items panel.
If you want to disable a menu item, click the Enabled check
box to turn it off. It remains disabled until you click Enabled
again. A disabled menu item appears gray in the menu.
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You can enter a line between menu items by clicking the Line
check box. This effectively separates menu items into groups
of commands for the convenience of the user, as on the
standard Macintosh Edit menu.

Previewing the Menus and Adding a Graphic

You use 4th DIMENSION’s Menu editor to preview your menu
bar and to paste a picture to use with it.

Choose Show Custom Menus from the‘Menu menu.

4th DIMENSION displays the menu bar you have just
designed.

Pull down the Employees menu that you have just created.

& File Edit Depart

ApALITEEESN Reports
Add Employee N
Modify Employee
Remove Employee

4th DIMENSION

©1985-1989 ACI, ACIUS Inc.

Figure 14-7

Previewing the custom menus

Choosing a menu command from this screen does not activate
the command (and it wouldn’t activate it even if you had
already written the procedure). You must be in the Runtime
environment to start a command from a custom menu.

If you have a picture in your Clipboard, you can paste it here.
If you do so, each time this menu bar is shown, the picture will
be displayed also.
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Use this feature of 4th DIMENSION to personalize your
database applications with designs, patterns, and pictures that
suit the company, person, or department that will be using the
application.

Click anywhere in the screen below the menu bar to return to
the Menu editor.

Click the close box to close the Menu editor and return to the
Structure window.

The Next Step

In this chapter you have seen how to create and preview a
customized set of menus and menu items for use in the
Runtime environment. Go on to the next chapter to see how to
create the global procedures that are called by these menu
commands.

It does not matter in what order you create the custom menus
and the procedures they use. You can write the procedures first
or create the menus first. In the case of the Add Employee,
Monthly, and the other menu items in this chapter, you created
the menu items before the procedures. You now need to give
the correct name to each procedure when you write it. You can
keep the Menu editor window open on the screen when you
name the procedures, so that you can see which name you
have used.
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USING PROCEDURES WITH MENUS

Database: Personnel 15
Estimated time to complete: 25 minutes

If you want to use the Runtime environment or the Runtime
version of 4th DIMENSION, you need to create custom menus
to add and modify records, search, sort, print, and so on. You
write procedures that perform these functions.

4th DIMENSION provides a powerful procedural language that
allows you to control every aspect of your application.

In this chapter you will create procedures to
m add arecord
m print a report

m search records

® sort records

This tutorial is based on the menu structure you created in
Chapter 14. You will write three of the procedures you
specified in Chapter 14. After you write these procedures,
three of the menu items you created in Chapter 14 will work.
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Programming in 4th DIMENSION

A program is a series of statements that tell a computer what
to do. In 4th Dimension, a series of statements is called a
procedure. 4th DIMENSION’s language provides over 200
commands for writing procedures for runtime applications.

4th DIMENSION’s language is a high-level language; that is,
one command in the language performs a series of actions
within the computer. The ADD RECORD command, for
example, automatically peforms all the steps necessary to
display an input layout and accepts the record when you
click OK.

4th DIMENSION’s language has many techniques in common
with other programming languages, such as

Tests: Conditions that are evaluated so that the program
knows what to do next.

Loops: Statements that require the program to repeat an
action until a test is evaluated as true.

Parameters: Pieces of information given to a procedure
so that it knows what to do or what to act upon.

Functions: Statements that result in a value (a number,
date, time, or series of characters) that can be used by the
program. A function is said to return a value.

Commands: Statements that instruct the program to do
something. For example, ADD RECORD is a command.

4th DIMENSION functions and commands are called routines.
The routines available in 4th DIMENSION appear in a list so
that you can place them in a procedure by clicking.

A complete discussion of programming with 4th DIMENSION
is beyond the scope of this book. Further information can be
found in the 4th DIMENSION Language Reference.
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Creating a Global Procedure

You are now going to write the procedure to add an employee
record to the database. This is the procedure you named Add
Empl in the previous chapter.

1. If you have not done so already, start 4th DIMENSION and
open the Personnel 15 database.

2. Open the Procedure editor, and create a new global procedure
called Add Empl.

If you need to review the beginning steps for creating a
procedure, see Chapter 7, “Using Procedures.”

4th DIMENSION displays the Procedure editor in a window
titled Procedure: Add Empl. You use the Procedure editor to
write and edit procedures.

S[]=————= Procedure: Add Empl

Procedure text |
area

=14
> i

Keywords * Employees -* Routines

i | Arrays
Boolean

- Communications
ompiler Directiv

If
Else
End if
Case of

{7|Last Namne
First Name

End case
‘while

i|Exceptions
Execution Cycle

Figure 15-1
The Procedure editor

You can most easily learn how to write 4th DIMENSION
procedures by carefully considering what the program needs
to be able to work. Here are the most important points to keep
in mind:

m A global procedure is executed from beginning to end,
in strict order of the lines of the procedure. When the last
statement has been executed, the procedure stops running.

m Since a database can have more than one file for records,
you need to specify which file to add the record to.

m Since each file can have several layouts, you need to
specify which layout to use.
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To instruct 4th DIMENSION to add a new record, you will
specify the [Employees] file and the Empl Input layout, and
then you will use the ADD RECORD command.

You have already seen how 4th DIMENSION allows you to
enter commands and other elements of a procedure by
selecting them from the three panels on the bottom half of the
Procedure editor (in Chapter 7, “Using Procedures™). You can
select the filenames, field names, and layout names that appear
in the center panel; the keywords that appear in the left panel;
and the routines that appear in the right panel.

The following steps do not specify whether to select or type
the elements of the procedure. You will quickly decide which
method works best for you.

First type the following comment to identify the purpose of
the procedure:

- *Adds a record to the Employees file

The leading accent mark indicates that this is a comment, not
part of the instructions. The accent mark appears in different
places on different keyboards. Don’t confuse this accent mark
with the apostrophe or backslash.

Press Return.

When you press Return, the comment is entered and
automatically indented. The insertion point moves to the next
line.

Define the file to use for this record by entering
DEFAULT FILE([Employees])

The DEFAULT FILE command establishes a default file for the
remainder of the procedure. The command is one of the
routines listed in the Routines panel. Notice that when you add
the filename after the command, you need to surround it with
both parentheses and brackets. If you click the filename in the
middle panel, 4th DIMENSION enters the brackets
automatically.



Large dots indicate
incorrect statement.
In this example, the
parenthesis are

missing
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If you should omit any necessary part of a command, 4th
DIMENSION displays large dots on either side of the incorrect
statement (see Figure 15-2). When you correct the statement
and press Enter (or move the insertion point to a new line), the
large dots are removed.

E[J&=————=—= Procedure: Add Empl ="iba0F"=5"77o"]

“Adds a record to the Employees file
SDEFAULT FﬁE[Emplogees lo

Keywords - Employees
Last Name
First Name

Start Date

Routines

Arrays

Boolean

Communications
Compiler Directi
Data Entry
Displaying
Exceptions

If
Else
End if
Case of

End case
While

Department Code

Figure 15-2
Large dots around an incorrect command

Define the input layout you want to use by entering
INPUT LAYOUT("Employee Input”)

Employee Input is the name you gave the input layout you
designed in Quick Start. The layout names appear at the
bottom of the list of fields in the file panel.

Now enter the command to add a record:

ADD RECORD

S[J=———— Procedure: Add Empl
“Adds a record to the Employees file

DEF AULT FILE([Employees])

INPUT LAYOUT("Employee Input™)

ADD RECORD

Keywords

- Ermployees
| Last Name
First Name

-+ Routines

{;| Arrays

Boolean
Communications
Compiler Directi

If
Else
End if
Case of

End case

Department Code
“whils &

Exceptions
E tion C:

Figure 15-3
The completed Add Empl procedure

That’s it. Now you can see how it works.
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Seeing the Procedure in Action

Now that you have a procedure that can be called by a menu
item, you can use the Runtime environment to see how it
works.

Choose Runtime from the Use menu.

The menu bar you have created is displayed. If you pasted a
graphic to this screen from the Menu editor, the screen
displays it also.

Choose Add Employee from the Employees menu.
The input layout you specified in the procedure is displayed.
Type some practice information, and then click Enter.

The initial screen reappears. The record has been accepted just
as if you had entered it in the User environment. Your
procedure works fine.

However, there is still some work to do. Typically, you would
be adding several records to the employee file at the same
time. The way your application works now, it returns to the
starting screen after you enter each record. You will see in the
next section how to make the slight change that keeps the
input screen active until you have finished.

Choose Quit from the File menu.

4th DIMENSION returns to the User environment. Quitting
from the Runtime environment returns control to the User
environment. The record you have entered is displayed.

Choose Design from the Use menu.

The windows you have been working with reappear, ready for
you to make any necessary changes.
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Modifying the Procedure

The Add Empl procedure you have written works fine for
adding a record to the correct file. However, if you have three
records to add, you have to choose the menu item three times.
With a slight modification of the procedure, you can leave the
input layout on the screen until you have finished entering as
many records as you want.

This modification requires that you write a loop for the ADD
RECORD command, making it active until you click Cancel.
This loop is called the “Repeat...Until” loop. Essentially it
requires 4th DIMENSION to repeat a series of commands until
a test is satisfied. The following steps show you how to edit
the procedure you have already written.

If necessary, click in the Procedure:Add Empl window to
make it active.

Click just to the left of the ADD RECORD command to move
the insertion point to that spot.

Either type Repeat or select it from the list of Keywords on
the lower left panel of the screen, and then press Return.

4th DIMENSION automatically indents the ADD RECORD
command. The indentation means that the command has
moved down one level and will be executed only under the
control of the loop that will surround it.

Move the insertion point to the line below the ADD RECORD
command.

You can either click the mouse button to move the insertion
point or use the down arrow on your keyboard.

Enter Until (OK=0) and press Return.

This step completes the loop. The meaning of the loop you
have inserted in the procedure is that 4th DIMENSION must
repeat the ADD RECORD command when you click OK or
press Enter while adding records. Not until you click Cancel
will the ADD RECORD command stop repeating. Clicking
Cancel sets the OK variable to O (zero).
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The OK variable is a variable that 4th DIMENSION creates
automatically. You use it in procedures to test whether a user
has pressed the Cancel button.

E[[=————= Procedure: Add Empl
“#dds a record to the Employees file
DEFAULT FILE([Employees])
INPUT LAYOUT( "Employee Input™)
Repeat
ADD RECORD -
Until (0k=0)

- Employees nd I Routines

Last Name {7 Arrays

First Name . Boolean
Communications

Compiler Directi

Data Entry

Displaying

Exceptions

E Execution Cycle E

Keywords

If
Elze
End if
Case of

End case
While

epartment Code
[ Empigee ot

Figure 15-4
The revised Add Empl procedure

Now return to the Runtime environment to see the difference
this loop makes to the task of entering records.

The input layout now remains displayed and ready to accept
additional records until you click Cancel (OK=0).

Using the Search Editor in an Application

You have several more procedures to write before your
application is finished. In this section you will see how to
bring the Search editor from the User environment into your
own application. You will use the Search editor as part of the
Mod Empl procedure.

The steps described here show you how to create a procedure
that

m displays the Search editor to create a selection of records

m displays the selection as a list from which you can select
the records to modify

Return to the Design environment and create a global
procedure called Mod Empl.

The steps for creating a procedure are explained earlier in this
chapter. Mod Empl is the procedure name you entered for the
Modify Employee menu item in the previous chapter.
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Indicate the file and input layout to use by entering the
following:

DEFAULT FILE ([Employees])
INPUT LAYOUT("Employee Input")

Now you want to instruct 4th DIMENSION to use its own
Search editor.

Enter the following:

SEARCH

The SEARCH command, without any argument, displays the
Search editor. 4th DIMENSION will use the search conditions
you enter to create a selection of records.

Instruct 4th DIMENSION to display the selection of records
and prepare to modify those selected by entering the
following:

MODIFY SELECTION

This command allows you to modify the records in the
selection. To display a record in the input layout, the user
simply double-clicks on the record that needs to be modified.

[ECJ===== Procedure: Mod Empl E'—E]EI
DEF AULT FILE([Erployees]) 1
INPUT LAYOUT("Employee Input™)
SEARCH

MODIFY SELECTION

+ Employees - ] Routines

Last Name 1| Arrays

First Name . Boolean
ommunications

ompiler Directiv

Keywords

If
Else
End if
Case of

ata Entry
isplaying
xceptions
tion Ci

End case
While

Figure 15-5
The completed Mod Empl procedure
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Now return to the Runtime environment to see how this menu
command works.

When you choose Modify Employee from the Employee menu,
the Search editor is displayed. You use the Search editor just as
you used it in the User environment. After you enter the
conditions to isolate the records you want to modify and click
OK, 4th DIMENSION displays the selection of records.

Creating the Report Procedure

In this section you will see how to write a procedure that sorts
the records and then prints them for a monthly report. You will
use the report layout you designed in Chapter 13.

Return to the Design environment and create a global
procedure called Monthly Rep.

The steps for creating a procedure are explained earlier in this
chapter. Monthly Rep is the procedure name you entered for
the Monthly menu item in the Chapter 14.

Indicate the file and report layout to use by entering the
following:

DEFAULT FILE ([Employees])
OUTPUT LAYOUT("EmployeeReport")

Enter ALL RECORDS to make the selection include all the
records in the database.

Sort the records by entering the following:

SORT SELECTION([Employees];[Departments]Name;>;
[Employees]Last Name;>)

The SORT SELECTION command is very powerful in

4th DIMENSION. It can be used to sort a selection based on
fields you specify in the command, to sort based on variables
you enter in a custom dialog box, and in many other ways.
Here, you have instructed 4th DIMENSION to sort the records
in the [Employees] file according to the department name in
the [Departments] file and then by Last Name. Note that you
first specify the names of the file you want to sort, and then you
specify the filename for each sort field. The greater-than sign
(>) instructs 4th DIMENSION to perform an ascending sort.
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You need to sort the records because the report you are
printing calculates subtotals for each department. Therefore,
the records must be sorted by department before printing.
You must sort on at least one more level than the number
of breaks you are using. In this case, you are sorting on two
levels and using only one break level.

Instruct 4th DIMENSION to print the selection of records by
entering the following:

PRINT SELECTION

This command carries out the printing process. It works like
the Print command in the User environment.

Finally, restore the output layout by entering the following:
_OUTPUT LAYOUT ("Employee List")

This command instructs 4th DIMENSION to use the previous
output layout to display the records.

S(J=————— Procedure: Monthiy Rep

DEFAULT FILE([Employzes])

OUTPUT LAYOUT( EmployeeRepart”)

ALL RECORDS

SORT SELECTION([Ernployees];[Departments Name ;> ; [Employees JLast Name ;>)
PRINT SELECTION

OUTPUT LAYOUT( "Ernployee list")

Keywords Routines
Arrays
Boolean

Communications

4 Employees
{p| Last Marne
Firzt Name

If
Else
End if
Casge of

End caze
“While

epartment Code

Figure 15-6
The completed Monthly Rep procedure

Now return to the Runtime environment to see how this menu
command works.

4th DIMENSION sorts the records and prints the report you
have designed.
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The Next Step

You need to write a global procedure for each menu item you
use in your runtime application. With 4th DIMENSION’s
procedural language, you can create programs of great power
and flexibility that allow you to control the processing of your
information.

This chapter has been merely an introduction to one of the
most powerful features of 4th DIMENSION. For complete
information about all the commands available, see the

4th DIMENSION Language Reference.
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USING THE PASSWORD ACCESS
SYSTEM

Database: Personnel 16
Estimated time to complete: 10 minutes

When you create a database that will be used by more than
one person, you may need to set up a password access system
to limit access to data. An access system requires each person
who uses an application to have a password, and controls what
functions the person can perform.

For example, you may hire a temporary employee to enter
some information into your database. You can easily provide
that person access to enter or modify records, but reserve other
functions for only those employees who need to use them.

In this chapter you will learn how to
m use 4th DIMENSION’s Password Access editor

m set up an access system with passwords for your personnel
application

Vi
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Users and Groups

The access system provided by 4th DIMENSION is based on
the concept of users and groups. Users are assigned to groups,
and groups are given access rights to different parts of a
database.

You create user names and passwords for as many users as
you want. 4th DIMENSION begins with two users who are
given special access powers:

Designer: The person who has access to everything in all
environments—Design, User, and Runtime. The Designer
can create and delete groups, assign and change group access
privileges, and reassign users to different groups.

Administrator: The person responsible for overseeing the
application on a daily basis. The administrator can add and
delete users and assign them to groups.

Groups can contain any number of users (and, in fact, can
contain other groups). The groups determine who has access
to a particular file, procedure, layout, or menu. Records in
each file can be loaded, saved, added, or deleted depending
on which group is given access to each function.

File Attributes...

Filename: |[ Iyl [v]T[-1-33

Record Access

Load: [All Groups

save: [Personnel

Add: [Personnel

Delete: |Executive

[ cancel J[[ 0K |]

Figure 16-1
Access privileges are part of the File Attributes

As you can see in the dialog box in Figure 16-1, all groups
have the right to load records in this file, but only users who
belong to the Personnel group can save or add records, and
only users who belong to the Executive group can delete
records. This system of differing access priveleges allows the
records to be seen by everyone with a password, but ensures
that the records are changed only by the appropriate people.
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You maintain the access system by adding new users to the
proper groups, deleting users who no longer need to be in a
particular group, and by creating new groups for special
purposes.

Adding Users and Groups

You know that there are four likely users for your
application—yourself, the head of the personnel department,
his secretary, and possible temporary workers. You need to
enter them as users and assign a password. Then you need to
group them in appropriate groups and assign the groups to the
correct menu choices.

1. If you have not done so already, start 4th DIMENSION and
open the Personnel 16 database.

Personnel 16 starts in the Design environment.
2. Choose Passwords from the Design menu.

4th DIMENSION displays the Password Access editor.

S[[=——— Passwords ————U01=
Users... Groups...
P Designer K| >
P Administrator
Users list
Groups list
o =
i K]
] ]

Figure 16-2
The Password Access editor

The Password Access editor shows two sets of boxes.

The Users box displays the list of users. Currently it contains
Designer and Administrator; later it will also display the
users you create. The groups a selected user belongs to are
displayed in the box below the Users box. The Groups box
displays the list of groups you create, and the names of users
that belong to a selected group are displayed in the box
below the Groups box.
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Choose New User from the Passwords menu. 4th DIMENSION
displays the Edit User dialog box. You fill out one such dialog
box for each user you add to the system.

Edit User

User name: New User |

Password:

Startup procedure:

Last use: 00/00/00
Number of uses: 0

((cancer ] [ ok ]|

Figure 16-3
The Edit User dialog box

You can enter and edit user names, passwords, and a startup
procedure in the Edit User dialog box. 4th DIMENSION keeps
track of the date of last use and the number of uses of a
particular password.

Enter David as the User name, and HawkK as the Password.

As a double-check, you capitalize two letters of the password.
4th DIMENSION’s access system is case-sensitive. David (the
head of the personnel department) will have to capitalize both
the first and last letters when he enters his password.

You don’t plan to use a startup procedure for this user, so you
leave the “Startup procedure” box blank. A startup procedure
runs when a user starts 4th DIMENSION. Leaving this box
blank allows David to use the User environment as well as the
Runtime environment.

Click OK.

4th DIMENSION closes the Edit User dialog box and adds
David to the list of users.

Add the following users and passwords to the list:

User name: Helen User name: Temporary
Password: Gos6h Password: Temp

Notice that the password for Helen, the personnel department
secretary, has a number entered in the word.

This is another way to ensure password security.
The password for the temporary worker is simple, easy to
remember, and appropriate. If necessary, you can change it.
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You don’t need a user name for yourself, since you plan to use
the Designer name.

E[l=—— Passwords ————17|
Users... Groups...
® pesigner K7 O
P Administrator
[J pavid
Helen
= -l
< %
K i
o o
[
Figure 16-4

The completed list of users
Choose New Group from the Passwords menu.
You are now going to create the groups you want to use.

4th DIMENSION displays the Edit Group dialog box.

Edit Group

This group contains 0 users.

Group owner: [Administrator ]

(oo ) ()

Figure 16-5
The Edit Group dialog box

4th DIMENSION allows you to name the group and to
choose a group owner from among the users already created.
The group owner can add and delete users from the group.
Normally you leave the Administrator as the group owner.

Enter General as the group name, and leave the “Group
owner” box alone.

This is the group that will contain all users.
Click OK.

General is added to the list of groups.
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10.

Create two more groups with the following names:
Special
Manager

Your completed list of users and groups looks like this:

S(J=———= Passwords —————V|
Users... Groups...
P Designer K+ |JJGeneral Q}
P Administrator [Jd special
(3 pavid [JIManager

Helen
[J Temporar

Bl [k
|

[® Administrator

<
<l

Figure 16-6
The users and groups

You are now ready to assign users to various groups.

Placing Users Into Groups

You place users into groups by dragging their names from the
Users list to a group in the Groups list. Once the name is in a
group, it appears in the lower group members list.

You are going to place all users in the General group, David
and Helen in the Special group, and David in the Manager
group. You don’t need to place Designer in a group, since the
Designer has access to everything.

Select David from the Users list, and drag it to the General
group.

When you release the mouse button, David appears in the list
of group members.
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[[=—— Passwords —————T[TF]

Users... Groups...

P Designer
Administrator [JJ Special
[2) David [IManager

[J Helen
[J Temporary

C o]
| [ Administrator [

David belongs to
these groups

[@

Figure 16-7 :
Dragging a user name to place it into a group

Place Helen and Temporary in the General group.
These names are added to the grou;; members list.
Place David and Helen in the Special group.
Place David in the Manager groﬁp.

E(l=— Passwords ———————13|

Users... Groups...

[&

B pesigner

® Administrator
[J pavid

[J Helen

[J Temporary

These users

[ [

[JJ ceneral I
[JJ Special
[JJ Manager

|

belong to the
Manager group

Figure 16-8

The completed access setup

If you accidentally add a user to the wrong group, simply
select the user name in the Group list and drag it back to the
same name in the Users list.
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Assigning Groups

You have now created the user names you need and assigned
the users to groups. Now you need to assign the groups to
different portions of the application. This step will complete
the installation of your access system.

You have named the groups so that you know who is in
each group. You need to assign the Manager group to those
portions of your application that you want only the head of
the personnel department to be able to use.

Open the Menu editor to show Menu Bar #1 which contains
the menus for your application.

These are the menus you created in Chapter 14.

Select the Reports menu, and then select the Monthly menu
item.

Selecting a menu item activates the Password pop-up menu.
Currently it contains the All Groups designation.

Choose Manager from the Password pop-up menu.

E0==———— MenuBar #| ===———D]|

Menus Items Procedures
File K> [Month onth Rep Ko
Departments Quarterly Quarter Rep
Employees
Reports
1 0] o]
[0 Keyboard: D O Bold
[Line [ 1talic
X Enabled [] Underline
[J outline
Password:[ All Groups ] [ Shadow
Genex_'al =)
Special
Figure 16-9

Choosing from the Password pop-up menu

The Manager group now has access to the Monthly menu
item. Only David will be able to use this menu command.

Assign Manager to the Quarterly menu item.

Remember to select the Quarterly menu item, then choose
Manager from the Password pop-up menu.
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In a similar way, assign the following groups and menu items:

L4

Department Add Department Special
Modify Department Special
Remove Department Manager

Employees Add Employee General
Modify Employee General
Remove Employee Special

When your application is used in the future, only those users
belonging to these groups will be able to use the assigned
functions.

Close Menu Bar #1

Seeing the System in Action

There is actually one more preliminary step to establish the
access system for your application. This step is the key to the
whole system:

You must give the Designer a password to initiate
the access system.

When the Designer has a password, the system takes effect.
Not before. (To disable the access system, simply remove the
password from the Designer.)

Select Designer from the Users list.

Choose Edit User from thé'APassword menu.
The Edit User dialog box is displayed.
Give the Designer the following password:
ToddAndDate

Or make up one of your own. Be sure it is a password you can
remember, or write it down. Otherwise you won’t be able to
get back into this database.

Click OK.

Giving the Designer a password activates the access system.
You can now proceed to test the system.
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Choose Quit from the File menu.

You must quit from 4th DIMENSION because the access
system takes effect on startup.

Double-click the Personnel 16 database icon to start
4th DIMENSION again.

This time, after the initial screen, 4th DIMENSION displays
the “Enter password” dialog box:

Enter password:
Designer |
2 [ Administrator
David
Helen
Temporary
1| Cancel

Figure 16-10
The “Enter password” dialog box

The panel contains all the user names you have created,
Designer, Administrator, and one other, Guest. The Guest
selection is available to be used by anyone. It does not require
a password. A person who enters the application as a guest can
use any function that has All Groups assigned to it.

Select Helen and type her password.

(Her password is the word “Gosh” with a 6 before the h
(Gos6bh). Remember that the password is case-sensitive. You
must use a capital G.)

As you type the password, 4th DIMENSION displays icons
instead of characters. The icons are displayed instead of the
characters so that no one can read your password when you
type it.

Click OK.

4th DIMENSION opens in the User Environment. You could
create a Startup procedure to make the database open directly
in the Runtime environment.
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Switch to runtime and choose several menu items.

The items that have been assigned to the General and Special
groups can be used at this time, since Helen belongs to these
groups. The items that have been assigned to the Manager
group cannot be used.

Choose Quit and start up 4th DIMENSION again, this time
entering as the Designer.

The Designer’s password is ToddAndDate.

This time 4th DIMENSION opens in the Design environment.
You can use your application by changing to the Runtime
environment. Entering as the Administrator, by the way, starts
in the User environment.

Feel free to play around with the access system, creating
new user names and passwords, adding groups, assigning
them to different parts of the system. You can even write
startup procedures [such as ALERT(“Hello there Phil!
Welcome to my wonderful personnel application!”)] to
be run at the beginning of a user’s session.

The Next Step

The 4th DIMENSION access system is very flexible, yet it is
extremely simple. Once you have created a few user names
and groups, the idea of how to protect different parts of your
program is obvious.

Using this system, you can provide complete security for your
application and for your information. You probably noticed
that you can protect your information even if you don’t create
a runtime application. Simply assign Designer a password, and
no one can open your database without knowing the password.

See the 4th DIMENSION Design Reference for complete
directions for changing passwords, restrictions, and so forth.

By the way, if you have worked through all the chapters in this
book, congratulations. Have fun with 4th DIMENSION!

CHAPTER 16: USING THE PASSWORD SYSTEM 223
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INDEX

Cast of characters:

* (accent mark), as comment
indicator 91, 200

& (ampersand), in entry filter 65

@ (at sign), as search
wildcard 150

$ (dollar sign), in local
variables 92

:= (gets symbol) 77, 80

> (greater-than sign), for
ascending sort 206

# (number sign)
in entry filter 65
in Quick Report editor 161

A

Abbreviated date 17

accent mark, (*), for comments
91, 200

access privileges 214
to related file 114-116

access system 213-223
adding users and groups
215-218
assigning groups 220-221
disabling 221
placing users into groups
218-219
testing 221-223
users and groups, described
214-215

Action menu, in creating buttons
27,29

active objects 25
See also buttons; layout
objects; objects
Create Active Object icon 24,
172
using on report layout
172-177

Add Field icon/tool 55,78, 171

Add to Layout command 38

ADD RECORD command, in
procedures 201, 203-204
Administrator 214, 217
alert box, in data validation 71
Align Center/Vertical icon/tool
13
alignment icons/tools, using
12-15
Align Right icon/tool 13
Align Top icon/tool
in duplicating buttons 29
for adding new field 56
ALL RECORDS 206
ampersand (&), in entry filter 65
And, with search conditions
146-148
Append Item command 190
Append Menu command 189
Apple menu 189
applications
assigning groups to 220-221
runtime, 186, 187-194
Search editor in 204-206
at sign (@), as search
wildcard 150
automatic relation, 101
deselecting 108
One to Many 126
subfile use vs. 130
testing 113-114

B
border, designing 9-10
break, defined 157
Break area
defined, 167
in Layout editor 170
in Quick Report editor 155,
160-161
subtotal script for 174-177
break header, defined 167
Break Header area 170-171
Break Header marker 170-171
break levels, sort levels and
157-158
Break marker 169

INDEX

Bring to Front icon/tool 13
buttons
adding to layout 23-32
aligning 29
duplicating and editing 27-29

Cc
calculating a total
in quick report 160
scripts for 177
Cancel button
creating 28-29
loop and 203-204
Can’t Modify attribute 63
capitalization
in passwords 216, 222
procedure for 89, 91-93
Choices attribute 52
Choices lists
creating 50-52
modifying 51-52, 58
placing on layout 54-57
testing 57-58
for Title field 68-69
using 49, 50-52, 57-58
Choose File/Layout dialog
box 31
List of Files window vs. 70
Clear command, for search
condition 146, 148, 149
Clipboard, pasting to menu from
193-194
Close button, for report script
173
Collapse button, for layout name
88
Command key, for deleting extra
Break marker 169
Command-1 keystroke, for adding
to field 56
Command-N keystroke, for menu
shortcut 192
commands
Add to Layout 38
ADD RECORD 201,
203-204
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ALL RECORDS 206
Append Item 190
Append Menu 189
Clear 146, 148, 149
Copy 40
Custom Menus 193
DEFAULT FILE 200, 205,
206
defined 198
Design 167
Edit User 221
high-level language and 198
INPUT LAYOUT 201, 205
Layout 94 ~
Menu 188
Modify Record 57, 124-125
MODIFY SELECTION 205
New Group 217
New Record 114
New User 216
OUTPUT LAYOUT 206,
207
Passwords 215
Print 179
PRINT SELECTION 207
Quick 158
Quit 188-189, 202, 222
Right 176
role of 77-78
SEARCH 205
Search Editor 145, 146, 147,
149
Search by Formula 150
Search by Layout 143, 150
Search and Modify 150
Show All 146
SORT SELECTION
206207
User. See User command

Command—Space bar, for “List of
files” window 70, 113, 124,
135

comments XV
in Procedures 91, 200
in text area 137

comparison operators, in search
conditions 144

compound searches 143-150

conjunctions, in search conditions
146-148

control panel, custom buttons
for 23-32

Copy command, for adding
buttons 40

Create Active Object icon/tool
24,172

customizing
adding buttons to layout
23-32
adding fields 49, 52-57
data entry order 41-45
data validation 61-72
menus 185-194
multi-page layouts 35-40
report layouts 165-180
using Layout editor 5-19
using lists 49, 50-52, 57-58
using procedures 87-95
using scripts 76-81

Custom Menus command 193

cut-and-paste operations, for
copying buttons 40

D

databases
adding fields to 49, 52-57
adding files to 101, 103-105
combining files in 101
password access to 213-223
runtime applications, 186,
187-194
searching methods, 150. See
also specific methods

data entry
See also data validation
changing order of 41-45
Choices lists for 49, 50-52
to a subfile 135-138

data validation 61-72
adding a validation range
66-67
capitalization procedure
91-93
checking 70-72
required list for 68-69
setting entry filter 64-66
using field attributes for
62-63
date
creating a script for 174
default value for 81
date field display format 16-18
decimal number display format
18
Default box 81
DEFAULT FILE command 205,
206
in procedure 200
default data entry order 41
default values 75, 81
Design command
for modifying procedure 202
for report layout 167
Design environment
access through 223
adding users and groups
in 215
checking in User environment
30-32
modifying layout in 5
Designer 214, 217
entering system as 223
password for 221
Design menu
Layout command 42, 94
Lists command 50
Menu command 188
Passwords command 215
Structure command 52
detail and break instructions
157-158, 160-161



Detail area
creating a script for 173
defined 167
in Layout editor 170, 173
in Quick Report editor 155,
161
Detail marker 169, 170, 171
display format
entry filter and 64, 65-66
setting 15-19
Display Only field attribute 78
dollar sign ($), in local
variables 92
double-clicking, as shortcut 18
drawing icons/tools, using 9-12
Duplicate icon/tool, in creating
buttons 28

E
Edit Group dialog box 217
editing buttons 27-29
Edit menu
Clear command 146, 148, 149
Copy command 40
Paste command 40
Undo command 7, 29
Edit User command 221
Edit User dialog box 216, 221
Enabled check box, in Menu
editor 192
Enterable layout field attribute 68
Enter menu
Modify Record command 19,
57, 124-125, 136
New Record command 114
Enter Password dialog box 222
entry filter 64-66
Entry Order command 42
error correction
with alignment tools 14
in copying buttons 29
in Layout editor 7, 169
in Procedure editor 201
Expand button, for layout
name 88

IS

Field area, drawing 55
field attributes, for data validation
62-63
Field Definition dialog box
16-17, 18
in adding new field 55
in creating a subfile 132
in setting entry filter 64, 66,
67
for Titles list 68—69
using default value in 81
in writing a script 79
Field dialog box
in creating a subfile 131
for specifying attributes 62
in writing a script 78
field label, creating 56
field names
for reports 175
in search condition 144
Field for Review Info dialog
box 132
fields
adding to database 49, 52-57
adding to layout 36, 38-39,
54-57
aligning 13-14
creating labels for 56
placing values in 77
searching in related files
149-150
setting display formats
for 15-19
subfields 129
file access. See access privileges
File attributes, access and 214
file icon 104
File menu
Import Data command 112
Print command 179
Quit command 188-189, 202,
222
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file procedures, defined 87
files
See also related files; subfiles
adding to databases 101,
103-105
displaying information on 102
maximum per database 104
parent 129
in Procedure editor 77, 90
fill pattern, choosing 10
Fill Pattern submenu 10, 11
Flowchart editor 76
Flowchart procedure type 89
fonts
for Header area 173
in Layout editor 171
in menus 192
for report elements 173
footer, defined 167
footer area
in Layout editor 169
running title for 178
Footer marker 169
“Format for an included layout”
dialog box 134
Format box, in setting entry
filter 65
Format area 16, 18
Format submenu 16-17
forms, imitating 36-37
Formula editor 150
4th DIMENSION, programming
in 198
Full-page layout 132, 135, 136
functions
defined 198
global procedures as 91
role of 78
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G
gets symbol (:=) 77, 80
global procedures

for adding records 199-204

for capitalization 91-93
creating 91-93, 199-201
defined 87
requirements for 199
using in scripts 94
graphics
adding to menus 193-194
using Layout editor 9-12
greater-than sign (>), for
ascending sort 206
group owner 217
groups 214-215
adding 217-218
assigning to applications
220-221
placing users into 218-219
Groups box 215

H
handles, around objects 7
header, defined 167
Header area
in Layout editor 170-171,
173
in Quick Report editor 155
Header marker 170

|
icons, in password display 222
Import Data command 112
Import Data dialog box 112
imported data 113
included layout
creating 122-123
full-page layout and 135
for a subfile 134-135
indentation, in loop 203
Indexed attribute, Unique
attribute and 63
INPUT LAYOUT command 205
in procedure 201

Input Layout icon 70
with included file 124
with related file 113

input layouts
See also layouts
changing data entry order on
41-45
changing display format on
16-19
fast access to 70
included 122-123. See also
included layout
for procedures 201
for related files 108-111
for subfiles 132-135
Validate 70, 71

Items column 189
appending an item to
190-191

Items menu, Sort command 51

K

Keyboard check box, for menu
shortcut 192

keyboard symbols, as entry
filters 65

keywords, in Procedure editor 77,

90

L
layout
See also input layouts; output
layouts
modifying 5-9, 19
searching by 142, 150
layput border, selecting 9—-10
Layout command, 5
for changing data entry
order 42
for testing a script 94
Layout dialog box 3, 6, 54
for included layout 122
for related file layout 108
in setting entry filter 64
shortcut to opening 24

Layout editor 5-19, 155,
168-172
for adding new field 54
advantages of 165
in creating a subfile 132-133
drawing icons/tools 9-12
modifying layout in 5-9
setting display formats in
15-19
layout elements, multiple 29
Layout Field dialog box, in
setting validation range, 6667
Layout menu
Add to Layout command 38
Entry Order command 42
layout objects
See also active objects; objects
changing 7-9
scripts and 76
layout procedures, defined 87
layout rulers 166, 167
layouts
See also input layouts; output
layouts
adding buttons to 23-32
adding fields to 38-39, 54-57
aligning 12-15
changing data entry order on
41-45
designing 9-12
full-page 132, 135, 136
multi-page 35-40
saving 12
size of 36
testing modifications to 19
layout title, layout name vs. 8
Layout window, expanding 6
letters, in entry filter 65
Line check box, in Menu editor
192, 193
Line Width submenu 10
List button, activating 52
“List of files” window 70, 71
displaying 111, 135
for included file record
display 124



Listing editor 76-78

Listing procedure type 89
for report layout procedure
173

lists 49. See also Choices lists

Lists command, for creating a
list 50

Lists dialog box 52-53, 69

Lists editor 50-51

local variables 92

loops, defined 198, 203-204

Lowercase function, in global
procedure 91-93

Macintosh typeface, for menu
items 192
mail-merge letters, text areas
for 176
Mandatory attribute 62
Mandatory layout field
attribute 68
Many-to-One relation 103, 106
Maximum box (validation
range) 67
menu bars 17, 187
Menu Bars dialog box 188
Menu command 188
Menu editor
assigning groups with 220
changing style with 192—193
entering menu titles and items
in 189-191
getting to 188-189
previewing menus with
193-194
Menu menu 189
Append Item command 190
Append Menu command 189
Custom Menus command 193
menus
adding graphics to 193-194
customizing 185-194
previewing 193-194

Menus colunm 189
appending menu titles to 189,
190-191

Minimum box (validation
range) 67

Modify Record command 57
for checking display format
19
for included files 124-125
for subfiles 136

MODIFY SELECTION
command 205

Move to Front/Move to Back
icons/tools 11-12

multiple search conditions
146-148

multi-user applications, 186
password access to 213-223

N
networks. See multi—user
applications
New File command 104
New Group command 217
New Layout dialog box 38-39
for included layout 122-123
for related file layout
108-110
for report layout 168
for subfile 133-134
New Record command, for
checking related files 114
New User command 216
Next Page button, creating 3940
Next Page icon/tool 38
Next Record button, creating 28,
29
numbers
in entry filter 65
in passwords 216
number sign (#)
in entry filter 65
in Quick Report editor 161
numeric display format, setting
18-19, 78-79

INDEX

o
Object Definition dialog box 25
in duplicating buttons 29
on report layout 172-173
Object menu
Fill Pattern submenu 10, 11
Format submenu 16-17
Line Width submenu 10
objects
See also active objects; layout
objects
dragging 7-8
nonenterable, on report layout
172-177
selecting multiple 13
Object Type menu, in creating
buttons 26
OK button, creating 24-27
OK variable, Cancel button and
203-204
One file/Many file 103, 106
one-to-many relation 103,
121-126
“Only if modified”, reports and
173
operators, in search condition
144
Option key
with Break marker 169
in creating procedure 93
with Header marker 170
Or, with search conditions
147-148
OUTPUT LAYOUT command, in
report procedure 206, 207
Output Layout icon 70
output layouts
changing display format
on 19
displaying records on 19
fast access to 70
for reports 166—172
Oval icon/tool 11
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P
page number, script for 178
pages, adding to layouts 37-38
parameters, defined 198
parent file 129
parent record 129
returning to 137
password access system. See
access system
Passwords command 215
Password Access editor, 215
Passwords menu
assigning groups in 220-221
Edit User command 221
New Group command 217
New User command 216
paste operations
for copying buttons 40
to custom menu 193-194
pixels 41
pop-up menus 17
fast access to 70
previewing on screen
custom menus 193-194
custom reports 180
Print command 179
printer control markers, in Layout
editor 169
Printer dialog boxes 180
Print File dialog box 179
printing
custom reports 179-180
procedures for 206-207
quick reports with
breaks 155-162
PRINT SELECTION
command 207
Procedure dialog box 88-90
Procedure editor 76-78, 90, 91
adding a procedure in
199-201
getting to 88-89
writing script with 79-81

procedures
See also scripts
creating 91-93
custom 194, 197-208
custom menus for 187-194
default file for 200
defined 198
modifying 203-204
for reports 206207
for search selection 205-206
testing 202
types of, 87. See also specific
types '
using 87-95
Procedures column
appending a procedure
to 190-191
in Menu editor 189
Procedure type dialog box 79
programming 198

Q

Quick command 158

Quick Report editor 155-156
using 158-162

Quit command 202
in Menu editor 188-189
in password system test 222

R
Real field type 78
records
creating in related
file 114-116
importing to related
file 111-112
parent 129
procedures for adding
199-204
search subsets of (selection)
144
subrecords 129, 130
Records window, for checking
related files 113

rectangles
aligning 12-14
drawing 9-12

Rectangle icon/tool 12

related files 101-103
advantage of 101
creating new records 114-116
importing records 111-112
many to one 101-116
one to many 121-126
searching on fields
in 149-150
subfiles vs. 130
testing automatic relation
113-114

Related layout
checking 113-114
creating 108-111
selecting 113

Relation Type dialog
box 107-108

Rename command, for
new file 104

Repeat, in loop 203

report control markers 166, 167
working with 167-172

report layouts 166—167

Report menu, Quick command
158

reports
creating (Layout editor)
165-180
creating (Quick Report editor)
155-156, 158-162
details and breaks in 157-158
previewing on screen 162,
180
printing 179-180
procedures for 206-207
Quick Report vs. Layout 155,
165
saving 162



Reports menu, assigning groups
with 220

Required check box, for Choices
list 68, 69

resizing an object 7, 8

Right command 176

routines
defined 198
in Procedure editor 77-78, 90

runtime applications 186
custom menus for 187-194

Runtime command, for testing
procedure 202

Runtime environment
custom menus and 193
Designer access to 223
procedures for 197-208
testing procedures in 202,
204, 207

S

saving layouts 12
saving reports 162
screen display
of entered password 222
previewing report on 162, 180
Script button
in Layout editor 173
for Subtotal routine 175
Script editor, shortcut to 94
scripts 75
See also procedures
defined 75, 76, 87
elements of 77
Procedure editors and 76-78
for report layout 172-177
using global procedures in 94
writing 78-81
Scripts layout
adding new field to 78-81
checking 82-83
SEARCH command 205

search conditions
compound 146-148
in Search editor 144, 145
using 144
wildcard (@) 150
Search editor
search condition in 144
using 143, 145-150
using in application 204-206
Search Editor command 145,
146, 147, 149
Search by Formula command 150
Search by Layout command 143,
150
Search and Modify command
150
search selection. See selection
Search selection check box 148
security system 213-223
selection order arrows, changing
4244
selection (record subset) 144
printing 207
procedure for modifying
205-206
Select menu
Search Editor command 145,
146, 147, 149
Search by Formula
command 150
Search by Layout command
143, 150
Search and Modify command
150
Show All command 146
Shift-click, for selecting multiple
objects 13,29
shortcuts, in custom menu 192
Show All command 146
Sort command, in creating a list
51

INDEX

sorting for report 179
in procedure 206-207
for quick report 159
report design and 157
sort and break levels
157-158, 159
SORT SELECTION command
206-207
startup procedures, in password
system 216, 223
Structure command, for adding a
field 52
Structure menu
New File command 104
Rename command 104
style changes, for menus
192-193
Style menu
Center command 9
Right command 176
subfields 129
creating 131-132, 133
subfile display area 136
Subfile field type 131
subfiles 129-138
creating 130-135
entering data into 135-138
subrecords 129, 130
subtotals
in Quick Report editor 160,
161
scripts for 174-177
Sum symbol, in Quick Report
editor 160
symbols
as entry filters 65
as script elements 77

T

tests
on custom procedures 202
defined 198

text areas, embedding values of
fields in 174-176
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Text Area icon/tool
for changing layout object 8
for creating field label 56
in Layout editor 172

“This record does not exist”, in
related file 115

time, script for 174

Title field, Choices list for 68—-69

totals
in Quick Report editor 160
scripts for 177

Totals row, in Quick Report
editor 150, 155

Type menu, in creating
buttons 26

U

Underline check box, in Menu
editor 192

Undo command 7, 29

Unique attribute 63

Until, in loop 203

Uplow procedure, creating 89-95

Uppercase function, in global
procedure 91-93

Use menu
Design command 167, 202
Runtime command 202
User command. See User
command
User submenu 19

User command
for checking data
validation 70
for checking defaults 82
for checking Scripts input
layout 82
for entering data to
subfile 135
for importing related file
data 111
for included files 124
for printing report 179
in testing new buttons 30

User environment
Administrator access to 223
checking choice lists in 57
checking custom data entry
order in 45
checking custom layout in 19,
30-32, 40
checking scripts or default
values in 82-83
for included file record
display 124
for relating files 111-112
User Modifiable lists 52
users 214
adding 215-217
placing into groups 218-219
Users box 215
User submenu, for checking
display format 19

v
Validate input layout 70, 71
validation range, adding 66-67
values

functions and 198

placing in a field or variable

77

in search condition 144
variables

See also global variables

local 92

placing values in 77

w

Wildcard choices list, in relating
files 108

wildcards, in searching (@) 150

word wrap, in text subfile 137

z

zoom box, for viewing report 180



